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THE GS PLAN INTERFACE

The GS Plan Window

The Main Window in GS Plan contains the Drawing Area, the menu bar, toolbars, and the status bar.
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Level F3
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Bearings F5
Planes F6
Extend F?7
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Panel sM
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MENU BAR
Entries in the menu bar, located at the top of the GS Plan window, can be accessed one of three ways:

1. Move your mouse cursor over the name of the menu that you want to access and then click the
left mouse button. Then select the command you want from the menu by clicking on the
command name with the left mouse button.



2. Start by pressing the F10 key. This will activate the File menu. Then use the right arrow key to
move to the menu needed, then the down arrow to move to the command needed. When the
proper command is highlighted, press the Enter key.

3. Hold down the Alt key and then press the letter that is underlined in the menu name. For
example, in File, the “F” is underlined, so press Alt and F at the same time to bring up the File
menu. Then press P to print (because the P is underlined letter in Print Drawing).

DRAWING AREA

The Drawing Area is the central portion of the Main Window in which layouts are displayed. All input,
editing, and viewing of the model takes place within the Drawing Area. When in the Drawing Area,
there are three different cursor modes. Depending on the mode that you enter, your cursor will change
appearance:

1. If you are in the Select Mode, the arrow cursor will appear. (This cursor will also appear if you
leave the Drawing Area.)

2. Ifyou are in Drawing Mode or Input Mode, the crosshair cursor will appear.

3. Ifyou are in Animate Mode, the animate cursor will appear.

TOOLBARS
Toolbars can be added or subtracted from the Main Window in two ways:

1. Click on the Tools menu and scroll down to the Toolbars option. On the sub-menu that appears
to the right, click on the toolbar that you want to add or remove from your view. (The toolbars
that are currently displayed will have a checkmark next to them in the sub-menu).

2. Right-click in a gray area of the GS Plan Window (for example, the gray area to the right of the
Help menu). On the menu that appears, click on the toolbar you want to add or subtract from
your view. (The toolbars that are currently displayed will have a checkmark next to them.)

STATUS BAR
[,Se;ect line X: 68-5-0 Y: -56-5 Z: 000 Rim Joist Lo \

The status bar displays information about the function currently being performed. Below is a sample
status bar.

=  Prompt—The Prompt informs the user about the next step that should be performed in the
application. (For example, "Set first point" when starting to draw a bearing.)

= X Coordinate — This is the current location of your cursor along the X-axis (left — right, horizontal
in Plan View).

= Y Coordinate — This is the current location of your cursor along the Y-axis (up — down, vertical in
Plan View).

= 7 Coordinate — This is the current location of your cursor along the Z-axis (height).

= Current Entity — If you are in a Drawing Mode, this is the type of entity you are currently drawing
or are going to be drawing. If you are in a Select Mode, then this is the type of entity that you
last selected.



= Current Snap Modes — These are the snap modes that you currently have activated.
¢ Zrepresents XYZ Snap
¢ P represents Point Snap
*+ Grepresents Grid Snap

¢ represents Ortho

= [evel —This is the current active level in GS Plan. To change the levels that are active and/or
visible, choose the Set Levels option on the Tools menu.

RIGHT CLICK MENU

The right-click menu provides shortcuts to some of the most often used commands in GS Plan. The
commands that are available at any given moment are contingent upon the actions currently being
performed by the user. Following are some of the commands commonly available from the right-click
menu:

Deselect — The Deselect command allows you to deselect selected (highlighted) items in the model. No
items will be selected after this command is executed.

General Information — Select General Information from the File menu to open the General Information
window. This window allows users to set up default information for the current layout. It is the same
window that appears when you start a new job. For more information, see the section within this
document entitled “General Information Tabs & Settings.”

Set Levels — The Set Levels command allows users to create new levels, and to view and edit information
about all existing levels in the current model. For additional information, see the section within this
document entitled...

Set Visibility — The Set Visibility command allows users to select the entities to be displayed in the
Drawing Area, and those to be hidden. If the name of a member type has a check mark next to it in the
Set Visibility window, it will be displayed in the Drawing Area. If the member is not checked, it will not
be displayed. To check (or uncheck) a member type, click in the box to the left of the name. For
additional information, see the section within this document entitled...

Plan View — The Plan View command displays a model from above, as large as possible on the screen, so
that it fills the entire Drawing Area.

Animate — The Animate command allows users to view and rotate a model in 3D space. After selecting
Animate, your model will be displayed in a preset 3D view. Use the arrow keys on your keyboard (not
the keys on the numeric keypad on your keyboard) or your mouse to move the model. To exit the
Animate View press the Escape key. If you move to a 3D view that you wish to keep, either click the left
mouse button or press the Home key on your keyboard.

Solid Model — This feature allows users to view jobs with a Solid Model View in a modeless window. The
Solid Model View window can be resized and/or repositioned at any time. Size and position information
are stored when the viewing window is closed and restored when the window is opened. Pressing the
Escape (Esc) key while in the viewing window will close the window and return the user to the standard
Model View.

Undo — The Undo command reverses the action of the last single-line Modify command.

Redo — The Redo command reverses the action of the last Undo command.



Tools — The right-click Tools option opens a Tools menu with a subset of commands that are available
from the Tools option on the menu bar. For more information about the features and functions
available on the Tools menu, see the section within this document entitled . Note, the five
options not available from right-click Tools include: 1) Set Levels, 2) Deselect All, 3) Select, 4) Select All
Visible, and 5) Enter Point.

Entities — The right-click Entities option opens an Entities sub-menu with a list of commands functions
that are identical to those available from the Entities option on the menu bar. For more information
about the Entities menu, see the section within this document entitled

Display — The right-click Display option opens a Display sub-menu that contains a subset of the
commands available from the Display option on the menu bar. The commands available from the right-
click Display sub-menu include:

Zoom Window

Zoom Full

Zoom Last

Show Wall Profiles

Show Planes & Overhangs

ik N e

Macros — The right-click Macros option opens an Macros sub-menu with a list of commands functions
that are identical to those available from the Macros option on the menu bar. The single exception is
the Re-Elevate Roof Members function, which is not available from the right-click Macros sub-menu. For
more information about the Macros menu, see the section within this document entitled

Set Properties Mode — The Set Properties command allows users to view and change the properties of a
selected member. To use this command, first choose Select from the Classic Sidebar, Standard toolbar,
or the Tools menu. Use the arrow cursor to select the entity that you want to modify. Select Set
Properties from the Modify menu. The property window for the selected entity type will appear.
Review or change any information necessary, then click on the OK button.



The GS Plan Menu Bar & Toolbars
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GS Plan toolbars contain a subset of the most commonly used commands and functions available from
the GS Plan menu bar. Taken collectively, the menu bar contains all the commands and functions
available within the GS Plan application. The available listings on the menu bar change, based upon
where the user is within the application and the functions he or she is performing at any given time.

Fie Tools Modify Entites Display

THE FILE MENU & TOOLBAR

D New
The File menu and the File toolbar provide users with commands for z :’:: o
opening, saving, merging, extracting, exporting, and printing GS Plan files. Save As...
They also provide commands for accessing a variety of file-related presets. ool S
Export DXF File...
New — When you select New from the File menu, or click the New L Merge...
: . . B, Load Shadow Job...

button when first starting GS Plan, you will be prompted to enter @ Two or more tnusses with the same...

default information for the job that you are beginning. The first & print Drawing

window to appear is the General Information window. Fill in any & PlotLayout

default information necessary, and then click on the OK button. & Priot Tousees

This will bring up the Set Levels window. Define the level that you i) Generl nformaton

Save Defaults
want to start working on and then click on the OK button. (Note: Reset Products
Define only the level that you want to work on, since empty levels % :f::‘m’"b
do not save.) Auto Saye & Undo Settings

. 1C:\KBS\)08S\Demo\Demo. LAY

If you have a model open when you start a new model, you will be 2 SwormiTest. 030720 14.LAY
prompted to save the existing model before a new model is started. 3C:\KBS\I0BS \House LLAY

4 C:\KBS)... \TestStructure LAY

@I Open — When you select Open from the File menu, or when first Exit

starting GS Plan, you will be prompted to select the model that you

want to open, using the Open File dialog box. You can use this option to

open either .lay files or .may (options) files. Use the Open File

dialog to locate and select the model that you want to open, and

then click on the Open button. When a model is first opened, all levels

will be visible and the lowest level will be active. Once you have a model open, and attempt to
open a different model, you will be prompted to save the current model.

Note: To open a job that contains Options, change the File Type from GS Plan Layout Files to GS
Plan Base House files and then select the .MAY file you wish to open. The preview box will display
the base house plus all options — even though simultaneous option selection may be structurally
impossible. Don’t worry about this slight exaggeration. The preview is based upon snap-points
stored with the model and does not differentiate between base house and option entities.
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The Open File window is shown below. Read below for more information.

[ open x|
e ./._\. |
QU [ -ower-s@mx- (1) -~ @l @) 8
Organize v  New folder =+ 0 @
=& 05 () @ Al ame | Date modified [ Type -
E Dell
- ) Batch 4/14/2014 9:43 AM File folder
® . Drivers
Intel 9/9/2014 10:36 AM File folder
B KBS House 1 4/16/2014 2:21PM File folder
Beam J House 2 3/20/2014 1:23PM File folder
@ . Buid House 4 @ 1/9/2014 10:45AM  Fie folder
% CAD Swarm Test 1 4/14/20149:43 AM File folder
Column
~ untitled 1/9/2014 10:51 AM File folder
(2 Comm
" di z_Legacy 5/30/2014 8:18 AM File folder
ehouse @ House LLAY 2/21j2014 12:06 PM LAY File
i+ GssOutput @ House LAY 9/4/2013 1:48 PM LAY File
8] House 3.LAY 5/18/2013 12:36PM LAY Fie
Batch 8] House 4.LAY 10/2/2013 12:24PM LAY File
+ Demo
# House 1
ool | 3

@Filegame:l =] [KeyBuild Leyout Files (".LAY) @
l Open |v| Cancel I

7

1. File Path —This field, at the top of the Open window, displays the full path to the folder
selected below in the Navigation Pane. You can use the File Path field to navigate to a
new location in the folder hierarchy, or you can navigate to a new path using the
Navigation Pane. (See below.)

2. Search Field — This field is used to search for files and/or folders within the currently
selected folder and its sub-folders. Simply type in all or part of the file or folder name you
are seeking, and then click on the Search icon to the right of this field to initiate your
search.

3. Navigation Pane — As its name implies, the Navigation Pane is used to navigate to the
desired folder within your directory structure.

4. Details Pane — The Details Pane displays the contents of the folder currently selected in
the Navigation Pane.

5. File Name — When you click on a file in the Details Pane, its name is displayed here in the
File Name field. You can also type the name of the desired file into this field, or select the
file from the field’s drop-down list.

6. File Type — You can chose a specific File Type to search for from this field’s drop-down list.
The list of available options includes:

= AllFiles (*.*)
= GS Plan Layout Files (*.LAY)
=  GS Plan Layout Files (*.MAY)

11



Command Buttons

Open — Opens the selected file.

Cancel — Cancels the Open process and closes the Open
window. L] C:EKMWY JobsiKey mark. lay

) was openin Model at 06/0905 18:09:50
Note: GS Plan programs now check to see if the job you are ALK ks W'k b o Jongee cpen:
attempting to open is already open by another user. Ifitis |I|

determined that the job you are attempting to open has

already been opened by someone else, you will get an error
message and will not be able to open the job. Ifitis

determined that you have the job open and are cspian
attempting to open it again, you will be warned and
then, if you click OK, the program will open the job. L7 iﬁk’?.;ﬁ%“&%":ﬂ&'mmmmm

Please note that having a GS Plan job open by multiple
users will cause file corruption, and could result in the

loss of all job information.

Save — Select this command from the File menu to save the changes to the job that is currently
open. If you have never saved this model before, you will be prompted by the Save As window to
define a name. (See below for more information about the Save As window).

Shortcut: Press the Control and S keys on your keyboard at the same time.
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Save As — The Save As command will bring up the Save As window, allowing you to specify a name
and directory for the current job. Jobs that do not contain options will be saved as GS Plan layout
files (.Lay files). If you are saving a job that contains options, change the File Type to GS Plan Base
House files, so that the job will be saved as a .may file).

The Save As dialog box is displayed below.

[ seveAs x|
(o[ - computer - 05 (C:) - KBS - 085 - Q) v &3 [ search 085 @ (0]
Organize v  New folder =y @
Drivers ;l Name | Date modified ] Type =
Intel
KBS | Batch 4/14/2014 9:43 AM File folder
| Beam , Demo 9/9/2014 1:01PM File folder
. Buid J . House 1 @ 4/16/2014 2:21PM File folder
@ CAD House 2 3/20/2014 1:23PM File folder
. Column | House 4 1/9/2014 10:45AM  File folder
§ Comen @ House 1.LAY 2/21/2014 12:06PM LAY File
dl
& House 2.LAY 9/4/2013 1:43 PM LAY File
el 8 House f4/.
GesOutput 8| House 3.LAY 9/18/2013 12:36PM LAY File
JOBS @ House 4.LAY 10/2/2013 12:24PM LAY File
KS
L i K | i
Save as type: |KeyBuid Layout Files (*.LAY) QS) |
“ Hide Folders Save | Cancel |
v

1. File Path —This field, at the top of the Save As window, displays the full path to the folder
selected below in the Navigation Pane. You can use the File Path field to navigate to a
new location in the folder hierarchy, or you can navigate to a new path using the
Navigation Pane. (See below.)

2. Search Field — This field is used to search for files and/or folders within the currently
selected folder and its sub-folders. Simply type in all or part of the file or folder name you
are seeking, and then click on the Search icon to the right of this field to initiate your
search.

3. Navigation Pane — As its name implies, the Navigation Pane is used to navigate to the
desired folder within your directory structure.

4. Details Pane — The Details Pane displays the contents of the folder currently selected in
the Navigation Pane.

5. File Name — Use this field to type the name you wish to use when saving your file.

6. Save as Type — Select the File Type you wish to use when saving your file. The list of
available options includes:

= AllFiles (*.*)
= GS Plan Layout Files (*.LAY)
= GS Plan Layout Files (*.MAY)
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Command Buttons

Save — Click on the Save button to save your file as the specified File Type and to the specified
location.

Cancel — Click on the Cancel button to close the Save As window without saving your file.

Options Extract As — The Options Extract As command allows users to extract .lay files from a job
that contains options (.may files). This option operates in conjunction with the Select Options
command on the Tools = Options sub-menu, to generate a set of .lay files containing the base
house plus all selected options. (If no options have been selected, only base house entities will be
extracted). This command is used whenever you want to export an options job to one of GS Plan’s
downstream modules (such as Structure, which cannot analyze a .MAY file).

To use this command, first use the Select Options command to select the options you wish to
export into a .lay file. Then choose the Options Extract As command from the File menu. A dialog
box similar to the Save As screen will appear. (See above for an explanation of each field). Choose
a file name and click on the Save button to generate .lay and level files based on the base house
and options currently selected.

Export DXF File — This command allows you to export the current layout as a DXF file.

Merge — Select Merge from the File menu to import a single level of an existing job into the
current one. After selecting the command, the Open File window will open. Use this window to
locate the file that you want to merge into the current job, and then click on the Open button.
(For more information on the Open window see the Open help above). The level selected will be
placed into the active level, but will retain its original height (the top of plate height at which the
level was input) as well as its original location.

All of the members on the imported level will be highlighted after it is imported. This allows you
to use the commands on the Modify menu to move the imported members to where they are
needed.

Load Shadow Job — This command allows you to import a level of any existing layout as a shadow
to be used for tracing. Choose the appropriate level (jobname.l##) from the Open File window
and click Open.

GS Build -
Re-Synchronize the GS Wall-Side Data with the GS Plan-Side —

Print Drawing — Selecting Print Drawing from the File menu will send a printout of the view in the
Drawing Area.

Plot Layout — Select this option from the File menu to plot the layout of the currently active level
in Plot. When you choose this option, GS Plan opens Plot with your floor layout, a material list,
and title box. The labels drawn with the individual floor members correspond with the material
list.

Note: The labels will change if you make changes to your job and regenerate the plot. This feature
is intended for quick bid and quick output, for NON-ENGINEERED layouts.

Print Trusses — This command is used to print a Truss Profiles Report.
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General Information — Selecting General Information from the File menu opens the General
Information window. This window is used to set up default information for the current job. It is
the same window that appears when you start a new job. For comprehensive information about
General Information settings, please see the section of this manual entitled “General Information
Tabs & Settings” on page .

Save Defaults — This command stores the layout and information on the main window to be used
the next time you start GS Plan. Selecting the Save Defaults command from the File menu will
store the current settings of the following to be used each time GS Plan is run:

= Snap modes (Z, P, G, and O)

=  Snap grid settings

= Current color settings

= Current entity type

=  Current view (animated or plan)

Reset Products — Selecting Reset Products from the File menu will set the product list for all design
materials to the default (defined in the General Information window (see above).

ReSync Job — The ReSync Job command is used to re-synchronize panel-side data with model-side
data within GS Plan. Users can elect to force panel updates (which updates all of the sticks/wall
studs for a panel each time an update is performed) or, they can process panel updates as a group
by clicking ReSync Job. This latter action determines what panels have been modified and leaves
any custom framing on all walls, except for those that are out of sync with the model side. Walls
that have been modified or added to the model-side are reframed.

Set Paths — The Set Paths command allows users to specify the location of the KeyMan executable
file (usually C:\KMW\Man or C:\KMS\Man). This is the location from which GS Plan accesses
header, skylight, post and geometric categories. Set this path to the location of your KeyMan
directory (by typing it in or using the Browse button to find the Man directory) and then click on
the OK button.

Note: Even if you store your Inventory and KeyMan jobs on a network, you must point this path at
your local Man directory — not the server location.

x
Auto Save & Undo Settings — Clicking on this P
command opens the Auto Save & Undo Settings 7 (B e 10 minutes
window pictured at right. =

l_ Undo levels, Saved to: I—_I'e =

Enable Auto Save Every — When this checkbox is = i

activated, GS Plan will automatically save your Saving Undo to Disk File enables crash recovery.
. . . ! . Saving Undo to Memory disables crash recovery.

open files according to the timeframe defined in

the adjoining Minutes field.

Minutes — This field defines how often the Auto
Save function is executed. If the Enable Auto III i’

Save checkbox is deactivated (unchecked), then
the Minutes field is grayed out and uneditable.

Undo — The Undo field defines how many consecutive user actions can be cancelled (undone).
The maximum number of actions that can be undoneis__.
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Undo Levels Saved To — The drop-down list in the Undo Levels Saved To field provides two
options:

Disk File — If this option is selected, undo levels are saved to the user’s local hard drive.
This is considered non-volatile storage, and the Undo information will be retained even if
the user’s computer loses power.

Memory — If this option is selected, undo levels are saved to the user’s Random Access
Memory (RAM). This is considered volatile storage, and the Undo information will be lost
if the user’s computer loses power.

Exit — Choose this option to close GS Plan. If you have made changes to the current layout you will
be prompted to save it before the program closes.
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THE TOOLS MENU & TOOLBAR Tock | Modfy Briites Oliley Maaos

] eoint Snap Ctrl+p
The Tools toolbar provides users with commands to... Q ;‘:t:;:”w c;:::
h_ Perpendicular Snap Ctrl+R
D Point Snap — The Point Snap icon is used to toggle the Point Snap Z XrZsnap cul+E
function on and off. If Point Snap is turned on, the user can snap to f; g"ms’“" E::g
the XY coordinates of existing snap points within a model. In this
mode, when the crosshairs of a user’s pointer move past an existing m ::;:ﬁ
snap-point, a rubber-band line (a line running from the center of the Hi setVisual Grid...
crosshairs to the nearest snap point) will appear. If you click the left & setlevek...
mouse button while the rubber-band line is visible, your cursor will E .
t

>

jump to the exact XY location of that snap point. If Point Snap is not

M, Select All Visble
turned on, the rubber-band line will not appear regardless of how

close you are to the snap-point. You will not be able to get your 18 setTop of Wall.. culeH
crosshairs to the exact location of the point. xvz Show Coordinates
It is important to note that you stay in the current Z plane when using Show Structure Hags
Point Snap. If you are snapping to a point that is at a different height, % Check Bearings
the crosshairs will move only to that point’s XY coordinates, while ) Chedk Geometry

. . . Options »
staying at the current Z height. If you want to jump tothe X, Y, and Z Tockas .
location of a point, use the XYZ Snap tool described below. Custom Toobars

You can tell if Point Snap tool is turned on or off in two ways. If the icon to the left of the
command name on the Tools menu is highlighted, then Point Snap is on. The second is to look at
the status bar. If a P is displayed in the lower right, then Point Snap is on.

Shortcut: Press the Control and P keys on your keyboard at the same time. This will toggle Point
Snap on and off.

Note: Point Snap cannot be on at the same time as XYZ Snap. Only one of the two can be active at
a time.

Midpoint Snap — When activated, the Midpoint Snap function creates snap-points at the center of
each member and at the middle of each square of the Snap Grid. If Midpoint Snap is turned on,
you can snap to the XY coordinate of existing snap-points in your model. In this mode, when you
move your crosshairs past an existing snap-point, a rubber-band line appears. A rubber-band line
is a line that runs from the center of the crosshairs to the nearest midpoint snap-point. Click the
left mouse button while the rubber-band line is visible, and the cursor moves to the exact XY
location of that midpoint snap-point.

You must stay in the current Z plane when Midpoint Snap is on. If you snap to a point thatis at a
different height, the crosshairs move to that points XY coordinates, while staying at the current Z
height. If you want to move to the XYZ location for a point, use the XYZ Snap command from the
Tools menu.

If Point Snap is turned off, the rubber-band line does not appear and you cannot get your
crosshairs to the exact location of the point.

Intersection Snap — When activated, the Intersection Snap function creates snap-points at the
every point member intersects another member. It also creates a snap-point at each location
where a vertical line of the snap grid intersects a horizontal line of the snap grid.
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In this mode, when you move your crosshairs past an existing snap-point, a rubber-band line
appears. A rubber-band line is a line that runs from the center of the crosshairs to the nearest
intersection snap point. Click the left mouse button while the rubber-band line is visible, and the
cursor moves to the exact XY location of that intersection snap point.

You must stay in the current Z plane when Intersection Snap is on. If you snap to a point that is at
a different height, the crosshairs move to that points XY coordinates, while staying at the current Z
height. If you want to move to the XYZ location for a point, use the XYZ Snap command from the
Tools menu.

If Intersection Snap is turned off, the rubber-band line does not appear and you cannot get your
crosshairs to the exact location of the point.

Perpendicular Snap — If Perpendicular Snap is turned on, you can snap to the XY coordinate of
existing snap-points in your model. In this mode, when you move your crosshairs past an existing
snap point, a rubber band line appears. A rubber-band line is a line that runs from the center of
the crosshairs to the nearest intersection snap-point. Click the left mouse button while the
rubber-band line is visible, and the cursor moves to the exact XY location of that perpendicular
snap-point.

You must stay in the current Z plane when Perpendicular Snap is on. If you snap to a point that is
at a different height, the crosshairs move to that points XY coordinates, while staying at the
current Z height. If you want to move to the XYZ location for a point, use the XYZ Snap command
from the Tools menu.

If Perpendicular Snap is turned off, the rubber-band line does not appear and you cannot get your
crosshairs to the exact location of the point.

XYZ Snap — The XYZ Snap icon is used to toggle the XYZ Snap function on and off. If XYZ Snap is
turned on, the user can snap to the XYZ coordinates of existing snap-points in a model. In this
mode, when the crosshairs of a cursor move past an existing snap-point, a rubber-band line (a line
running from the center of the crosshairs to the nearest snap-point) will appear. If you click the
left mouse button while the rubber-band line is visible, your cursor will jump to the exact XY
location of that snap-point. If XYZ Snap is not turned on, the rubber-band line will not appear,
regardless of how close you are to the snap-point. You will not be able to get your crosshairs to
the exact location of the point.

It is important to note that you will not necessarily stay in the current Z plane when in XYZ Snap. If
you are snapping to a point that is at a different height, the crosshairs will move to that height.
(This can cause problems if you are using XYZ Snap while viewing a layout from above, as it is
impossible to see changes in the Z direction). If you want to jump to the XY coordinates, and
preserve the current Z height, use the Point Snap tool instead.

You can tell if XYZ Snap is on or off one of two ways. The first is by looking in the Tools menu at
the XYZ Snap command. If the icon to the left of the command name on the Tools menu is
highlighted, then XYZ Snap is on. The second is to look at the status bar. If a Z is displayed in the
lower right, then XYZ Snap is on.

Shortcut: Press the Control and Z keys on your keyboard at the same time. This will toggle the
XYZ Snap on and off.

Note: XYZ Snap cannot be on at the same time as Point Snap. Only one of the two can be active
at any given time.
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Grid Snap — The Grid Snap icon is used to toggle the Grid Snap function on and off. If Grid Snap is
turned on, the user can snap to the points on the grid defined in the Set Snap Grid window. In this
mode, as your cursor moves around the Drawing Area, your X and Y coordinates will jump by the
increment defined in the Set Snap Grid window. If you click the left mouse button, your cursor will
jump to the nearest grid-point. (The XY coordinates that are displayed in the status bar at the
time). If Grid Snap is not turned on, the cursor will not be restrained by the grid, but will move
freely by increments of a sixteenth of an inch.

You can tell if Grid Snap is on or off one of two ways. The first is by looking in the Tools menu at
the Grid Snap command. If the icon to the left of the command name on the Tools menu is
highlighted, then Grid Snap is on. The second is to look at the status bar. If a G is displayed in the
lower right, then Grid Snap is on.

Shortcut: Press the Control and G keys on your keyboard at the same time. This will toggle Grid
Snap on and off.

Ortho — The Ortho icon is used to toggle the Ortho function (short for orthogonal) on and off.
When Ortho mode is active, users are restricted to drawing lines at 90-degree angles. (That is to
say, lines can only be drawn straight up, straight down, straight left, or straight right.

You can tell if Ortho is on or off one of two ways. The first is by looking at the Ortho command on
the Tools menu. If the icon to the left of the command name on the Tools menu is highlighted,
then Ortho is on. The second is to look at the status bar. If an O is displayed in the lower right,
then Ortho is on.

Shortcut: Press the Control and O keys on your keyboard at the same time. This will toggle Ortho

on and off. i
Set Snap Point Rules — Clicking on the Set Snap-Point Rules [ Ensble Eraming Member Snap Points
icon opens the Set Snap-Point Rules dialog box pictured at —Bottom Snap Points . :
right. This dialog box contains the following parameters: V' Enable for Walls &Posts - :

[V Enable for Beams Cancel ]

=  Enable Framing Member Snap Points — When this
checkbox is activated, GS Plan...

Save Defaults Restore Defaults |

BOTTOM SNAP POINTS
=  Enable for Walls & Posts — When this checkbox is activated, GS Plan...

= Enable for Beams — When this checkbox is activated, GS Plan...

COMMAND BUTTONS

=  OK - Click on the OK button to save your changes and close the Set Snap-Point Rules
dialog box.

= Cancel —Click on the Cancel button to discard your changes and close the Set Snap-Point
Rules dialog box.

= Save Defaults — Click on the Save Defaults button to save the current settings as your
default settings for snap-point rules.

= Restore Defaults — Clicking on the Restore Defaults button cancels any changes made to
the three checkboxes in this dialog box, and restores the checkboxes to their default state.
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Note that, once a user clicks on the Save Defaults button, the Restore Defaults button
cannot be used to return these checkboxes to their previous default state.

Set Snap Grid — The Set Snap Grid command allows you to define the |

grid-points used by the Grid Snap option. When you select Set Grid

Snap from the Tools menu, the Set Snap Grid Values window ed wih: [ 019

appears. This window is used to set the size of the snap grid used by Grid Height: [0-10

Grid Snap. o] |

There are two values to be entered into the Set Snap Grid Values

window; the Grid Width and the Grid Height. The Grid Width increment will establish grid lines

running vertically across the Drawing Area. Grid Height establishes the horizontal grid lines.

Every time two grid lines cross, a grid-point or snap-point is created.

Set Visual Grid — The Set Visual Grid command allows users to define =
x

the size of the grid displayed in the Drawing Area. When you select
Set Visual Grid from the Tools menu, the Set Visual Grid Values el 0-1-0
window appears. This window is used to set the size and type of the
visual grid being displayed.

=
It is important to note that the values for the Visual Grid are @ m
completely separate from the Snap Grid, established in the Set Snap x| —

Grid Values window. Your visual grid and your snap grid do not need

to be the same.

There are three values that can be entered into the Set Visual Grid Values window:
=  Grid Width — Establishes grid lines running vertically across the Drawing Area.
= Grid Height — Establishes the horizontal grid lines.
=  Grid Type — There are three different grid types that can be used:

Dots — When Dots is selected as the Grid Type, a small dot will be displayed at each
grid line intersection.

Lines — When Lines is selected as the Grid Type, each of the grid lines will be
displayed.

None — When None is selected as the Grid Type, the grid will not be displayed.
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Set Levels — The Set Levels command allows users to create new levels, and to view and edit
information about all the levels in the current model. See below for more information on each
field.

xl
Comment [TopofWaI [Levei | Active | Visible | Shadow |
Floor 0-0-0 10 Active Visible

[ o ] ol |  addied |  mion |  moF | Aishedow |

Comment — The Comment field is used to assign a name to each level. To edit the name in the
Comment field, click once on the name and then type in the new level name.

Top of Wall — This is the Z height of the top of the /\
bearings in the level. The picture above shows a section L ] ¢ 17-2-4
of a two-story house that is divided into three levels. Z 20 .12
dimensions are shown in green. The Top of Wall for {
each level is shown in blue. These Top of Wall heights 100 ¢ 8.1.2
are based on a 0-0-0 point. (In this case, the top of the Py ]
first-floor joists in red.) 10 s

o o | 000
Level — The Level field displays the identifying number Law J ;'E'g \_! " 1-0-0
assigned to each level in a structure. Before a house i e

can be input, you must divide it into levels. Generally,

each level should consist of framing members (roof or floor), and the bearings that support
them. After you have determined how your structure will be divided into levels, you need to
assign a number to each level. In the example above, the house is broken into three levels.
When numbering levels, you must go from top to bottom. (The highest level should have the
largest number; the lowest level the smallest number).

Notice that the assigned level numbers go from top to bottom. The upper level has the largest
number, since it is on top. The middle level has the next largest, and the lower level has the
smallest number. The order that you assign numbers to levels is very important, as
Structure™ will transfer the load through the building from the level with the largest number
down to the level with the smallest number. In this case, roof loads will be developed (level
20) and then passed through the second story walls to the second-story floor (level 10). The
loads will then pass through the first story walls to the floor, and then into the basement (level
5). If level numbers were numbered backwards, then the load would originate in the
basement and be passed up through level 10 and 20.

Notice that the levels are not numbered in increments of 1. There are several empty levels
between the upper and middle levels, and again between the middle and lower levels. This is

21



a recommended practice, as it may be necessary at a later time to add a load transfer member
between levels.

Active — The level that has Active displayed next to it is the level that currently being worked
on. You can only input or edit items on the active level. For this reason, only one level can be
active at a time. When you input on the Active level, you will be inputting at the Top of Wall
for that level. To turn a level to Active, click in the Active column to the right of the level
number.

To quickly make a level both Active and Visible, double click in the Active column next to that
level. This will remove the Visible or Shadow flags from all other levels, and make only the
one you double-clicked on Active and Visible.

Visible — If a level is Visible, it is displayed in full color and can be edited. To turn a level Visible
(or turn Visible off), click in this field to the right of the level number. A level can have Visible
or Shadow on one at a time. If neither is on, the level is invisible and cannot be seen or
edited.

Shadow — If a level is set to Shadow, it is displayed in the shadow color. (The default Shadow
color is dark blue). This level cannot be edited, but the snap-points are usable. To shadow a
level (or turn shadow off), click in this field to the right of the level number. A level can have
Visible or Shadow on one at a time. If neither is on, the level is invisible and cannot be seen or
edited.

COMMAND BUTTONS

OK — Click on the OK command button to save any changes made and return to the main GS
Plan window.

Cancel — Click the Cancel button to ignore any changes made and return to the main GS Plan
window.

Add Level — Click the Add Level button to create a new level. You will need to enter a level
number before you can leave the Set Levels window. (Only available level numbers will be
displayed in the drop-down list). When you return to the main window, the new level will be
completely empty. (Levels cannot be saved with the model until at least one entity is
entered.)

All On — Click the All On button to make all levels in the current job visible.
All Off — Click the All Off button to turn the Visible and Shadow flag off for all levels.

All Shadow — Click the All Shadow button to set all levels in the current job to Shadow.

Deselect All — The Deselect All command allows you to deselect all selected (highlighted) items in
the model. (In other words, no items in a model will be selected after this command is run.)

Select — The Select command puts you into Select Mode where you can select items to change,
edit, or delete. Choose this option and then click on an entity.

Select All Visible — Choose the Select All Visible option from the Tools menu to highlight every
member on every visible level. (See the Set Levels help for more information on visible levels).
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Enter Point — The Enter Point command allows users to move the crosshairs to any XYZ location.
Selecting the Enter Point command from the Tools menu will bring up the Absolute Point window,
which allows you to specify the exact coordinates of a point where you want your cursor to go.
This command is most commonly used when inputting entities. If you are in an input mode when
this command is run, the cursor will move to and pick the point entered, as if you had picked the
point with the left mouse button. Shortcut: Press the P key or the spacebar.

X — Enter the X coordinate of the point to which you want the
cursor to jump. The default value displayed in this field is the
coordinate that your cursor was at when the command was run.
Note: No entities should be input in negative space, so do not
input a negative number in this box.

Y — Enter the Y coordinate of the point to which you want the
cursor to jump. The default value displayed in this field is the
coordinate that your cursor was at when the command was run.

Absolute Point x|

X:
£

000
v [000
000

i

Note: No entities should be input in negative space, so do not input a negative number in this

box.

Z — Enter the Z coordinate of the point to which you want the cursor to jump. The default
value displayed in this field is the coordinate that your cursor was at when the command was

run.

COMMAND BUTTONS

OK — Click on the OK command button to move your cursor to the point defined by the

coordinates and select it.

Cancel — Click on the Cancel button to return to the main GS Plan window without moving

your cursor.
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Set Top of Wall — The Set Top of Wall command allows users to
establish a default Z height for input. When you select Set Top of
Wall from the Tools menu, a dialog box like the one pictured at right
will open. Set Top of Wall dialog box appears. Enter the desired
height in the Top of Wall Elevation field, and then click on the OK
command button to apply your new setting.

Set Top of Wall

Top of Wall Elevation: |0-0-0

Shortcut: Press the Control and H keys on your keyboard at the same time. Below is the Set Top
of Wall window. See below for more information on each field.

Show Coordinates — The Show Coordinates command allows users to view the XYZ coordinates of
a selected member. To use this command, select Show Coordinates from the Tools menu. Your
cursor will change into an arrow pointer. Move the tip of the arrow next to the member that you
want to see information about, and then click your left mouse button. The Show Coordinates
window will appear. After reviewing the information in the window, click the Cancel button to
return to the main window. At this point you are still in the command. Click on any other
members for which you need information. Click the right mouse button to exit the command.
Below is the Show Coordinates window. See below for more information on each field.

START POINT
X —This is the X coordinate of the start stertPont Font
point (or beginning point) of the selected % | 3 0 13 (16.0877) | 2210]13/020672)
line. ¥: | 59 11 15 (59.99480) | 59 11 15 (59.99480)
.. . Z: 0 0 0 (0.00000) 0 0 0 (0.00000)
Y — This is the Y coordinate of the start I |
point (or beginning point) of the selected Index: [ 188 Levets [10° Type: [10° sea: o
line. 1: [b2fSh26e-5306-4c68-87d0-cocada 1518

Z —This is the Z coordinate of the start point
(or beginning point) of the selected line.

END POINT
X —This is the X coordinate of the endpoint of the selected line.

Y —This is the Y coordinate of the endpoint of the selected line.

Z—This is the Z coordinate of the endpoint of the selected line.

Index — As each member is input, it is assigned an index number. This number serves as an ID
for the members. Note: Each time a model is altered, or a member deleted, index numbers
are reassigned.

Level — This is the level on which the selected member resides.

Type — This is the type of entity that is currently selected. There are 11 potential values:

0 — Construction Line

1 —Bearing
2 —Area
3 —0Opening

4 — Load (Point, Line, or Area)
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5—Plane

6 — Overhang

7 — Gable

8 — Hip End Line

10 - Framing Member
11— Hip End Member

Seq — If the entity selected is a compound entity (members that are made up of several lines
joined together, such as areas, planes, or openings), this field will display which line in the
entity was selected. Note: Like the Index number, the Seq number can change due to
alterations to the entity.

ID — The read-only ID field displays...
To close the Show Coordinates window, hit the escape key on your keyboard.

Show Messages — If a job encounters problems when it is run through Structure™ (i.e. errors,
warnings, or constraints), the Show Messages command will become available in the Tools menu.
Selecting Show Messages allows you to view the messages that were generated by Structure. The
messages will be displayed in the Structure Messages box. There are three buttons at the top of
the box:

=  Print — Click this button to print a copy of the message list.
=  Find — Click this button to search for a word or phrase in the message list.
= (lose — Click this button to close the Show Messages box.

In the box, a list of all messages for the current job will be listed. There are three different types
of messages:

Warnings — A warning is a small problem in the model that you should be made aware of, but
that is not a big enough problem to prevent the continued design of your structure.

Errors — An error is a structural problem in the model. This means that there is something
wrong with the model that is causing it to not be designed by Structure™. Errors must be
fixed before the job will run through Structure.

Constraints — A constraint is caused when a model presents Structure™ with a design problem
that it cannot solve, or exceeds the limits of Structure’s abilities. Constraints must be fixed
before a job will run through Structure.
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Show Structure Flags — Clicking on the Show Structure Flags listing on the File menu opens a
Structure Flags dialog box like the one pictured at right. This dialog box contains the following

attributes:
*  Level - x]
Generate  Truss Analyze Valid Member
= Generate Loads — 10 H';':d toade e e et T o Q|
=  Truss Files —
=  Analyze Products —
=  Valid Products -
4]
=  Member Placement -
=  Plot-
Check Bearings — The Check Bearings command is used to x|
make sure that each member on the active level has at least _
two supports. Selecting Check Bearings from the Tools menu i Hove i over cath red it o e

will check the members on the current level. If a member
fails the bearing check, it will be highlighted in red and an
error message, like the one pictured at right, will be

diagnostic message(s).

displayed. Aslong as Check Bearings is on, moving the cursor
over a red member will display a short message. One of the following messages will be displayed:

Fewer than two bearings — If this message is displayed, it is because the highlighted
member has only one, or zero, members supporting it. To fix this problem, add supports
to the member, then run Check Bearings again.

Too many supports — This message will appear when a member has more than 10
supports. To fix this problem, either remove some of the supports, or break the
problematic member into multiple parts.

Bearings cross each other — If bearing or framing members run through each other, you
will receive this message. Break one of the members at the point of intersection.

Indeterminate structure — This message appears if members bear improperly upon each
other.

Conflicting hipends — If you have two or more sets of hip-end framing interfering with
each other, you will receive this message. You may need to move a hip-end line or area to
fix this problem.

Conflicting bearings — This message appears if you have two or more of the same bearing
type occupying the same space. At least one bearing will have to be moved or changed to
fix this problem.

If a member has more than one of these errors, the error names will be displayed in the pop-up
separated by a semi-colon (e.g. Conflicting bearings; Indeterminate structure). Once a member is
highlighted it will remain that way until Check Bearings is turned off (selecting Check Bearings a
second time will turn it off). Check Bearings will not re-check the job unless it is run a second time
(turned off then on again).
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Check Geometry — The Check Geometry command checks your model for points that nearly, but
not exactly, coincide. It identifies and corrects points that are not multiples of 1/16" (or other
specified tolerance value); however, it does not directly identify non-orthogonal lines, or lines that
fail to connect with each other precisely.

To use this command, make sure the level you wish to test is active and visible. You should also
disable the visibility of any entities you wish to exclude from testing. Check Geometry only works
on visible lines within the level that is currently active. It will automatically exclude construction
lines, framing members, and dimension lines, whether visible or not.

Note that, as soon as you click the OK button on the Check Geometry screen, the dialog box
disappears, allowing you to view the entire Drawing Area. However, the command remains
checked in the Tools sub-menu until all errors have been corrected, or until you re-select Check
Geometry and click the Cancel button.

During the modeling process, there are times when it makes sense to use Check Geometry, and
other times when it is not advisable. One very good time (for which, in fact, the feature was
originally designed) is immediately after you have imported a DXF file as a shadow job. If slight
geometric errors in a DXF file are allowed to remain when GS Plan entities are traced, those errors
will be propagated throughout the entire model. Therefore, immediately after loading a DXF file,
you should use Check Geometry to scan the file (as a shadow job) and correct slight errors that are
too small to be detected with the naked eye.

Another good time to use Check Geometry is immediately after you have drawn all walls (and
optionally headers), but before you have added any framing areas or roof planes. In general, the
XY coordinates of ridge and valley lines will seldom coincide with even multiples of any specified
tolerance. You do not want Check Geometry to adjust plane coordinates so that the resultant
vertices are no longer co-planar.

Finally, you should consider using Check Geometry whenever you get the message "Cannot form
exterior boundary" (typically when using the Create Shear Lines command or Ceiling Planes
macro). This message can arise from one or more breaks between exterior walls and/or headers
in your model which are too small for the eye to detect, but which Check Geometry can readily
identify.

: - [Check Geometry N
After selecting the Check Geometry option, the e =
Check Geometry window (shown at right) will Alowable tolerance: [1/16 <]
appear. See below for more information on each Sean: i R i

(" Display tolerance errors below this value.
" Adjust selected line(s) to this tolerance.

field.

. " Exdude selected lne ; ad all others.
Allowable Tolerance — This tolerance should = S S Aot

normally be set to 1/16" or 1 mm (since these
are the usual increments used in architectural o] [ o |
drawings). However, you may also check

tolerances to the nearest 1/8", 1/4”, or whatever value makes sense within the context of
your drawing.

SCAN

Current Job — When this radio button is selected, GS Plan checks the geometry of all visible
entities on the level that is currently active.
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Shadow Job (incl. DXF) — When this radio button is selected, GS Plan checks the geometry of a
file that has been imported via File—> Load Shadow Job, including imported DXF jobs. Note
that shadow jobs are not the same as shadowed levels, which always belong to the current
job.

[ACTIONS]

Display tolerance errors below this value — When this option is selected, GS Plan finds all
error lines (lines whose endpoints are not even multiples of the specified tolerance) without
attempting to correct them. It first displays the number of error lines discovered. If no errors
are discovered, a message to that effect is displayed.

After you click on the OK button, the error message will disappear and any lines with
geometric errors will appear in red on your screen. For bearing members (such as walls or
headers), only their reference lines will turn red. To view the XY coordinates of any red line,
move the cursor close to it, and the coordinates will be displayed near the cursor.

Adjust selected line(s) to this tolerance — This option changes the XY coordinates of (both
endpoints of) selected lines to the nearest 1/16", or other specified tolerance. As each error
line is corrected, its display reverts to its native entity color. Line selection is terminated by
pressing the Escape key on your keyboard, or clicking the right mouse button.

Exclude selected line(s); adjust all others — This option allows you to exclude one or more
lines from adjustment. This strategy is useful for non-orthogonal lines (such as diagonal walls),
whose endpoints you know cannot be even multiples of the designated tolerance. As each
error line is excluded, its display reverts to its native entity color. Line exclusion is terminated
by pressing the Escape button on your keyboard or clicking the right mouse button, at which
point all non-excluded error lines will be adjusted.

Adjust all lines to this tolerance — This option changes the XY coordinates of all visible lines,
on the level that is currently active, to the nearest multiple of the specified tolerance, without
first displaying them in red. You should be careful not to use this option indiscriminately, or
you can potentially corrupt the model beyond easy restoration.

COMMAND BUTTONS

OK — Click on the OK button to save your changes and close the Check Geometry dialog box.

Cancel — Click on the Cancel button to discard your changes and close the Check Geometry
dialog box.

Options — The Options commands allows users to create and edit plan options, and to select the
options to be displayed on-screen. Jobs that contain options are saved as .MAY and .M** files
(instead of the usual .LAY and .L** files). MAY files cannot be run in Structure, however, so you
must use the Options Extract As command on the File menu if you need to run the job through
Structure.

Before drawing any options, you will ordinarily construct a base house, in order to give yourself a
frame of reference for the options. Drawing a base house is exactly the same as drawing any other
model in GS Plan. Entities (bearings, planes, framing areas, etc.) not specifically associated with an
option belong to the base house by default. You may want to save the base house as either a
“.LAY” or “.MAY"” file, before proceeding with creating the options.
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When you select Options from the Tools menu, a sub-menu opens with five listings:

1. Create/Edit Option

2. Select Options
3. Copy/Xfer Option
4. Copy Selected Entities
5. Option Materials
Create/Edit Option
To create a new option, click on Tools - Options x|
- Create/Edit Option. The screen pictured at Select/Enter New Option
right will appear. . |
DR Bay Window MadiyiExclude Optior |
Select/Enter New Option — If you are creating a b e SO _
new option, type a name for the option in the T RUP—. Sub-Option |
Select/Enter New Option field. If you select an e Remove Option |
existing option from the pane immediately below Excusion(s) s sub-options
this field, the name of the selected option will be i -
displayed in this field. Prished Basement
Fireplace
. i Fred's Grandmother's Room ﬂ
Option names may be up to 40 characters in et
length and may contain spaces. Itis | [_RetmTosaserouse |

recommended that you use names that are
reasonably suggestive of the option content, so
that you (or someone else) can readily identify
them from a list of available options. As soon as you type one or more characters of the option
name, the Clear Selection, Add/Modify Option and Draw Option command buttons will be
activated.

Figure 1: The Create/Edit Option window.

Option names are stored with a job when it is saved. Therefore, whenever you add a new option
name (or modify the spelling of an existing name) and click on Add/Modify Option, the job will
have been changed — even though you may not have drawn any new entities. If you subsequently
exit the job without saving it, you will be prompted to save these changes.

Exclusions — To eliminate the possibility that a user might select or extract conflicting options, the
Create/Edit Option dialog box allows you to identify "mutually exclusive" options. From the upper
list box, select any one of the conflicting options. Then in the lower list box (Exclusions), select
those options you wish to exclude. Finally, click on the Modify/Exclude button. Thereafter, in the
Select Options dialog box, it will no longer be possible to select conflicting options.

It is not necessary to exclude options reciprocally. That is, if Option A excludes options B and C,
Option B will automatically exclude A and C, and Option C will automatically exclude A and B. To
reverse the exclusion process, simply re-select one of the excluded options in the upper list box
and de-select the other one(s) in the lower list box; then click again on the Modify/Exclude Option
command button.

Do not confuse excluded options with "excluded base house entities." (That is, base-house
entities that have been deleted from a particular option. The two concepts have nothing to do
with one another.)
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COMMAND BUTTONS

Clear Selection — Clear Selection erases the name entered into the Select/Enter New Option field.
Add/Modify — Copies the name to the two list boxes below.

Sub-Option —

Remove Option — Clicking on the Remove Option button will delete the selected option from the
list of available options.

Draw Option — The Draw Option returns control to the Drawing Area, where you may begin
drawing entities belonging to that option. It is not necessary to draw each option as you name it.
If you are modeling a base house with several options, you may type each name and click
Add/Modify Option at the outset.

Option names will always be listed in alphabetical order, regardless of the sequence in which they
were entered. To select a particular option to draw (or modify), click on the corresponding name
in the upper list, and then click on the Draw Option button.

Whenever you leave the Create/Edit Option dialog box via the Draw Option button, you will be in
Draw Option mode. The specific option being drawn is the one that was displayed at the top of
this box. You can return to the base house at any time by clicking the Exit Options button that
appears at the bottom of the Classic Sidebar. (Alternatively, you can return to the Create/Edit
Option dialog box and click on the Return To Base House button.)

For additional information about options, see the section within this document entitled “Working
with Options.”

Return To Base House — Returns the user to the base house. (That is the house without any
options or sub-options.)
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Select Options

To select one or more options simultaneously, click on Tools - x|
Options = Select Options. A Select Options dialog box like the one Cosed Foyer

pictured at right will open. Only those options for which entities have DR T Cata!

actually been drawn will be displayed on this screen. (As compared R oot

with the Create/Edit Option screen, which also displays options that Fiok-Frotped Bosement

have been named but not yet drawn.) i
Select a particular option by clicking on its name. As each selection is
made, the corresponding option will become highlighted. To clear “Has sub-options
the list of all selections, click on the Clear button.

You will sometimes find that selecting an option will cause one or

more other options to disappear from this list. This phenomenon arises whenever options have been
designated as mutually exclusive. In this case, GS Plan prevents you from choosing two options that
would conflict with each other geometrically. (For example, a three-car garage with a gable roof and the
same three-car garage with a hip roof.)

To return to the Drawing Area showing the base house with all selected options, click on the OK button.
To ignore any changes, click on Cancel. Note that Cancel will not necessarily restore the base house if
options were selected prior to opening the Select Options dialog box. You must first clear the
selection(s) and then exit via the OK command.

Whenever you leave the Select Options screen with one or more options selected, you will be in Select
Options mode. The same Exit Options button will appear on the Classic Sidebar as when you were in
Draw Option Mode. This button provides a convenient way to restore the base house without returning
to Select Options and deselecting all options.

In Select Options mode, you cannot draw any new entities because GS Plan will not know the option to
which they belong. You also cannot select and modify existing entities. In fact, most of the Modify,
Entities, Macros, and Lateral menu commands will be disabled. Only the following commands will
remain available:

= Modify - Set Properties (assuming you have selected a specific entity)
= Modify = Shift/Copy Model

=  Modify = Rotate Model [Temporary]

= |agteral - Create/Erase Shear Line.

While using the Selection Options function, the Modify = Set Properties command will allow you to
inspect, but not change, the properties associated with the selected option(s). The Modify - Shift/Copy
Model will translate all entities (whether belonging to selected options or not) to a new XYZ-coordinate
system. Modify = Rotate [Temporary] will rotate all entities (whether belonging to selected options or
not) around the (0,0) origin. And Lateral - Create/Erase Shear Lines will create or erase shear lines for
all visible entities on the active level, as previously described.

Despite these drawing restrictions, all of the Tools and Display menu commands are still available in
Select Options mode. Therefore, you can Animate, Zoom In, and Pan across the entire base house with
selected options. You can also check truss profiles, change visibility (by level or by entity type), verify
XYZ-coordinate values, and check bearing conditions for any combination of options.
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The File - Options Extract As command operates in conjunction with Select Options to generate a set of
"L" (.lay and level) files containing the base house plus all selected options. (If no options have been
selected, only base house entities will be extracted.)

Other File menu commands work with options pretty much as one would expect:

File > Generate Materials List creates a file containing non-engineered products and other materials
for the base house and selected options only.

File >Merge assumes that all merged entities belong to (the current level of) the base house.

File = Print Drawing will print entities belonging to the base house and currently selected options
only (i.e. whatever is visible in your drawing area).

Conflicting Options

Any time two or more options cannot co-exist, they are said to conflict. One obvious situation is when
options occupy the same geometric space. For example, a three-car garage with a gable roof cannot co-
exist with (the same) three-car garage with a hip roof. Another less obvious situation arises when
options that apparently do not conflict geometrically require alternate framing configurations — even
though those configurations may differ only in some minor respect. Consider the following example:

Figure A shows the base house. A’ 1) B ! =1 e 1k
Figure B shows the same base W E e i1 e
house with a fireplace option
(overhang cut-away) in the
upper right-hand corner. Figure
C shows the same base house
with an optional room in the
lower right-hand corner. Figure
D shows the same base house c R 3
with a hip roof option on the
left side.

A .

|

Although this is just an example, - ,
the fact remains that all of ’ r- ' o —

these options conflict with each A —
other! The framing area in - TT1 L4
Figure B requires a different on-

center spacing than all the others. The framing area in Figure C requires a roof opening for a skylight
(with a consequent break in one of the trusses), and the framing area in Figure D requires hip-end
members from the roof peak down to the left eave. The way these options were modeled was to delete
the base house framing area from each of them, and then draw separate framing areas for each one.
Note that the roof planes are the same throughout, except for the hip-roof option, where they had to be

deleted and replaced with three option-specific planes.

By the way, when in Draw Option mode, you may be tempted to delete individual base-house framing
members. For example, in drawing the option illustrated in Figure C, you might consider deleting the
truss that intersects the skylight opening and drawing two separate truss members on either side. This
strategy is not recommended. As soon as you re-generate members for the base house, the deleted
truss will re-appear. It is much better to delete and redraw the entire framing area for the specific
option.
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Copy/Xfer Options

Executing the Copy/Xfer Option command will open a Copy/Transfer x|
Option dialog box like the one pictured at right. As its name implies, gmﬂy?{mw
this dialog box is used to make a copy of an existing option, or to DR Tray Ceiing
. . Finished Basement
transfer an option to a different . I

Half Finished Basement

COMMAND BUTTONS

Copy Option — If you attempt to copy a parent-level option, GS
Plan will display the error message pictured at right. Copy Option I T |

Transfer Option — ???

OK — Clicking on the OK button...

Cancel — Clicking on the Cancel button...

Copy Selected Entities

The Copy Selected Entities function adds the ability to make actual physical copies of Option entities in
addition to the current functionality of being able to make logical copies of Option entities. To activate
this feature, you must be in Create/Edit Options mode with a currently active Option displayed on the
screen. If this is not the case, the Copy Selected Entities menu selection will be disabled, along with the
corresponding icon on the Options toolbar. Enabled selections will appear as a pull-down selection from
the Tools menu or as a toolbar icon in the Options toolbar.

Copy Selected Entities requires the selection of one or more entities belonging to the current Option. If
no entities are selected you will receive the following message:

l: At least one entity from the current option must be selected.

If you have selected entities that do not belong to the current Option you will receive this message:

!E Selected entities that do not belking to the current option wall be igrared.

o]
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If an entity from the current option has been
selected, the Copy Selected Entities dialog
box will open. The Copy Selected Entities
dialog box lists the target Options available
to receive the copies of the selected entities.
The current Option in this example is:

004 Walkout Basement
006 Standard Door
007a Swing Left

Notice that the current Option (007a Swing
Left) will never appear in this list. (It does not
make sense to copy an option to itself!)
Additionally, if the parent of the current
Option only has one Sub-Option (the current
option), it will also be removed from the list.

Option entities cannot be copied to direct
ancestors of the current Option. This logic is
applied all the way up the hierarchical chain
as appropriate (grandparent Options, great

Copy Selected Entities

{001 Walkout Deck
002 Opt, Shees
003 Standad Doot

004 'Walkout Basement
005 Opt. Shdes
006 Standad door
007b Swang Right
005 Garden
101 Elevahon A
102 Elevabon B
103 Elevation C
106 Freplace
107 Fee/meda A
108 Fre/Media B
109 Standard Lrving
112 0p. Bay Windw
113 Stardad Kitch
201 Loit
202 Bedioom
203 Master Codng
204 Mastes Vauk. Ceiing

& Logeal Copy

" Physicel Copy

Cancel

grandparent Options, and so on). That said, however, if the parent Option (or grandparent Option, etc.)
has more than one Sub-Option (a sibling to the current Option), the parent Option will be displayed
along with the sibling Option(s). The ability to copy Option entities to sibling Options is a necessity.

This circumstance creates the potential for copying Option entities to direct ancestors which, as we
stated previously, is not allowed. Proper handling of this situation will be described below.

You will now select the destination Options by highlighting selections in the available Options list.
Multiple destination Options can be selected by holding down the Control key down on your keyboard

as you click with your mouse.

In addition to selecting destination Options, you must also determine whether the new Option entities
will be Logical or Physical copies of the current Option entities. This is accomplished by clicking on the
appropriate radio button. Logical is the default selection. A logical copy mimics the current
Copy/Transfer Option behavior. That is to say, it does not create a new entry in the job files, but rather
associates the existing entities with the destination Options by setting the appropriate Option flag
information (a transfer). A Physical copy creates a new entry within the job files for each of the
selected destination Options (a copy). Thus, the newly created entities are autonomous and can be
modified without affecting the properties of the original entities.



A typical selection screen might appear as:

Copy Selected Entities

107 Fue/meds A

109 Standard Livng
112 Op. Bay Windwe
113 Standord Kdch
201 Lokt

200 Master Caing
204 Mastor Vault Cesirg

T Logeel Copy & Prysical Copy

.

In this situation you have requested to make a physical copy of the currently selected Option
entities to the following Options:

001 Walkout Deck
002 Opt. Slider
004 Walkout Basement
108 Fire/MediaB
202 Bedroom

Clicking the Cancel button will abort the Copy Selected Entities process.
Clicking the OK button will initiate the process.

There are a few potential issues that need to be addressed. The first is that the options 001
Walkout Deck and 001 Walkout Deck | 002 Opt. Slider are direct ancestors of each other. This
will create an unnecessary duplication of the selected entities and as a result will not be
allowed. You will receive the following error message and be required to reselect the
destination options:

!: Copying entities to the same hierarchical Ineage & not allowed,

]

The second is the fact that 004 Walkout Basement is a direct ancestor to the current Option.
004 Walkout Basement
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006 Standard Door
007a Swing Left

Since this is also not allowed, you will receive this warning message:

:5 Request to copy entities to direct ancestors vl be ignored.

e ]

You will not be required to reselect destination Options in this case. The offending Option is
merely ignored and the remaining valid destination Options are honored.

There are no additional error checks aside from those listed above. There is no provision to
prevent you from copying a selected entity to a specific destination Option more than once
using subsequent Copy Selected Entities requests. Likewise, there is no provision to prevent
you from copying a selected entity to an ancestor of an Option to which it has previously been
copied. Both of these situations could produce entity duplicates that are unnecessary as well
as potentially hazardous to the model processing.

Toolbars — The main Model window can be customized to include one or more toolbars. Each
toolbar contains commands either from specific menus (i.e. File, Tools, or Modify) or collections of
often used commands (i.e. Classic Sidebar or Standard). Each toolbar option corresponds to a
menu option, but they are grouped together for your convenience. Each toolbar is described
below. Click on a link to jump to information about that specific toolbar or scroll down to read
about each.

Custom Toolbars —

Option Materials
Clicking on the Option Materials line-item on the Tools - |
Options menu will open a message box like the one
Open the CSV file?
pictured at right... (C:\KBS\I0BS \Demo\Demo2\/OptionMaterials_Demo2.csv)

= _» |
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THE MODIFY MENU & TOOLBAR

The Modify menu and toolbar provide users with commands for editing
existing members of your model.

—| Set Line Length — The Set Line Length command is used to view
and change the exact length of a selected member. To use this
command, first choose Select from the Classic Sidebar, Standard
toolbar, or the Tools menu. Use the arrow cursor to select the line
that you want to modify. Keep in mind that the point you select
closest to the endpoint is the one that will move.

When you select the Set Line Length from the Modify menu, a
dialog box like the one pictured in Figure X will open.

= Reference Length — This is the distance, along the line,
from the beginning point to the endpoint.

= X Length —This is the change, along the X axis, from the
beginning point to the endpoint.

= Y Length —This is the change, along the Y axis, from the
beginning point to the endpoint. In this example, a

horizontal line was selected, so the Y Length is grayed out.

= ZLength—This is the change, along the Z axis, from the
beginning point to the endpoint. In this example, a
horizontal line was selected, so the Z Length is grayed out.

=  Member Length —

=  OK - Click on the OK button to save your changes and
close the Set Line Length dialog box.

+— SetLine Length...

A, SetLine Angle...

== Move Endpoint

< SphtLine...

/¥ Join Lines

X, IrimfExtend Lines

-~ Trim/Extend Two Lines
H| OffsetLine / Array...
— | Reverse Reference Line
{7} Make Polygon Edges...
Set Properties

W)

(0"

S shift/Copy Selected...

@ Rotate Selected...

A Mirror Selected. ..
Delete Selected

&5 Change Level...

shift/Copy Model...
() Rotate Model [Temporary]...
[ setProperties Mode
[y Relap Comers
™ Relap Corners to Default

Modify Entities Display Macros Lateral

= 0 X & = n 3

Y Length: 31-11-12

OKI Cancel

Reference Length |31.11-12
|—
|—

—
—

=  Cancel — Click on the Cancel button to discard your changes and close the Set Line

Length dialog box.
Examples in e-text.

él Set Line Angle — The Set Line Angle command is used to view and
change the exact angle of a selected member. To use this

command, first choose Select from the Classic Sidebar, Standard
toolbar, or the Tools menu. Use the arrow cursor to select the line
that you want to modify. Keep in mind that the point you select
closest to the endpoint is the one that will move. (The line will
pivot around the other point.) When you select the Set Line Length
from the Modify menu, a dialog box like the one pictured in Figure X
will open.

= Angle —This is the angle of the line measured
from the beginning point to the endpoint. The
angle of a line is based on the XYZ axis and is
measured from the beginning point to the
endpoint of the line. Pictured at right is the
same line selected twice. Notice that the angle
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Set Line Angle
Angle: | 90.000

DY/DX: | Vertical
I oK I Cancel |




of the line changes because of the location of the endpoint.
=  DY/DX - This is the change in the Y axis over the change in the X axis.

=  OK - Click on the OK button to apply your changes to the selected line and close the Set
Line Length dialog box.

= Cancel — Click on the Cancel button to discard your changes and close the Set Line
Length dialog box.

Examples in e-text.

Move Endpoint — The Move Endpoint command is used to change the location of a selected
member’s endpoint. To use this command, first choose Select from the Classic Sidebar, Standard
toolbar, or the Tools menu. Use the arrow cursor to select the line that you want to modify. Keep
in mind that the point you select closest to, will be the endpoint (the point that will be moved).
Select Move Endpoint from the Modify menu. Choose the new location for the selected point,
using either the mouse or keyboard input commands. (The same way you would choose the
endpoint when inputting a single line.)

Split Line — The Split Line command is used to break a selected [spitine x|
member into multiple pieces. To use this command, first choose  fofeanions F
Select from the Classic Sidebar, Standard toolbar, or the Tools : -
menu. Use the arrow cursor to select the line that you want to € % from beginning
modify. (Keep in mind that the point you select closest to will be £ % from end
the endpoint.) Next, select the Split Line command from the
Modify menu. When you do so, a dialog box like the one pictured
in Figure X will open.

—
(" distance from beginning |
. " distance from end

(5] o]

= # of Equal Parts — When this radio button is activated, you
can enter the number of parts into which you want Split
Line to break the selected line.

= % from Beginning — When this radio button is activated, you can break the selected line
by a specified percentage from its beginning point.

= % from End — When this radio button is activated, you can break the selected line by a
specified percentage from its endpoint.

= Distance from Beginning — When this radio button is activated, you can break the selected
line by a specified distance from its beginning point.

= Distance from End — When this radio button is activated, you can break the selected line
by a specified distance from its endpoint.

Examples in e-text.

=7
o |

Join Lines — The Join Lines command is used to join two lines of the same type together into one.
To use this command, first choose Select from the Classic Sidebar, Standard toolbar, or the Tools
menu. Use the arrow cursor to select the first of the two lines that you want joined together.
Select Join Lines from the Modify menu. Click on a second line that you want joined with the first
selected line.

Trim/Extend Lines — The Trim/Extend Lines command is used to shorten or lengthen lines so that
they meet the selected line. To use this command, first choose Select from the Classic Sidebar,
Standard toolbar, or the Tools menu. Use the arrow cursor to select the line that you want other
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lines to run to (not the lines that will move). Select Trim/Extend Lines from the Modify menu.
Click on the end of the lines that you want to meet the selected line. When finished, click the right

mouse button to exit the command.

Trim/Extend Two Lines — The Trim/Extend Two Lines command is used to shorten or lengthen two
non-parallel lines so that their endpoints meet. To use this command, first choose Select from the
Classic Sidebar, Standard toolbar, or the Tools menu. Use the arrow cursor to select the first of
the two lines that you want to meet. Make sure that you click closest to the end at which you
want the second line to end. The endpoint is the point that will be joined with the second line.

Select Trim/Extend Two Lines from the Modify menu. Click on the end

of the lines that you want

to meet the selected lines endpoint. The two selected ends will move so that the lines now are

end to end.

Offset Line/Array — The Offset Line/Array command is used to x|

move a line a specific distance perpendicular to its original
location. To use this command, first choose Select from the
Classic Sidebar, Standard toolbar, or the Tools menu. Use the
arrow cursor to select the line that you want to modify. Make
sure that you note the end of the line that you click closest to, as

" Click Offset (+ Reference Line Offsat

Distance: | 0-0-0

(Positive Right, Negative Left)
™ Retain Original

(] =]

the direction of the offset will depend upon the location of the
endpoint. Select Offset Line/Array from the Modify menu. This
will open an Offset Line/Array dialog box like the one pictured at right.

= Click Offset —

= Reference Line Offset —

= Distance — Enter the distance that the line is to be offset. Enter a positive value to offset
the line to the right, and a negative value to offset the line to the left.

= Retain Original —

= OK-Click on the OK button to save your changes and close the Offset Line/Array dialog

box.

= Cancel —Click on the Cancel button to discard your changes and close the Offset

Line/Array dialog box.

Examples in e-text.

Reverse Reference Line — Bearings are defined by the reference line. The reference line is the part
of a wall with a dot on either end. You may need to reverse the reference line due to a bearing or

ledger condition.

The Reverse Reference Line command is used to change the reference

line side of the selected

bearing, without moving the bearing’s location. The Reverse Reference Line command will only
become available if you have a bearing member selected. To use this command, first choose
Select from the Classic Sidebar, Standard toolbar, or the Tools menu. Use the arrow cursor to
select the bearing that you want to modify. Select Reverse Reference Line from the Modify menu.

The reference line will move to the opposite side of the bearing.

command.

NOTE! A bearing member with the reference line set to center will not be affected by this

39



Make Polygon Edges — The Make Polygon Edges command is
used to create a polygon (and therefore "rounded" walls) from
a current straight line segment. To use this command, first
choose Select from the Classic Sidebar, Standard toolbar, or
the Tools menu. Use your mouse to select the straight line
that you want to make rounded. Select Make Polygon Edges
from the Modify menu. The Make Polygon Edges dialog box
will open.

=  Number of Edges in Complete Polygon — Enter the
number of edges in the complete polygon (as if it were

a full circle). This determines the angle of the individual

N
x|

& Number of edges in complete polygon: 0
" Radius of circumscribed circle: 00
Number of edges to construct: l_
Selected line is:
* Comerto-comer
" Edgeto-edge

" Comerto-edge
" Edgeto-comer

OK I Cancel

sections as well as the number of segments to appear when the polygon is constructed.

= Radius of Circumscribed Circle — Enter the radius of the circle.

= Arc Height/Width — Enter the Arc Height/Width.

= Number of Edges to Construct — Enter the number of polygon edges to be constructed
(with % edges being counted as full edges). The number of edges must always be less that
the number of edges in the complete polygon, if that option was selected above.

= Selected Line Is:
A. Corner to Corner -
B. Edge to Edge —
C. Corner to Edge —
D. Edge to Corner -

——— e
" OK-
= Cancel -

NOTE! Polygon edges cannot be created from a raked wall.

|5

2[5

Set Properties — The Set Properties command allows you to view and change the properties of a
selected member. To use this command, first choose Select from the Classic Sidebar, Standard
toolbar, or the Tools menu. Use the arrow cursor to select the entity that you wish to modify.
Select Set Properties from the Modify menu. A properties window will open. (Note that the
specific type of properties window that opens will depend upon the entity type that you have
selected within your model. Review and modify the properties as appropriate, then click OK.

Undo — The Undo command reverses the effects of the last single-line Modify command.

Redo - Click on the Redo button to reapply changes that have been undone using the Undo

button.

40




Shift/Copy Selected — The Shift/Copy Selected command allows you to move or copy selected
linesin the X, Y, or Z direction. To use this command, first choose Select from the Classic Sidebar,
Standard toolbar, or the Tools menu. Use the arrow cursor to select the member(s) that you want
to modify. Select Shift/Copy Selected from the Modify menu. The Shift/Copy Selected dialog box
will open.

X Shift — This is the amount that you want the selected lines [Shift Selected
to be moved (or copied) along the X axis. In Plan View, enter

o . . X shift: [0-0-0
a positive number to move the line to the right; enter a T
negative number to move the line to the left. zsnf:[o00
: . . I Retain Original (Copy)
Y Shift — This is the amount that you want the selected lines I Use Snap Points '
to be moved (or copied) along the Y axis. In Plan View, enter I tiold Bottom of Walls
. R X ™ Maintain Truss Edits
a positive number to move the line up; enter a negative
number to move the line down. [ox] o]

Z Shift — This is the amount that you want the selected lines to
be moved (or copied) along the Z axis. In Plan View, enter a positive number to move the
line toward you; enter a negative number to move the line away from you.

Retain Original (Copy) — If the Retain Original checkbox is activated, when the OK button
is clicked, the original selected line(s) will remain in their original position, and a copy will
be created then shifted the distance specified.

Use Snap Points — If the Use Snap Points checkbox is activated, when the OK button is
clicked, you will be prompted to select a "From" and "To" point on your model, rather
than defined shift directions and distances.

Hold Bottom of Walls — If the Hold Bottom of Walls checkbox is activated, when the OK
button is clicked, the bottoms of all wall members will remain at their original Z height.
The tops of the walls will then move the distance specified in the Z Shift field. This will not
affect members shifted on the X or Y axis.

Maintain Truss Edits —

OK — Click the OK button to move (or copy) the selected members the distance specified,
then return to the main window.

Cancel — Click the Cancel button to return to the main window without moving or copying
the selected members.

Examples in e-text.
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Rotate Selected — The Rotate Selected command is |
used to rotate a selected member (or members),

in a counterclockwise direction, around one of
three types of points. To use this command, first
choose Select from the Classic Sidebar, Standard

Enter angle of rotation (CCW from original)
J0.000

& Around geometric center
€ Around minimum xy point

toolbar, or the Tools menu. Use the arrow cursor " Around selected snap point
to select the member(s) that you want to modify. ok | —

Select Rotate Selected from the Modify menu. The
Rotate Selected dialog box will appear.

= Enter Angle of Rotation (CCW from Original) — Enter the angle of rotation (positive or
negative) that you wish to rotate the model. Remember that the model will be rotated in
a counterclockwise direction. . .

=  Around Geometric Center — If you choose this
option, the model will be rotated around its
own center point. (Point A in Figure X.)

=  Around Minimum XY Point — Choose this
option to rotate the model around the pointin | | ||
the model that has the lowest XY coordinate = =
values. (Point B in Figure X.)

=  Around Selected Snap-Point — Choose this option to rotate the model around any snap-
point you choose. If you choose this option and click on the OK button, you will be
prompted (in the status bar) to click on the snap-point around which you wish to rotate
the model.

= OK - Click OK to rotate the model according to the angle and point selected above.

= Cancel - Click the Cancel button to return to the main window without rotating your
model.

;E)J Mirror Selected — The Mirror Selected command is used to mirror or invert the selected member

: (or members) across a specific line. To use this command, first choose Select from the Classic
Sidebar, Standard toolbar, or the Tools menu. Use the arrow cursor to select the member(s) that
you want to modify. Use your mouse to select the axis of reflection (the line that you want the
selected member(s) to be mirrored along — usually a construction line). Click on the Mirror
Selected command on the Modify menu. The Mirror Selected dialog box will open.

= Retain Original Portion — If this box is checked, the selected x|
members will remain where they are and a copy of them will

be generated and mirrored along the axis of reflection (the line [~ Myror Lines On Ads
that you want the selected member(s) to be mirrored along).

=  Mirror Lines on Axis — If this box is checked, the member
selected as the axis of reflection will be mirrored along with the
other members. If it is not checked, the axis line will not be mirrored.

=  OK-—Click the OK button to return to the main window where you will be prompted to
select the axis of reflection. (That is, the line along which you want the selected
member(s) to be mirrored.)

= Cancel - Click the Cancel button to abort the Mirror Selected command and return to the
main window.
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Examples in e-text.

Delete Selected — The Delete Selected command is used to permanently erase all selected lines
from your model. To use this command, first choose Select from the Classic Sidebar, Standard
toolbar, or the Tools menu. Use the arrow cursor to select the member(s) that you want to
delete. Select Delete Selected from the Modify menu.

If only a single member is deleted with this command, it can be brought back using the Undo
command. If, however, multiple members are selected when the command is run, the Delete
Multiple Lines window will open, requiring the user to confirm his or her intention to delete
multiple lines. If the user elects to delete multiple members, there is no way to restore the
deleted members. (That is to say, there is no Undo command available for a multiple-line
deletion.)

Shortcut: Press the Delete key while one or more members are selected.

Change Level — The Change Level command is used to specify a new x|
level number for the selected members. To use this command, first

choose Select from the Classic Sidebar, Standard toolbar, or the Enter new level number: [ 10
Tools menu. Use the arrow cursor to select the member(s) that you ™" Indude Plot dimension lines

want to modify. Select Change Level from the Modify menu. The E’ cance |

Change Level dialog box will open.

= Enter New Level Number — Enter the level to which you want the selected members to be
assigned.

= |nclude Plot Dimension Lines — Activate this checkbox if you want to include the
dimension lines when the members are moved.

=  OK - Clicking on the OK button will apply your changes and close the Change Level dialog
box.

= Cancel — Clicking on the Cancel button will discard your changes and close the Change
Level dialog box.

When the members are moved to a new level, they will retain their original locations and
properties. For example, if a wall with a top plate height of 10-0-0 is moved to a different level, it
stays a wall with a top plate height of 10-0-0, regardless of the Top of Wall height of the new level.
If a member is moved to a level that does not yet exist, that level will automatically be created
(with a Top of Wall height of 0-0-0) and set to Visible.

Shift/Copy Model — The Shift/Copy Model command is used to move
or copy an entire model in the X, Y, or Z direction. To use this x shift: [0-00
command, select Shift/Copy Model from the Modify menu. The ¥ shift: [ 000
Shift/Copy Model dialog box will open. zshft:[000
I Retain Original (Copy)
= X Shift — This field is used to define the distance you want I Use Snap Ponts
i A . ™ Hold Bottom of Walls
your model moved (or copied) along the X axis. In Plan View, [~ Maintain Truss Edits
enter a positive number to move the line to the right; enter a ] Conce |
negative number to move the line to the left.

= Y Shift — This field is used to define the distance you want your model moved (or copied)
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along the Y axis. In Plan View, enter a positive number to move the line up; enter a
negative number to move the line down.

Z Shift — This field is used to define the distance you want your model moved (or copied)
along the Z axis. In Plan View, enter a positive number to move the line toward you; enter
a negative number to move the line away from you.

Retain Original (Copy) — If the Retain Original checkbox is activated, when the OK button
is clicked, the model will remain in its original position, and a copy will be created then
shifted the distance specified.

Use Snap Points — If the Use Snap Points checkbox is activated, when the OK button is
clicked, you will be prompted to select a "From" and "To" point for your model, rather
than defined shift directions and distances.

Hold Bottom of Walls — If the Hold Bottom of Walls checkbox is activated, when the OK
button is clicked, the bottoms of all wall members will remain at their original Z height.
The tops of the walls will then move the distance specified in the Z Shift field. This will not
affect members shifted on the X or Y axis.

Maintain Truss Edits — When the Maintain Truss Edits dialog box is activated...

OK — Click the OK button to move (or copy) the model the distance specified, then return
to the main window.

Cancel — Click the Cancel button to return to the main window without moving or copying
your model.

Rotate Model (Temporary) — The Rotate Model (Temporary) command is used to temporarily
rotate the entire model around the Z axis. To use this command, select Rotate Model (Temporary)
from the Modify menu. The Rotate Temporary dialog box will open.

Enter Angle (CCW from Original) — Enter the
counterclockwise rotation desired, in degrees.

Rotate Temporary x|

To rotate the model back to its original Enter angle (CCW from original)
orientation, enter “0.” [0.000
OK — Click the OK button to rotate the job and [ ] cancel |

return to the main window.

Cancel — Click the Cancel button to return to the main window without changing the angle
of your model.

Examples in e-text.

Set Properties Mode — The Set Properties Mode is used to quickly change the properties of any
entity. Choose this option from the Modify menu or from the right-click menu, and then select
any item. The appropriate Properties dialog box for that entity will appear. This mode will remain
active until you right-click or press the Escape key on your keyboard.

Relap Corners —

Relap Corners to Default —
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ENTITIES MENU

The Entities toolbar provides users with commands to create and modify all of
the various parts that make up a structure.

[e Construction Lines — The Construction Lines command allows you to input
lines that you can use for reference. Construction lines are lines used for
your reference only. A construction line does not affect the loading of a
job or final material output. Construction lines are visible only in GS Plan.

To create a construction line, you must select a start point and an

Entities Display Macros Lateral
€4 Construction Lines
¢ Bearings

L7 Areas

%% Openings

(=) Obstructions

<7 Planes

L1 Loads

TR Overhangs

d Single Truss

B HioEnds

| Annotations KeyPlot
£ Additional Framing

=] Hangers
endpoint. Since construction lines have no properties to set (as they are //I Joist Holes
just lines), no property box will appear after a construction line is created. . :
After inputting a construction line, your crosshairs will remain connected
to the endpoint. The endpoint can then be used as the start point of the
next line, or you can click the right mouse button to disconnect.
ﬂl Bearings — The Bearings command is used to x|

input the support members of a model.

A K Bearing Type: Reference Line:
Bearings are members that directly support C ek C Center @ Right
other members, or the loads associated with e Beo.Heght [500 | Fatem. |
other members. To input a bearing member, e L Endhecht: [500  Fatem. |
you must select a start point and an endpoint. 2::;':;&,':? # Bles: [ 1
Once the endpoint has been selected, the Set Ot Jout. dywdh: [38
Bearing Properties dialog box will open. The e MrDepth: [00
. . . . Stru . -
specific contents of this dialog box will vary, o Product: | No Product Assigned
depending on the Bearing Type that is
. . Location: " [nterior % Exterior
selected. (For more information on the _— e [
features and functions of the Set Bearing - ;m armed I Boor
Properties dialog box, see the section of this I Nondoad bearing
[~ Bears on Earth

document entitled “Defining Bearing
Properties.”)

After drawing a bearing, your crosshairs will x| e

Wal Type IFramed hd I

remain connected to the endpoint. This

endpoint can then be used as the start point

for the next bearing, or you can click the right mouse button to disconnect.

The Bearings command also allows you to input posts in your model. To input a post, start by
selecting a start point. Next, enter a distance of zero (using any of the keyboard input
commands). When the Bearing Properties window opens, Post will be the only choice for Bearing

Type.
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7 Areas — The Areas command is
used to add framing areas to a
model.
the model that is filled with like
framing members. Areas are
compound entities. That is to
say, they are made up of several
lines joined together. Areas are
used to define floor members,
roof rafters, trusses, or concrete
slabs.

To draw an Area, use the left
mouse button to click to all the
corners, always moving
clockwise around the area to be
framed. When you have all but
the last side drawn, click your
right mouse button to
automatically close the Area
and open the Area Properties
dialogue box. The Area
Properties window is pictured at
right. See below for more
information on each field:

%
An Area is a section of fresiim -
Ceiling Engineered Joists =
oot Non-Eng. Joists
Concrete Slab C_)lh_er‘ . ll
[ @eritaming Spacing: |2-m o.c.
- | i Depth: | 0-0
IBjsieathiog [oo offeet: [35
[~ Add Bearings
I~ Ledgered Area I" Add Planes
¥ Field-Framed '_*_\ddo\fe!‘hmgs
I” Addsheathing
I~ adde
Define Parallel Side I
Reference Line Product: !NoProduc‘tAssngﬂed
C Left
% Center
C Right
| OK I Delete I Save As Defaults

= Area Type —The Area Type field represents the overall function of the area being created.

The options are:

*

Roof — Members that make up the roof of the structure. Often these will be
composite members that will make up the roof and ceiling at the same time. Roof
areas receive roof loading.

Ceiling — Members that make up the ceiling on a roof level.
Floor — Members that create the floor of a level. Floor areas receive floor loading.

Concrete Slab — This will create a cubic footage of slab for takeoff purposes. No
engineering is performed on a slab.

Member Type — This field defines the kind of member that will be used to frame in the
area. The choices include:

Trusses — Trusses are composite members that are generated in Structure, then
output to GS Truss software for design. The Trusses option is only available if the
Area Type is set to Roof or Floor.

Engineered Joists — Engineered Joists are horizontal members that are loaded and
sized in Structure. The Engineered Joists option is only available if the Area Type is

*
*

set to Roof or Floor.
*

Non-Engineered Joists — These are members that generate materials for the final
materials list, but have no engineering values. They do not generate, or support,
any load. The Non-Engineered Joists option is only available if the Area Type is set
to Ceiling, Roof, or Floor.
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¢ Other — These are members that transfer load and support members above them,
however, they do not have materials associated with them. The Other option is
only available if the Area Type is set to Roof or Floor.

¢ Jacks (Hip End) —
¢ FTCs (Hip End) —
¢ Main Girder (Hip End) —

= Overframing — When the Overframing checkbox is activated, the Roof members entered
will be non-engineered overframe members rather than standard members. Unlike
normal roof members (which fill in the area between the roof and ceiling planes),
overframe members fill in the area between two overlapping roof planes.

= Min. Heel Height — This field defines the minimum value to be used for the vertical
dimension measured from the top of a wall to the top of a roof at the exterior face of the
wall.

=  Sheathing —

= Spacing — The Spacing field defines the distance from the center of one member to the
center of the next member. Spacing is entered in inches and sixteenths of an inch.

= Depth —The Depth field is only used when defining floor trusses or a concrete slab. Depth
is entered in inches and sixteenths of an inch.

= Offset — Generally, the first framing member is placed on the edge of the area (parallel
side, described below), then members are placed at the standard spacing across the area.
If you want the members to start somewhere other than on the edge, a positive offset can
be entered. This will move all of the members in the area, maintaining the spacing. Offset
is entered in inches and sixteenths of an inch. Examples available in e-text.

= Ledgered Area — If an area is to bear to the face of a wall or beam, then a ledger needs to
be created, and the area needs to be toggled "Ledgered Area." Joists and trusses
belonging to a ledgered area will be considered as supported, even though there is no
apparent supporting wall or beam.

= Field-Framed -

= Add Bearings —

= Add Planes —

= Add Overhangs —
=  Add Sheathing —
= AddRim-—

= Reference Line -

=  Product -

COMMAND BUTTONS

= Define Parallel Side — The parallel side is a line that the members of an area run parallel
to, and the location from which the layout begins. Click the Define Parallel Side button to
specify a new line as being the parallel side.
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= Define Product List — Click on
P =T

the Set Products button to He Ed yew Helo
bring up the PST Product
Priority dialog box pictured at
right. This window allows users
to specify the materials to be
used want to use for the
framing members.

Usage:

=  OK-Click the OK button to
apply the information in this
window and return to the main
GS Plan window.

= Delete - Click the Delete button
to return to the main window
without drawing the area. If
you have opened the Set Area
Properties dialog box using the
Set Properties command, this
button will read Cancel. Click Add Products... |

Cancel

Cancel to return to the main
window without applying the
changes made to this area’s properties.

= Save As Defaults — Click the Save as Defaults button to store the information in this
window and use it each time a new area is input.

Openings — Openings are holes in framing areas that are used to x|
create skylights, stairwells, and other holes. The Openings command
is used to define openings in framing areas. To draw an opening, use ™" Define Bearings

your left mouse button or the keyboard input keys to define all the
corners, always moving in a clock-wise around the opening. When you

have all but the last side drawn, click your right mouse button to

automatically close polygon of the opening. This will open the Set Opening Properties dialog box.
Click in Define Bearings checkbox to activate it. When you click on the OK command button, the
Set Bearing Properties dialog box will open. For more information about the Set Bearing
Properties dialog box, see page .
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Obstruction — The Obstructions command is used to define either circular or rectangular framing
obstructions. At this point, obstructions do not automatically adjust framing in GS Plan or in

_. Obstructions *DO* appear in Adjust Members in _ and

should be used as a visual aid in manually adjusting framing.

Drawing an obstruction is similar to drawing a load, in that you can input a single point or a single
line to designate different obstruction types (circular and rectangular vs. point load and line load).
To draw a circular obstruction, click on a point with the mouse, and then either click again on the
same point with the mouse or use an arrow key and set a "0" length, then right-click or hit the
Escape (Esc) key. To draw a rectangular obstruction, click on a point with the mouse, and then
either click on another point with the mouse or use an arrow key and type in a length, then right-
click or hit the Escape (Esc) key. You will be prompted with one of the following dialog boxes.

Diameter: | 0-5-0 Width: 0-3-0
Function: Function: |
™ Continuous ™ Continuous
o | peete | [ ok ] Delete |

For circular obstructions, input the Diameter of the obstruction, with the circle centered around
the input point. For rectangular obstructions, input the Width of the obstruction, with half its
width on either side of the drawn reference line. The Function field allows you to enter up to a 20-
character description that is saved with the obstruction.
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v Planes — Planes are 3D surfaces that are used to define roof and ceiling geometry. A plane is
defined by a single line (the baseline), and is then extended out to meet other planes and
bearings. The Planes command is used to define roof or ceiling planes.

A plane is input as a single line along the heel of the x|
framing members. Select the start point, then the ending —
point, moving clockwise around the building. Once you Roof I™ Force Heel Height
have drawn the line, click the right mouse button. This will % I | istch Adjacent:
open a Set Plane Properties dialog box like the one [ wc:m"'m= (e
pictured at right. Define the plane that you want to place [God |—
and then click on the OK button. Once you have entered Seat Cut: BJC Upset:
all of the planes in the roof or ceiling you are defining, use 000 Jood
the Extend commands to fully develop the geometry. The r;c_;zm Dot |D_'°_"_°"°°'°°°"’=
Set Plane Properties dialog box contains the following e, f———
fields and command buttons: [ |
= Plane Type — There are three potential options: % izt
¢ Roof — A roof plane will create a surface Cantiever Offoets
that the tops of roof framing members will [eo0 [ |
follow. [ ok | oeete | vetcd | cabe |

¢ Ceiling — A ceiling plane will create a
surface that ceiling members (or the bottom of roof trusses) will follow.

¢ Stick Roof — A stick-roof plane functions the same as a roof plane, but the heel
height is calculated differently. (The B/C Upset turns to Seat Cut.)

Force Heel Height — If the Force Heel Height checkbox is activated, the user must enter an
exact heel height rather than having GS Plan calculate one based on the information in the
Set Plane Properties dialog box.

Match Adjacent — Examples in e-text.

Current Plane

Slope — Enter the slope for this plane. The default value and format of the slope is based
on the preset set in the General Information window.

Seat Cut — If you are defining a stick-roof plane, this is the size of the Seat Cut. This is the
amount of the rafter that will sit flat on the bearing. This is used when the Heel Height is
calculated. If you are defining a ceiling plane, this field is grayed out.

T/C Member Depth — This is the actual width of the member being used
as the top chord of a truss or the roof rafter. This value is used when
calculating a Heel Height. This field is grayed out if you are defining a
ceiling plane.

Overhang Length — This field is only used when the Match Adjacent T/C Member Depth

checkbox is activated. This value is used by the Match Slope calculator. If the Match
Adjacent checkbox is activated, the Heel Height will be generated to align with an adjacent
plane. The fields below this checkbox are used to enter information for the adjacent
plane, and remained grayed out until this box is checked.
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[Match Adjacent] Plane

Other

Slope — This field is only used when the Match Adjacent checkbox
is activated. This value is used by the Match Slope calculator.

B/C Upset — If you are defining a roof plane, this is the bottom

chord upset. The bottom chord upset (or butt cut) us the amount o

of the end of the bottom chord that is left flat when it is beveled. Chord =

This is used when the Heel Height is calculated. This field is only dpeet

used when the Match Adjacent checkbox is activated. This value is used by the Match
Slope calculator.

T/C Member Depth — This field is only used when the Match Adjacent checkbox is
activated. This value is used by the Match Slope calculator.

Overhang Length — This field is only used when the Match Adjacent checkbox is activated.
This value is used by the Match Slope calculator.

Continuous — If the Continuous checkbox is activated, all of the planes drawn after this
one (until the plane command is exited, or restarted) will have the same properties. You
will not be prompted for property information after inputting planes.

Heel Height — If you are defining a roof or stick-roof plane, this is

the Heel Height of the plane (or the vertical distance from the wall

to the top of the plane). If the Force Heel Height checkbox is -
activated, this value can be entered directly. Otherwise, it is Helghti|:
calculated by the Heel Height calculator or the Match Adjacent

calculator.

The Heel Height calculator causes the value in the Heel Height field to be calculated
automatically, based on the information in the Slope, B/C Upset (or Seat Cut for stick-roof
planes) and T/C Board Width. As long as the Force Heel Height flag is not set, this
calculation will be carried out automatically.

If the Match Adjacent option is selected, the value in the Heel Height field will be
automatically generated. This value is created based on the information for the current
plane (Slope, B/C Upset (or Seat Cut for stick-roof planes), T/C Board Width and Overhang)
and the information for the plane to be matched (the fields below the Match Adjacent
checkbox.)

Cantilever Offset —

Command Buttons

Save As Defaults — Click this button to store the information in this window to be used
each time a new plane is input.

OK — Click the OK button to apply the information in this window and return to the main
window.

Delete — Click the Delete button to return to the main window without inputting the
plane. If you are editing a plane using the Set Properties command, this button will read
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Cancel. Click the Cancel button to return to the main window without applying any

changes made to the properties.

Vertical — Click the Vertical button to cause this plane to angle straight up. A vertical
plane allows any plane input to cut along the vertical plane. The only property that is used

in a vertical plane is the Plane Type.

Gable - Click the Gable button to
turn the plane line drawn into a
Gable. This will open the Truss
Properties dialog box, like the one
pictured at right.

¢  Truss Scheme

¢ Save

¢ Delete
Reference Line
—  Left
— Center
— Right
Truss Type
— Truss

Valley Truss
Non-Structural Gable
Structural Gable

— Valley Gable
Location

— Roof
— Floor
Width
Depth
Spacing
Ledgered
# Plies
Label
Gable Info
Drop T/C
Flat B/C

Backspan

ﬂ
Save
Truss Scheme: | ;l —

Referenceline: (" Left (¥ Center (" Right

Truss Type: |yl Ke= 0 ~
Location: % Roof € Floor
ﬁdlh: [W 3&5:|1_
Depth | 2-0-0 W:I_
Specng: [200 I Ledgered
i~ Gable Info
" DropT/C " BatB/c Backspan: 2-0-0
Vent: & None " peak (" Rectangul
T @ sheating " BoxRake
Drop Dimension: [160 " yentwidth: [200
Vert Web : [W Vent Height: W
I™" Field Framed V' Continuous
| OK I Delete | Reset Properties |
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Vent

— None

— Peak

— Rectangular
Overhang Type

— Sheathing

— Box Rake
Drop Dimension
Vert Web Spacing
Vent Height
Vent Width
Field Framed
Continuous
OK
Delete

Reset Properties

1 1] Loads—The Loads command allows you to define non-standard point loads, line loads, and area

loads.

Area — To define an Area load, move clockwise around the I
baen chasen dick the nght mouse button. Tiswil open  [ARERIEN
the Set Area Load Properties dialog box pictured at right: Wetosd: [0.000psF
+ Replacement Load — When this radio button is Dead Load: [0.000 psf
selected, GS Plan replaces the standard loads on Load Case: [Roof |
members with the loads defined in this dialog box. [ ] e |

Additional Load — When this radio button is
selected, GS Plan adds the loads defined in this
dialog box to the standard loads on members.

Live Load — This is the Live Load to be use to load any section of any members that
fall inside this area.

Dead Load — This is the dead load to be use to load any section of any members
that fall inside this area.

Load Case —

OK — Click the OK button to apply any changes made to the information in this
dialog box and return to the main window.

Delete — Click the Delete button to return to the main window without drawing
the load. If you are editing a load using the Set Properties command, this button
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will read Cancel. Click the Cancel button to return to the main window without

applying any changes.
Line — Click the left mouse button at the start of where x|
the load should be, then again at the end. Then click Begnning uve Losd: [0.000 5F
the right mouse button. This will open the Set Line Load Endng Uive Load: [0.000 5if

Beginning Dead Load: I 0.000 plf

Properties dialog box pictured at right:
Ending Dead Load: ID.GOOpr

¢ Beginning Live Load — This is the Live Load at Load Case: [Roof =
the beginning of the line (or the first point you
defined). [oc | _oeke |

¢ Ending Live Load — This is the Live Load at the
end of the line (or the second point you defined).

¢ Beginning Dead Load — This is the Dead Load at the beginning of the line (or the
first point you defined).

¢ Ending Dead Load — This is the Dead Load at the end of the line (or the second
point you defined).
¢ Load Case -

¢ OK-Click the OK button to apply any changes made to the information in this
window and return to the main window.

¢ Delete — Click the Delete button to return to the main window without drawing
the load. If you are editing a load using the Set Properties command, this button
will read Cancel. Click the Cancel button to return to the main window without

applying any changes.
Point — To input a point load, select the point that the x|
load should be at two times (either by clicking it twice LiveLoad: [0.0001b
with the mouse, or selecting it and using the keyboard DeadLoad: [0.0001
commands to move a zero length), then click the right Load Case: [Roof =
mouse button. This will open the Set Point Load [ox | oee |

Properties dialog box pictured at right:

¢ Live Load —This is the Live Load that is to be applied at this point.
¢ Dead Load — This is the Dead Load that is to be applied at this point.
¢ Load Case —

¢ OK-Click the OK button to apply any changes made to the information in this
window and return to the main window.

¢ Delete — Click the Delete button to return to the main window without drawing
the load. If you are editing a load using the Set Properties command, this button
will read Cancel. Click the Cancel button to return to the main window without
applying any changes.
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[Set Overhang Properties x|

Overhangs — The Overhangs command allows you to specify

the location and lengths of truss or rafter overhangs. )] 109
Overhangs will cause the ends of roof framing members to W save AsDefats |
extend past the edge of the area. An overhang is entered as a | e |

single line along the edge of a roof framing area. To input the
line, select the start point, then move clockwise to the second
point and click again. As soon as the second point is selected, the Set Overhang Properties dialog
box will open. Specify the overhang length, then click the OK button. The ends of the framing
members will not extend out until the Generate Members command is run.

= Overhang — This is the length of the overhang, measured horizontally.

= Continuous — If the Continuous box is checked, all of the overhangs drawn subsequently
will have the same properties. The user will not be prompted for property information
after inputting overhangs.

= Save As Defaults — Click this button to store the information in this dialog box to be used
each time a new overhang is input.

=  OK - Click the OK button to apply the information in this window and return to the main
window.

= Delete — Click the Delete button to return to the main window without inputting the
overhang. If you are editing an existing overhang, using the Set Properties command, this
button will read Cancel. Click the Cancel button to return to the main window without
applying any changes made to the overhang properties.

Single Truss — The Single Truss command is used to specify a single truss at a specific location. The
Single Truss entity allows you to place a single truss member at a specific location. To input a truss
member, you need to select a start point and an ending point. Since truss members have no
properties to set (like standard trusses, they just follow the planes around them) no property box
will appear after it is input.
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Hip Ends — The Hip Ends command is |
used to specify the type and location of -
hip-end framing. A hip-end line is the Setbod: [+00 =] o
only way to define hip-end framing -
members. A hip end is entered as a (et Top Commans
single line along the edge of a roof Pacement: Jorder o Pesk N
framing area where the heels of the | 200
jack members will be placed. To input -Left Corer Set | ~Right Corner Set
the line, select the start point, then ples: [1 | Ples: [1
move clockwise to the second point Holdback from girder [ooo Holdback from girder 000
and click again. As soon as the second Vert Web Holdback [000 | || VertwebHoldback 000
point is selected, then Hip End ' _ -
Properties window will appear. Specify [[Rosmbemes
how the hip end should be framed, Plagement: [To corner | Spacng: [ 200
then click the OK button. At this point, End Jack Corner Jacks:
you will be prompted to specify the Offact =D =
planes and area that define this hip e [000 000
end. Pick the area that the hip end falls Vert Web Holdback 000 000
in, and then pick the right, face, and left '
planes of the hip end. The hip-end o ] — [ sovesDefauts |  Restoe et |
framing will then appear.
= Master Girder -

=  Setback -

Plies —

Flat Top Commons

Placement — This controls how you want the flat-top commons to be placed. Flat-top
commons will follow the 10C spacing of the hip end, regardless of how this flag is set.

There are two options:

* Girder to Peak — This will start the commons at the center line of the girder, and

space them up to the peak.

* Peak to Girder — This will start the commons at the peak, and space them down

toward the girder.

= Spacing — This is the distance from the center of one hip-end member to the next. All

members placed from the peak to the face of the hip are hip-end members.

=  Truss at Peak —

Left Corner Set
=  Plies — This is the number of plies in the girder.
= Holdback from Girder -
= Vert Web Holdback -

Right Corner Set

=  Plies — This is the number of plies in the girder.
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Holdback from Girder —
Vert Web Holdback —

Jacks/Sub-Girders

Placement -

Spacing —

Offset End Jack —

Offset Corner Jacks —

Holdback from Girder End Jack —
Holdback from Girder Corner Jacks —
Vert Web Holdback End Jack -

Vert Web Holdback Corner Jacks —

Command Buttons

OK — Click the OK button to apply the information in this window and return to the main
window. If you are inputting this hip end and have not already used the Define Area &
Planes button, you will be prompted to select the area and planes associated with this hip
end.

Cancel — Click the Delete button to return to the main window without placing the hip
end. If you are editing this hip end (using the Set Properties window), this button will read
Cancel. Click the Cancel button to abandon the changes made to the properties and
return to the main window.

Save As Defaults — Click this button to store the information in this window and use it
every time a new hip end is entered.

Restore Defaults —
Select Planes —
Select Area —

Clear Planes & Area —

Annotations Plot — The Annotations Plot command opens KeyPlot, which is used to place
dimensions, labels, and text on your model. You can then use KeyPlot to print your model,
including the information you have added, or you can export the model as a DXF file. For more
information about KeyPlot, see the section entitled on page __ of this document.
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Additional Framing — ...this will open the Set |

" Framing Accessory Properties dialog box
pictured at right: Framing Entity: ReferenceLine: ~ | o
. . . " Center
* Framing Entity — ....The list of _ & Rht
i i : Cant. Reinf.
potential values includes Rein: Product; [N Seecton
Floor Joist -
* Rim Joist — \Web Stffener LGS Ply wth: |[1-2
Roof Rafter .
) Roof Rafter (NE) Wb Depth: [9-3
¢ Blocking — Ceiing Joist epies: [1
¢  Bracing -
Label: I
¢ Cant. Reinf. -
. I” Continuous I Field Framed
* —
Chase Reinf. B LosdBeni |~ Seume 83 Jost Set Product
. Clear Product
¢ Floor Joist —
oK | Delete | Save Defauits

¢  Web Stiffener LGS —
¢ Roof Rafter —

¢ Roof Rafter (NE) —

¢ Ceiling Joist —

= Reference Line —

* Product-—

= Ply Width -
=  Mbr Depth -
= #Plies—

= Label-

=  Continuous —
= Load Bearing -
= Field Framed —

=  Same as Joist —

Command Buttons

=  Set Product — Clicking on this command button will open a Material dialog box that will
allow you to select a specific for your Framing Entity. The specific contents of the Material
dialog box will depend upon the currently selected type of Framing Entity.

= (Clear Product —
=  Save Defaults —
] OK —

= Delete -
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Hangers — The Hangers command is used to
add non-engineered hangers to a model.
When you choose the Hangers option from the
Entities menu, the cursor will change to GS
Plan’s cross-hair cursor and you will be
prompted to Set Start Point. Using standard
drawing conventions, draw a line across the
ends of the members to which you wish to add
hangers. After drawing the line, the Set
Hanger Properties dialog box will appear.

i
Hanger Part Number:

| =
e — Add Hanger Product |
Carrying Member Fasteners: |

Carried Member Fasteners: |

I™ Continuous [ One Sided Clip ™ Field-Framed

o« | cancel |

You can then select a hanger from the pull-down menu, or click on the Add Hanger Products
button to access the Add Hanger Products dialog box. In this dialog box, you must provide a
Hanger Part Number. Optionally, you can add a Note, Carrying Member Nailing properties, and
Carried Member Nailing properties. If you check the Save to Master Hanger Product List
checkbox, that hanger will be available in future jobs. If you do not check the checkbox, that

hanger will only be available in the current job.

Please note that the Master Hanger Product List contained in GS Plan is in no way associated with
the Simpson Strong-Tie or any alternate hanger manufacturer’s product lists provided in -

RIS - - KNSR

=  Hanger Part Number —

= Note -

= Add Hanger Product — Clicking on this command button
opens the Add Hanger Product dialog box pictured at |

right.
¢+ Hanger Part Number —
¢+ Note -
¢ Carrying Member Fasteners —

¢ Carried Member Fasteners —

¢ Save Master Hanger Product List —

* OK -

¢ Cancel -
= Carrying Member Fasteners —
= Carried Member Fasteners —
=  Continuous -
= One-Sided Clip -
= Field Framed —
[ ] OK -

= Cancel -
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Joist Holes — A new Joist Hole entity is used to
define hole locations in floor joists and then have
those hole locations included in the floor joist
design in GS Structure. To draw a joist hole line,
select the Joist Holes command from the Entities
menu or toolbar. Once the command is selected,
the cursor will change to the cross-hairs input
cursor. Select the start and end points for the hole
line. This will open the Set Joist Hole Properties
dialog box pictured at right:

= Type — There are two potential values:

Set Joist Hole Properties

Type: ]Cncular

Diameter: |40

Description: ]
Vertical Offset: | 7-0

Slope: 10/12

[ 1

I~ Continuous

Delete

¢ Circular — Choose this option to create a joist hole that is circular in shape.

¢ Rectangular — Choose this option to create a joist hole that is rectangular in shape.

= Diameter — When a Circular hole type is selected, fill in the Diameter field with the joist
hole Diameter. When a rectangular hole type is selected, fill in the Width and Height

fields with the joist hole dimensions.

= Description — Optionally, you can enter a Description for the joist-hole line. This joist hole
Description will be included on the Framer's Plot generated from GS Structure.

= Vertical Offset — The Vertical Offset field defines the offset above the Set Top of Wall
elevation at which the joist hole line is input. Please note that joist holes designed in GS
Structure will assume that the joist hole is centered in the depth of the joist. The Vertical
Offset of the joist-hole line will be displayed as input when viewed in 3D, and is included in

any saw files generated by GS Structure.

= Slope — The Slope field defines the slope of the joist-hole line drawn in 3D. Please note
that joist holes designed in GS Structure assume that the joist hole is centered in the
depth of the joist. The Slope of the joist-hole line will be displayed as input when viewed
in 3D, and is included in any saw files generated by GS Structure.

= Continuous — When the Continuous checkbox is activated, GS Plan will allow you to
continue to input joist-hole lines using the input properties, without prompting you for
the properties for each new joist-hole line. Right-click to exit the command.

] OK_

= Delete -

Annotations — Clicking on the Annotations command on the Entities menu opens a sub-menu with

the following seven options:

E Model Entity Labels —

=3 Draw Dimension Lines — A Dimension Line is an annotation that is used to display the

==J distance between two points. Dimension Lines are saved with the job and included in
Layout Plots generated from GS Plan. Please note that they will not be included in plots
from GS Plan Structure. To draw a Dimension Line, select the Draw Dimension Lines
command from the Entities | Annotations pull-down menu or from the new Annotations

toolbar.
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Draw Arbitrary Lines —

23| Draw or Edit Text Box —
|¥ Edit Annotation Attributes —
= Options —

|li‘l] Point-to-Point Dimension Lines — A Point-to-Point Dimension Line displays the
actual distance between two selected end-points and is drawn parallel to a line
connecting the selected end-points.

Horizontal Dimension Lines — A Horizontal Dimension Line displays the Horizontal
distance between two selected end-points

Vertical Dimension Lines — A Vertical Dimension Line displays the Vertical
distance between two selected end-points.

Auto Dimensions Filter

FE ®
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Display Macros Lateral Materials Design

DISPLAY MENU & TOOLBAR 3, Zoom Window

The Display toolbar provides quick access to... g im ;
Zoom Window — The Zoom Window command is used to & ;‘:r:m
change the view of a model in the main GS Plan window in one of @ Anmate
three ways. You can use the keyboard to pan, zoom in and out, or use 2 D;Sfm”‘,’rddm

the mouse to create a zoom window. N

B8 Show Wall Profiles

After selecting the Zoom Window command, you can use the Show Planes & Overhangs
arrow keys to move the view of the model. This allows you to pan v Show Member Width
around the model quickly. For example, the Up arrow key will move SR

. .. . . Force Panel te
the view of the model up. When you are finished panning, click the Y mgob,s_“m
right mouse button. @ Set Visbilty...

Clicking the Page Up key will zoom out on the model, while the Page

Down key will zoom in. This allows you to change the level of zoom
without having to use a window. When finished, click the right mouse button.

If you wish to enlarge a specific section of the model, using the zoom window is best. Use your
mouse to choose the opposite corners of a new viewport (that is, the section of the model that
you want enlarged).

Zoom Full — Selecting the Zoom Full command will increase or decrease the current view, so that
every section of the model can be seen.

Zoom Last — The Zoom Last command returns the user to the previous view of the model.

18 %

Rotate — The Rotate command is used to set the exact angle of x|
ro'tat.lon of the model, as well a§ es'fabhsh animation dgfaults. e
Clicking the Rotate command will display the Set Rotation Values X axsTit: [0 degrees
dialog box pictured at right: I Perspective
[V 3dProfiles
= Z Axis Rotation — This is the value, in degrees, that the I™ Regenerate
model should be rotated around the Z axis. enrex | Roghtresr |
= X Axis Tilt — This is the value, in degrees, that the model teftFront | RightFront |
should tilt forward on the X axis. [ ] conce |

=  Perspective — If this box is checked, GS Plan will draw the
animated model from a slightly altered angle, to enhance the perspective.

= 3D Profiles — If this box is checked, GS Plan will draw roof truss members as three-
dimensional members rather than single lines.

= Regenerate — If this box is checked, framing members will be regenerated every time you
enter animate mode, regardless of changes to the model.

Command Buttons

= Left Rear — Click the Left Rear button to change the Z Axis Rotation to a pre-defined value
of 225 degrees.

= Right Rear — Click the Left Rear button to change the Z Axis Rotation to a pre-defined
value of 135 degrees.
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= Left Front — Click the Left Rear button to change the Z Axis Rotation to a pre-defined value
of 315 degrees.

= Right Front — Click the Left Rear button to change the Z Axis Rotation to a pre-defined
value of 45 degrees.

= OK - Click on the OK button to view your model with your newly defined rotation values.

= Cancel — Click on the Cancel button to abandon your rotation changes and return to the
main window.

Plan View — The Plan View command will display your model from above, as large as possible on
the screen, so that it fills the entire drawing area.

Animate — The Animate command is used to rotate your model in 3D space. After selecting

' Animate, your model will be displayed in a preset 3D view. Use the arrow keys on your keyboard

(not the keys on the numeric keypad on your keyboard) or your mouse to move the model. To
exit the Animate mode and return to your previous view, click the right-mouse button or press the
Escape key on your keyboard. If you move to a 3D view that you want to keep, either click the
left-mouse button or press the Home key on your keyboard.

Solid Model — This feature allows you to view jobs with a Solid Model view in a modeless window.
The Solid Model viewing window can be resized and/or repositioned at any time. Size and position
information are stored when the viewing window is closed and restored when the window is
opened. Pressing the Escape (Esc) key while in the viewing window will close the window and
return you to the standard GS Plan view.

Once in the Solid View window, you can rotate the model by using the arrow keys on the
keyboard, or holding down the left-mouse button and moving the mouse back and forth. To zoom
in and out, use the '+' or '-' keys on your keyboard, or the scroll-wheel on your mouse. To pan,
hold down the middle-mouse button and move your mouse. To change the display of the Solid
Model view, right-click in the Solid View window. Selecting an item in the right-click menu will
toggle a check mark next to that item, to indicate whether or not the behavior attributed to the
item is currently active. Note: The menu item Copy Current View is not a toggled item.

Design Toolbar —

Show/Edit Truss Profiles — The Show Truss Profiles command is used to view the two-dimensional
outlines of truss members in your layout. To use Show Truss Profiles, select the command from
the Display menu, then select the truss that you wish to view with your mouse. A profile window
will appear. This window will show an outline of the truss, as well as basic information about the
truss geometry (slope, heel height, truss length, etc.). Click another truss to display it in the
profile window. To close the profile window and exit the Show Truss Profile mode, right click your
mouse or press the Escape key on your keyboard.

Show Wall Profiles — The Show Wall Profiles command is used to view the two-dimensional
outlines of walls in a layout. It is especially useful for verifying header heights. To use Show Wall
Profiles, select the command from the Display menu, and then select the wall that you wish to
view with your mouse. A profile window will appear. This window will show an outline of the
wall, as well as basic information about the wall’s geometry (length, height, etc.).

If you click on the Wall Profile box (to give it focus), and then press the Home key on your
keyboard, the profile will change to include all the wall segments within the same "span." (That s,
walls that are aligned but are not the same wall). Also, if you press the End key on your keyboard,
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the horizontal dimensions to each door and window opening will toggle from center to right to left
(similar to the Quick Header macro).

To view another wall profile, simply click on another wall to display that wall in the profile
window. (There is no need to close the box and start over; the box is "modeless" and, therefore,
you have the ability to click on additional walls in the plan). To close the profile window and exit
Show Wall Profile mode, right-click your mouse or press the Escape key on your keyboard.

Show Planes & Overhangs —

Show Member Width — Choose this option to display both sides of each framing member, rather
than just their centerline locations. This view can be used in conjunction with floor joists, rim
joists, blocking panels, web stiffeners, cantilever reinforcements, roof rafters, trusses, jacks, and
all other hip members. Display rules apply to both 2D (Plan View) and 3D (Animate) screen
displays. In 3D views, the depth of each member is also displayed. Note: To save the setting of
this checkbox for future runs of GS Plan, make sure to choose the Save Defaults option from the
File menu.

Show Panel Framing —

Force Panel Update —

Set Colors — The Set Colors command

x|
is used to define the colors to be used _
. . bhadowlines N io £nd Line E—
in GS Plan. Select Set Colors to display Selected Line e 7ddt] Mat] Line [—|
i i I Frami —
the Set Colors window pictured at . Framing Members
: c Grid Line ] o End Menbers  —
right. Use this window to change the Parent Options e Ladder Panels [——|
; ; ————— | [ ——————|
display colors for one or more entity Rabbeanlot Hangers
Bearing Line I Joist Holes —
types: Area Boundary I /otations [ ——————|
Opening Boundary (NN ©e2ring Ref. Lines I
= [Entity List] - Load Boundary/Line | Fioor Sheathing =
Ceiing Planes I Ecited Truss —————— |
= [Color List] — Roof Planes Y 'iaster Truss E—
Overhang Line e Copied Truss | ——
: ——
*  White Background — To e
change the background color Em
to white, click the White o |
Background check box. If this

box is not checked, the
background will use the default color (black). Note: Since the background can be changed
from black to white, both black and white lines show up as light gray.

= Bearing Ref Lines —

Command Buttons
= Material Colors —
[ ] OK -
= Cancel -

= Toggle Colors —

To change the color used to display an entity, click on the entity name in the list. Next, click the
drop-down color field at the lower left of the window. A list of available colors will appear. Click
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on the color that you want to assign to the selected entity. Once the colors are set, click the OK
button. The colors will not be saved as the new default color unless the Save Defaults command is
run. The list of default colors assigned to the various entity types is as follows:

Shadow Lines (Blue)

Selected Line ( )
Rubber Band Line ( )
Grid Line ( )
Construction Line (Green)
Bearing Line (Cyan)

Area Boundary (Red)
Opening Boundary (Magenta)
Load Boundary (Brown)
Plane Boundary (Bright Blue)
Overhang Line ( )
Gable Line ( )

Hip End Line (Bright Red)
Framing Members (Green)
Hip End Members (Green)
Ladder Panels (Green)

* Background ( )
'il Set Visibility — The Set Visibility command is used to |
' pick which entities should be displayed in the - _
Drawing Area, and which should be hidden. If a g;:';; = g?ﬁ:m
member type name has a check next to it in the Set ¥ Load WallsHdrs [ Roof Members
Visibility dialog box, it will be displayed in the e S e e
. . . . [V Area Boundaries ¥ Floor Members
Drawing Area. If the member is not checked, it will | Ooaringe/Obetucons ¥ Hp End Members
not be shown. To check (or uncheck) a member [ Load Boundaries/Lines ¥ Ladder Panels
type, click in the box to the left of the name. g ::f::; = e o
[V Oyerhang Lines [ Annotations
Command Buttons 7 Joist Holes ¥ sheathing
[¥ Gable Lines [¢ Shadow Lines
= OK-Click on the OK button to save your
e Aol | cancel | apply
changes and close the Set Visibility dialog

box.

All On [1] - Click on the All On button to activate the checkbox for all entity types.
Alternatively, you can press the “1” key on your keyboard to select all items.

All Off [2] — Click on the All Off button to deactivate the checkbox for all entity types.
Alternatively, you can press the “2” key on your keyboard to deselect all items.

Cancel — Click on the Cancel button to discard your changes and return to the main

window.

Apply -

Set View Scheme —
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View Scheme Settings —
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Macros Lateral Materials Design

MACROS MENU B ererate
= Re-Profile Members
The Macros menu contains functions that combine several commonly Indo All Top Chord Edits
performed commands into a single step. : :

Generate Members — Selecting Generate Members will recalculate and

‘-m]]—]]l regenerate any visible framing members in the model.
»
‘E Re-Profile Members — Tooge R
Stick Framing »
Undo All Top Chord Edits — ¥ skycht...

B8 Panel Break Mode
[ Floor Deck Edit Mode
[ Stretch Model

Undo All Bottom Chord Edits —

Re-Elevate Roof Members —

Headers — The Headers macro is used to create, move, or delete door and window headers.
Selecting the Headers option from the Macros menu will display the Headers sub-menu. This sub-
menu contains commands that are used to enter, edit, and delete door and window headers. The
sub-menu contains the following commands:

=  Header Products...

=  Quick Header...

=  Move Header

=  Snap Header...

= Verify Components

=  Global Change Components...

= Delete Header...

=  Move Snap Header

We will now turn to an exploration and explanation of these sub-menu functions.
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Header Products — The Header Products command is used to [Change Header Produt Sl =
set the materials used for door and window headers.

I Loabent
Selecting Header Products from the Headers sub-menu will  Nondoadbearing
open the Change Header Products window pictured at right. @ Boh

To set, or change, the material used for a specific type of ok | Cancel |

header, choose that header type and then click the OK
button. This will display the View/Edit Products dialog box,
allowing you to choose which materials you want to be used for the headers.

¢ Loadbearing —

¢ Non-Loadbearing —

¢ Both-
* OK-After you have T
selected the desired Ele Edt View Help

header type, click on Usage: IRoo‘ Beam 'I

the OK button. This
will open the View/Edit
Products dialog box
pictured at right. Use
this dialog box to select
the materials you want
to be used for your
headers.

¢ Cancel —Click the
Cancel button to return
to the main window
without altering the
product lists for

headers. SR
Copy To... I
Add Products... | Cancel !
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Quick Header — The Quick ]

Header command is used to
Component Type: (* Window

place headers into interior and " IDoor

exterior framed walls. Componentparts: [ SetComponent |

Selecting Quick Header from R.O.Sze(wdxht): [260  x [260 setComp. Assy. |

the Macros menu will open Header Depth: [54 UnsetComp. |

the Define Component dialog Header teight: [ 650

box pictured at right. This Lefthn. Bearing: [ 18 No. Trinmers: -1

dialog box allows you to s e
Trimwidth: [30 No.Uppersils:[-1

define the opening that you
wish to place:

No.Ples: [

Product: | No Product Assigned

¢ Component Type — Door Side: % [rside SaveAsDefaults |
Choose the type of i
opening component x| cancel | products |

you want to use; Door
or Window. The fields
that are available below will change based on the Component Type you select.

¢ Component Part # — This is the name of the component that you are currently
viewing. To change (or choose) a component, click the Define Component button.
Note: it is not necessary to define a component; you may input an opening based
on rough opening dimensions only.

width | width

+ R.O. Size (Wd x Ht) — This is the exact size of the t ]
opening to be placed in the wall. Enter the width of the  heiaht
opening in the first field, and the height in the second. height
(See the figure at right.)

¢+ Header Depth — This is the exact depth of the material header  depth
that will be used as the header. (See the figure at right.)
This value is entered in inches and sixteenths of an inch.

opening

¢ Header Height — This is the distance from the bottom of
the wall to the top edge of the opening. (See the figureat .
right.)

ight height

¢ Left Min. Bearing — This is the total width of any members that header
will be supporting the left side of the header. (See the figure at

right.) This value is entered in inches and sixteenths of an inch. opering

wicith
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heacder

¢ Right Min. Bearing — This is the total width of any members that
will be supporting the right side of the header. (See the figure at
right.) This value is entered in inches and sixteenths of an inch. —

—
wicith
width

+ Trim Width — This is the closest that either end of this opening can
get to another opening or an intersection wall. (See the figure at

. . . o . . . header
right.) This value is entered in inches and sixteenths of an inch.

¢ No. Plies -

¢  Product -

¢+ No. Trimmers —

¢ No. King Studs —

¢ No. Upper Sills —

+ Door Side — This option is only available if Door has been selected as the
Component Type. The Door Side represents the direction that the door will swing.
Inside and Outside refer to the room in which the door is placed.

Command Buttons

+ Set Component — Click this button to select a component from the list of doors
and windows you have created in KeyMan. The Set Components dialog box is
pictured at right. See below for more information. When you first enter this
screen, all door of window B
components are displayed
(depending on the Door Type:
component type you chose
on the previous screen). To
narrow the list, select the
component type in the
column on the right and/or —
other options such as Swing Swing: (any) =
or Location. Then click the Group: [

Update List button to filter Update st |
the component list based on o | Concel |
the selected options.

Highlight the component you

wish to place and click the OK button. If no components appear in the list, make
sure that the KeyMan® path is set correctly on the File, Set Paths screen.

¢ Set Comp. Assy. —

*

Unset Comp. — When a component is selected, the rough opening size is pre-
determined and therefore those fields are grayed out. If you wish to change this
door or window from having a component to having a rough opening, click this

70



button. The Component Part # field will be cleared and the rough opening fields
will become available.

+ Save As Defaults — Click the Save As Defaults button to store the information in
this window and bring it up every time a new header is being defined.

¢ OK - Click the OK button to apply the information entered in this window and
return to the Main Model™ window.

¢ Cancel —Click the Cancel button to return to the Main Model™ window without
making any changes to the selected header or header being placed.

¢  Products —

Once you have defined the door or window that you want to place, and clicked OK, you
will be prompted to select a wall in which to place the header. To specify a wall for
placement, click the center of the wall. The header placement lines will then appear. Use
the keyboard to define the exact location of the header. When the header is in the proper
location, press the Enter key on your keyboard. You will be returned to your previous
view, again being prompted to select a wall in which to place the header. To choose a
new header, press the Escape key, or click the right mouse button. This will return you to
the Define Component window. At this point, you can choose a new header to place, then
click the OK button to place it, or click the Cancel button to return to the main window.

Move Header — The Move Header command is used to move an existing header to a new
location. When you select Move Header from the Macros menu, you will be prompted to
select a header to move. When you click on a header, the header placement lines will
appear. Use the keyboard to define the new location for your header. When the location
has been defined, press the Enter key on your keyboard. You will then be prompted to
select another header to move. To return to the main window, click the right mouse
button or press the Escape key. Note: Clicking the right mouse button or pressing the
Escape key while a header is selected (while the placement lines are visible) will cause the
header to be deleted.

Snap Header — The Snap Header macro allows the use of the ends of Construction Lines to
create snap-points for placement of headers within walls. The Snap Header function
works in much the same way as Quick Header, with some minor differences. To access
the Snap Header command click on the Snap Header option in the Headers sub-menu of
the Macro menu or the Snap Header button in the Header Macros toolbar.

When selected, Snap Header, like Quick Header, displays the Define Component dialog
box. When component selection has been completed, again like Quick Header, you are
asked to select a wall for insertion of the selected component. When a wall has been
selected, the typical header placement cursor along with appropriate dimension-line
information is displayed. It is at this point that Snap Header behavior will differ from
Quick Header. If Snap Header detects either endpoint of a Construction Line within the
boundaries of the selected wall, the point is added to a list of available snapping points. If
any snap points are associated with the selected wall, the header placement cursor will
only be allowed to traverse between these snap points as the cursor is dragged using
either the mouse or the arrow keys. Except for the Page Up and Page Down keys, the
current Quick Header keystroke / mouse functionality applies to Snap Header, including
the End key to change the location along the rough opening where dimensions are drawn
to. If Snap Header does not detect any available snapping points, the current Quick
Header drag functionality is employed. Regardless of whether or not snap points are
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being used to place the header component, an additional feature of Snap Header allows
you to input a specific offset dimension to either side of the target header component.
Upon entering Snap Header one of the dimensions on either side of the placement cursor
will be highlighted in red. The Page Up and Page Down keys, as well as the middle-mouse
scroll wheel, can be used to toggle the highlighted dimension from one side of the
placement cursor to the other. Either, clicking the middle mouse button, or pressing the
Space Bar key will bring up the Input Header Offset dialog: Inputting a new header offset
value and selecting OK will immediately place the header accordingly. Selecting Cancel
returns you to the previous placement mode.

Verify Components — The Verify Components command allows you to view and change
door and window components used. Select Verify Components from the Headers sub-
menu to label each of the component headers. The labels will correspond to the list on
the right side of the window. Headers that were entered as rough openings (not as
components) will also have a label next to them. Click on a header in the plan view of the
model to view or change its properties. To return to the Main Model™ window, click the
right mouse button. Enhancements have been made to the Verify Components macro to
make it more useful in quality control checking. In Verify Components mode of previous
versions of Model, components were labeled together as long as they had the same
Component Part Number. Now you can choose additional criteria to group components
by including Assigned Product, Header Height, Number of Plies, Rough Opening Size, and
Left / Right Minimum Bearing. For Products, if multiple products are assigned to a header,
the first product in the product list will be used. To set the criteria, click the new Set
Criteria button in Verify Components to access the Set Selection Criteria dialog box shown
below. Check the boxes of the properties you would like included in the labeling of
components. When in Verify Components mode, you can click on a header to access its
properties. If you change any properties, you will now be asked whether you want to
"apply updates to all like headers?" If you click yes, those changes will be applied to all
like headers with the same label.

Global Change Components — The Global Change Components command allows you to
change a door and window component and have that change affect all components of
that type in the Model™ (including in any options). Select Global Change Components
from the Headers sub-menu and then select one of the components you wish to change.
The Define Component dialog box (described above) will appear. If the door or window
was entered as a component, the Set Component and Unset Comp will be available. Click
the Set Component button to change the component for this window or door. Click the
Unset Comp. button to delete the component and instead enter rough opening
dimensions. When you click OK, the change will affect the selected component as well as
all the components that were the same as that one.

Delete Header — The Delete Header command allows you to remove existing headers
from the model. When you select Delete Header from the Macros Menu, you will be
prompted to select a header to delete. Move you cursor over a header, and click the left
mouse button. The header will be removed from the wall. You will then be prompted to
select another header to remove. Click the right mouse button or press the Escape key to
return to the Main Model™ window.

Move Snap Header —
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Extrude Bearings — The Extrude Bearings macro allows
you to move the top or bottom of the walls of your
model. Selecting the Extrude Bearings command will

X

Top Track Elevation:
(% Extrude To Ceiling Plane(s)

display the Extrude Bearings window. This window allows € Extrude To Roof Plane(s)

you to move the tops or bottoms of your walls to specific -~ “uim Degth: o0 )
. . . . Extrude To: | 1

heights. Below is the Extrude Bearings window. See  IPrescve Eevalon

below for more information on each field. € Preserve Height

Bottom Track (Walls, Headers, Posts):

' Preserve Elevation
TOP TRACK ELEVATION " Preserve Height

" Change Elev. To: I 1-0-0
[~ Warn before splitting walls

Extrude to Ceiling Plane(s) — If this option is active (if B

the button to the left is filled in), you will be
prompted to select the ceiling planes that you want L’

the tops of the walls to move to.

Extrude to Roof Plane(s) — If this option is active (if the button to the left is filled in), you will
first need to enter the actual width of the roof members (into the T/C Board Width field). You
will then be prompted to select the roof planes that you want the tops of the walls to move
to. The walls will move to the location of the planes, minus the depth of the T/C members.

T/C Board Depth —

Extrude To — If this option is active (if the button to the left is filled in), you will be prompted
for a height to extrude the tops of the walls to (in the field to the right).

Preserve Elevation — If this option is active (if the button to the left is filled in), the current
location of the top plate will be held, regardless of the movement of the other

Preserve Height — If this option is active (if the button to the left is filled in), the current
distance between the two plates (actual wall height) will be held, regardless of the movement
of the other plate.

BOTTOM TRACK (WALLS, HEADERS, POSTS)

Preserve Elevation — If this option is active (if the button to the left is filled in), the current
location of the bottom plate will be held, regardless of the movement of the other.

Preserve Height — If this option is active (if the button to the left is filled in), the current
distance between the two plates (actual wall height) will be held, regardless of the movement
of the other plate.

Change Elev. To — If this option is active (if the button to the left is filled in), you will be
prompted for a height to extrude the bottom of the walls to (in the field to the right).

[OTHER]

Warn before splitting walls — If this box is checked, and you attempt to extrude a wall at a
point that it will need to break into more than one wall in order to be extruded (i.e. extruding
a top plate to a pitch break in a plane), you will be warned that the wall will need to be split.

Auto-select all walls and headers — If this option is checked, all walls on the active level will be
extruded when the OK button is clicked.
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COMMAND BUTTONS

OK — When you click the OK button, you will return to the Main GS Plan window and will be
prompted to perform the next step. This may be to select a plane or to select the walls to be

extruded.

Cancel — Click the Cancel button to abort the command and return to the Main GS Plan

window.

Create Veneer Wall — The Create Veneer Wall macro allows you to create a veneer wall on either
side of a bearing (to create, for example, a brick ledge). The Define Veneer Wall Properties
window allows you to specify which side of the bearing the veneer should be placed as well as
define the properties of the veneer wall such as width, location, and whether it is framed or load
bearing. Click OK and then click on the wall(s) you wish to place veneers on. You will stay in this
mode until you right click or press the Escape key on your keyboard, and then Cancel out of the

Veneer Wall Properties box.

Pictured at right is the Define Veneer Wall Properties window.
See below for more information on each field.

PLACE NEW VENEER WALL AT

Choose which side of the existing wall the veneer wall be
placed on — either the side opposite the reference line or
the same side as the reference line.

Side Opposite Reference Line —

Side with Reference Line —

NEW VENEER WALL PROPERTIES

Match Heights to Selected Wall — If this option is checked,
the veneer will be constructed to be the same height as

i

~Place new veneer wall at: -
(% side opposite reference line
" side with reference line

New Veneer Wall Properties
¥ Match heights to selected wall

BegnningHeight:  [500
EndngHeiht:  [500

Wall Width: 38 Gap: |0-0

—_— " Interior
Location: @ Exteri

|Framed 'l Wall Type
I™" Non-oad bearing
I Eiush wal pepth:  [3%

the wall it is selected to be on. If you uncheck this option, the Beginning Height and Ending
Height fields will become available, allowing you to specify the heights for the veneer to be

placed.
Beginning Height —

Ending Height —

Wall Width — Enter the width of the veneer wall to be placed, including any air space or

sheathing space between the two walls.

Gap -

Location — As in the Bearing Properties window, Interior or Exterior refers to the veneer wall’s
location in the context of the entire model (if it is an exterior wall or not). It does not in any
way affect the side of the wall the veneer is placed (that is controlled by the reference line

setting above).

Wall Type —
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Non-Load Bearing — If this veneer wall will not support loads transferred from above, the Non-
Load Bearing box should be checked.

Flush Wall — When this box is checked, the Depth field will become available so that you can
specify the height of the veneer wall above top plate elevation (i.e. the additional height
above the beginning and ending height. Generally, it is the depth of the overhead floor joists).

Depth —

Auto-Trim Enabled —

COMMAND BUTTONS

OK — Click the OK button when you are finished setting the properties for the veneer wall, and
then click on the wall that you want to place the veneer on.

Cancel — Click the Cancel button to cancel creating a veneer wall.

Roof Planes — The Roof Planes macro contains commands to automatically input and extend roof
planes. Selecting the Roof Planes option will display the Roof Planes sub-menu. This sub-menu
contains commands that allow you to enter and extend roof planes. The sub-menu contains the
following commands (click on one to jump to that help topic or scroll down to read them all):

ﬁ Create Planes — When you select Create Planes, GS Plan will attempt to place a roof plane

===! on each exterior wall in your model. After selecting the command, you will be prompted to
select a boundary for the planes. This means you need to select an enclosed area that
planes can be placed around. An example of a closed boundary would be four (or more)
walls that form a closed shape. If the shape is open at any point (if there is any section
where walls do not connect, leaving a gap) then create planes will not work.

After selecting inside of the boundary, you will be prompted by the Plane Properties window
to define the planes to be placed. Fill in the information in the window and then click the
OK button. The plane that you defined will then be placed on every exterior member of the
selected boundary.

Extend Manual — The Extend Manual command allows you to define the extension path of a
selected roof plane. After selecting the command, you will be prompted to pick the plane
that you want to extend. When you select it, the plane will extend infinitely in every
direction. White lines will be displayed anywhere the plane intersects another plane, or
crosses a bearing member. The baseline of the plane (the original line that was input) will
turn yellow. Moving in a clockwise fashion, pick each of the white lines that should be used
to form an edge of the final plane. Once all of the edges have been selected, click on the
baseline, and the plane is finished.

EN

Extend Single — Selecting Extend Single will automatically extend one plane. After selecting
Extend Single, you will be prompted to select the plane that you want extended. As soon as
you select it, the plane will be extended based on the locations of other planes, gables, and
bearings. It may be necessary to manually extend the plane to get the exact shape that you
need in more complex roofs (see above for help on the Extend Manual command).

B

={| Extend All — The Extend All command will automatically extend all of the roof planes in your
model. After selecting Extend All, all of the planes will be extended based on the locations
of other planes, gables, and bearings. It may be necessary to manually extend one or more
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planes to get the exact shape that you need in more complex roofs (see above for help on
the Extend Manual command).

,E Clip Off Corner —
& Five-Sided Bay Window —
E Three-Sided Bay Window —

Ceiling Pla X
Ceiling Planes — Select the Ceiling Planes option to e ) =
create and place a ceiling vault in the active level.
. . Scissor Hip
After choosing the command, you will be prompted to sudo Iﬁ
define the geometry of the vault with the ceiling. o
Below is the Ceiling Plane Properties window. See e, et
below for more information on each field. Qutside: |
Inside: =
g 12
Type — / \ [ Slopes: I 2
----------- 7 Symmetric ;
Tray — _ 3| 4
''''''''''' Seat Cuts: I I
1| 0-0-0 2| 0-0-0
Coffer— 3[0-00 4[0-00
Scissor Hip — [ | cancel |

Studio - \

Cathedral —
OUTSIDE
Enter the outside dimensions for the ceiling plane. For example, on 1 =R A
a tray ceiling the outside dimensions are measured as shown at Kossommiesss ,')!JR
right. In this case, 10 was entered for the length, 8 for the width. In g T
the Tray example under the Type explanation above, 2 was entered -] 1
for the height. je by
| o
Length — ) i 3
Height — | i )
T e =% 3N
Width - S =
K-— "= T T T T A
AN
INSIDE - 1 {
These fields will only be available if you choose either Tray or Scissor Hip : : : :
from the Type list. For example, on a tray ceiling the inside dimensions i g -
are measured as shown at right. In this case, 8 was entered for the o I
length, 6 for the width. : : : :
Length - Fam
Width -
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SLOPES

The slope will be calculated for you in many instances if you enter the height of the ceiling
plane, but if you wish to enter the slopes and have GS Plan calculate the height for you, enter
them here.

Symmetric — If this box is checked, GS Plan will ensure that opposite sides of the ceiling plane
have the same slopes (so they will be symmetrical).

q-

SEAT CUTS

This is the amount of the rafter that will sit flat on the bearing when the ceiling plane slopes
upward from the wall. In other words, the flat distance from the outside of the wall to the
beginning of the slope.

COMMAND BUTTONS
OK — Click the OK button to use the settings from this screen to place a ceiling plane.

Cancel — Click the Cancel button to cancel creating a ceiling plane.

Toggle — The Toggle macro allows you to view and quickly change certain properties of bearing
members. Selecting the Toggle option will display the Toggle sub-menu. This sub-menu contains
commands that allow you to view and change the properties of the bearings on the active level. It
contains the following commands:

Toggle Load-Bearing — The Toggle Load Bearing function allows you to switch walls on the

]|
=L

' active level from bearing to non-bearing and back with a single mouse click. Load Bearing
walls will be displayed in green. Non-load Bearing walls will be displayed in purple.

Toggle Roof/Floor — The Toggle Roof/Floor function allows you to view and change walls on

E

the active level from roof bearing to floor bearing and back by clicking on them. Roof
supporting members will be displayed in green. Floor supporting members will be displayed
in purple.

Toggle Interior/Exterior — The Toggle Interior/Exterior function allows you to switch walls
on the active level from interior to exterior and back with a single mouse click. Interior
members will be displayed in green. Exterior members will be displayed in purple.
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Toggle Wall/Header Widths — The Toggle Wall/Header Widths function allows you to view
and change the widths of all wall and header members on the current level. Each of the
different wall or header width will be displayed in a different color. A key to these colors
will be displayed on the right side of the main window.

To change the width of a wall or header, click the width to which you want to change from
the sidebar and then click on the wall or header that you want to change. To change a
member to a width that is not listed on the sidebar, click the Other entry, then enter the
new wall width and click the OK button. The new width will be listed as an option on the
sidebar. To change all members to a specific width, click the Global Change button. You will
then be prompted to select which types of walls should be changed: Interior, Exterior or
both. Click the OK button to change all of the members specified to the currently selected
width.

Toggle Overhang Lengths —

Toggle Framed/Non-Framed — The Framed/Non Framed Toggle function allows you to
switch walls on the active level from framed to non-framed and back with a single mouse
click. Framed walls will be displayed in green. Non Framed walls will be displayed in purple.

Toggle Top Plate Elevations — The Toggle Top Plate Elevation function allows you to change
the heights of walls on the active level by change their top plate elevations. Each existing
wall height will be displayed in a different color. To add a new wall height, click the "Other"
entry in the list on the right and enter the new top of plate elevation. This number will be
added to the list. Select the height you wish to assign from the list on the right and then
click on the wall to apply it to. The wall height will change, but the bottom plate will be held
in its previous location.

Toggle Wall/Header Heights — The Toggle Wall/Header Height function allows you to toggle
wall and header heights for the active level. When in Toggle Wall/Header Height mode,
walls will be visible and colored according to the wall height legend on the right side of the
screen. To change wall heights, left-click on the appropriate wall height in the legend, then
left-click on each wall to change. To add new wall heights, click on the Other button, enter
the new wall height in the Set New Wall Height dialog box, and click OK. To change wall
heights globally, changing all wall heights of the active level, click on the appropriate wall
height, then click the Global Change button, and finally check the appropriate boxes in the
Toggle Wall/Header Values dialog box and click OK.

Toggle Bearing Properties — The Toggle Bearing Properties function allows you to apply the
properties of a selected bearing to other existing bearings. When in Toggle Bearing
Properties mode, the visibility will change so only bearings are visible. You will be prompted
to Select Template Bearing, where you will click on an existing bearing to be the template
bearing. The Set Bearings Properties dialog box will come up for you to verify or change the
bearing template properties. These are the properties that will be applied to other
bearings. Once the template bearing properties are set, click OK to begin applying these
properties to other bearings or Cancel to not apply the template bearings properties. You
will be prompted to Select Target Bearing. The properties of each bearing you click on will
change to match the templates properties. You can continue to toggle bearing properties
until you right-click with the mouse or press the Escape key.

Toggle Bears on Earth —
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Stick Framing — The Stick Framing macro allows you to quickly input non-structural roof and
ceiling framing areas. Selecting the Stick Framing option will display the Stick Framing sub-menu.
This sub-menu contains commands that allow you to quickly input non-engineered stick framing
members (rafters and ridge members). The sub-menu contains the following commands (click on
one to jump to that help topic or scroll down to read them all):

Stick Areas (Roof) — The Stick Areas (Roof) x|
macro allows you to select a roof plane in the Offset: Spading:
active level to be framed with roof rafters. Ao [0 [0 e

When you select Stick Areas (Roof) the Stick
Area Properties window will appear, allowing
you to specify the type of material to be used in e [ e
the area. Once the information for the framing s - _
area has been defined, click the OK button to
choose the roof plane that you want framed.
Clicking a plane will create an area inside the
roof plane. Click the right mouse button to
return to the Main GS Plan window. Below is the Stick Area Properties window. See below for
more information on each field:

No Selection Set Product |

[Rafters] Offset — This macro will pick a start point automatically, generally at a corner or
peak point. Entering an Offset value will move the members from their standard location.

Spacing O.C. — Enter the on-center spacing to be used in the area.

Set Product — Click Set Product to specify a product to be used in the new area.
Battens —

[Battens Offset] —

[Battens Spacing O.C.] —

OK — Click the OK button to return to the Main GS Plan window to choose which planes
will be framed with the area just defined.

Cancel — Click the Cancel button to exit the macro and return to the Main GS Plan window.

Stick Areas (Ceiling) — The Stick Areas (Ceiling) macro allows you to select a ceiling plane in the
active level to be framed with ceiling rafters. When you select Stick Areas (Ceiling) the Stick
Area Properties window will appear, allowing you to specify the type of material to be used in
the area. Once the information for the framing area has been defined, click the OK button to
choose the ceiling plane that you want framed. Clicking a plane will create an area inside the
ceiling plane. Click the right mouse button to return to the Main GS Plan window. The Stick
Area Properties window is pictured at right. See below for more information on each field:

CEILING JoIsTS K
Offset — This macro will pick a start point 2= Spsche:
automatically, generally at a corner or peak Celing Joists [0 [2¢0 o.c.
point. Entering an Offset value will move | No Selection SRR
the members from their standard location.

oK Cancel
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Spacing O.C. — Enter the on-center spacing to be used in the area.
Set Product — Click Set Product to specify a product to be used in the new area.

OK — Click the OK button to return to the Main GS Plan window to choose which planes
will be framed with the area just defined.

Cancel — Click the Cancel button to exit the macro and return you to the Main GS Plan

window.
Ridge Boards (Roof) — The Ridge Board (Roof) macro =
allows you place ridge beam bearing members at any
intersection of two roof planes on the active level. When e 1o
you select Ridge Boards (Roof) the Ridge Board Properties |~ E SetProduct
window will appear, allowing you to specify the type of g [+
material to be used for the board. Once the information x| Cancel |
for the ridge board has been defined, click the OK button

to choose the intersection that you want framed. Clicking

an intersection line will create a board member. Click the right mouse button to return to the
Main GS Plan window. The Ridge Board Properties window pictured at right. See below for
more information on each field:

Ply Width — Enter the width of a single ridge board member.
# Plies — Enter the number of plies that you want to use for the ridge board.

Depth — Enter the actual (not nominal) depth of the material to be used as the ridge
board.

COMMAND BUTTONS

Set Product — Click the Set Product button to choose a specific material to be used as the
ridge board.

OK — Click the OK button to return to the Main GS Plan window and choose a ridge at
which you want to place a ridge board.

Cancel — Click the Cancel button to exit the macro and return you to the main GS Plan™
window.

Ridge Boards (Ceiling) — The Ridge Board (Ceiling) macro allows you place ridge beam bearing
members at any intersection of two ceiling planes on the active level. When you select Ridge
Boards (Ceiling) the Ridge Board Properties window will appear, allowing you to specify the
type of material to be used for the board. Once the information for the ridge board has been
defined, click the OK button to choose the intersection that you want framed. Clicking an
intersection line will create a board member. Click the right mouse button to return to the
Main GS Plan window. The Ridge Board Properties window is pictured at right. See below for
more information on each field.

Ply Width — Enter the width of a single ridge board x|
member. Ply Width: [e
£ Plies: 1
# Plies — Enter the number of plies that you want to A MESEEN|
Depth: [+

use for the ridge board.
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Depth — Enter the actual (not nominal) depth of the material to be used as the ridge
board.

COMMAND BUTTONS

Set Product — Click the Set Product button to choose a specific material to be used as the
ridge board.

OK — Click the OK button to return to the Main GS Plan window and choose a ridge at
which you want to place a ridge board.

Cancel — Click the Cancel button to exit the macro and return you to the main GS Plan™
window.

Skylight — The Skylight macro allows you to define and then place a skylight opening in a roof

' framing area on the active level. After clicking Skylight, the Skylight macro window will be

displayed, allowing you to define the size of the skylight, the component being used (if any), and
the manner by which the opening will be supported. Once the OK button is clicked, you will be
prompted to select the approximate location of the center of the skylight. Use your mouse to
click on a point near the center of the opening location. Once 3
the dimension lines appear, use the macro placement keys to

define the exact location of the skylight. The Skylight Macro Skvight Length: | 2+9

window is pictured at right. See below for more information on Sl II—M
. Component Part #:
each field. i e R
" Stick-frame (Girders)
Skylight Length — This is the horizontal width of the skylight € Opening Only
opening (distance left-to-right on your screen). Remember, setComponent | [ ok | concel

the Skylight Macro places the opening along the slope of
the plane, so this dimension is measured along the slope of the roof.

Skylight Width — This is the vertical width of the skylight opening (distance top-to-bottom on
your screen). Remember, the Skylight Macro places the opening along the slope of the plane,
so this dimension is measured along the slope of the roof.

Component Part # — If you have a database of skylight components created in KeyMan™, you
can click the Set Component button to choose one of them to place. Once a component is
selected, the component part number will be displayed in this field, and the length and width
dimensions will be entered automatically.

[FRAMING SUPPORTS]

Truss-Frame (Truss Girders) — Use this option if you are placing a skylight into a truss framed
roof and want Truss Girders supporting the opening.

Stick-Frame (Girders) — Use this option if you are placing a skylight into a conventionally
framed roof and want Girders supporting the opening.

Opening Only — Use this option if you do not want any support members automatically placed
around the opening.
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COMMAND BUTTONS

Set Component — If you have a database of skylight components created in KeyMan, you can
click the Set Component button to choose one of them to place. Once a component is
selected, the component part number will be displayed in this field, and the length and width
dimensions will be entered automatically.

OK — Click the OK button to place the opening defined above into the active level of the
model.

Cancel — Click the Cancel button to return to the main window without placing a skylight.

Dormer — The Dormer macro allows you to define and input dormer framing. Selecting Dormer
from the Macros menu allows you to define dormer framing in the Dormer Macro Window and
then place it in the active level of the current model. Place the front of the dormer using the
Macro Placement keys. The four Dormer Types are:

Gable Dormer
Shed Dormer

Shed Dormer —

Gable Dormer — Prain.
Hip End Dormer —
Above Front
Front
A Dormer — Above
Side
Side
Hip End Dormer
% Dormer

Front Above Front

Above
f Side : Side
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Pictured at right is the Dormer Macro Joormertaa x|

window. See below for more information on
each field. Note: Based on the Dormer Type TR SR ey 00
selected, the information displayed in the Soed T:;r:;t::; %
Dormer Macro window will change. e Dormer Roof Slope: [ 2/ 12
Dormer HeelHeight: [ 0-43
Dormer Type — This list allows you to Side Wal Length: [—
select the type of dormer you want to I AutoFrame Opening ( € Girders
define. The rest of the fields in the ™ Auto-Frame Dormer (0.C. Spacng: [ )
window will change based upon the WSS A ! )
Dormer Type selected. |I| Cancel |

Width (Exterior) — This is the dimension across the front (face)

of the dormer being defined.
Top Plate Elevation — This is the & /

absolute height of the top of the
dormer walls. If this field is left
empty or set to (Variable), the final height will be defined by
the TP Hgt field, and the placement of the dormer on the
existing roof.

¥,

TP Hgt (Above Roof) — This is the vertical dimension of the front
wall of the dormer (relative to the top of the existing roof).

Dormer Roof Slope — This is the slope to be used on the dormer
roof.

Dormer Heel Height — This is the heel height of the dormer
framing members.

Side Wall Length — This is the length of the walls that form the sides of the dormer. If this field
is left empty or set to (Variable), the length of the wall will be defined based on the TP Hgt
(described above) and the slope of the existing roof.

Auto-Frame Opening — If this box is checked, the opening in the existing roof that is created
by the macro will be automatically framed. Choose whether you want GS Plan to frame the
opening with:

Girders — For conventionally framed roofs.

Tr Girders — For truss framed roofs.

Auto-Frame Dormer (O.C. Spacing) — If this box is checked, GS Plan will automatically add
truss members to the dormer being created. On Center Spacing must be defined in the field
to the right.
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Auto-Add Overhangs (Length) — If this box is checked, overhangs (with their length defined to
the right) will be added to the three exposed sides of the dormer.

COMMAND BUTTONS
OK — Click the OK button to place the dormer into an existing section of roof.

Cancel — Click the Cancel button to clear the information in the window and return to the
Main GS Plan window.

How to Place Entities

Macro placement functions are used when placing one of two different entity types. The first is entities
that are placed into walls (headers, strong-walls); the second is members that are placed into roof
surfaces (skylights, ceiling planes, and dormers). The keyboard keys used for either macro type are the
same, but the actions that are performed may vary slightly. The keys used in macro placement are:

Arrow Keys — Press the arrow keys (not the keys on the numeric keypad on your keyboard) to move the
member along the wall or surface in which it is being placed. If you are placing a skylight, ceiling, or
dormer, the arrow keys allow you to move the member around inside the area or planes selected. Use
the four arrow keys to move members up, down, left, and right. To change the value that the member is
moving by, use the Page Up and Page Down keys on your keyboard.

If you are placing a door or window into a wall, the function of the arrow keys changes slightly. The left
and right arrow keys continue to move members to the left and right, however, the up and down arrow
keys change which side of the wall the header is being placed from. When the dimension lines are
drawn for header placement, they start and end at either the outside corner or nearest intersecting
wall. In this case, if the placement side of the wall is changed (by pressing the up or down arrow keys)
the dimension lines will change. Rather than dimensioning to the outside corners, they will dimension
to the inside corners of the intersecting walls.

In this picture, the function of the arrow keys is reversed. The left and right arrow keys will change the
side of the wall that the header is being placed, and the up and down arrow keys will move the header
along the wall. As above, pressing the Page Up and Page Down keys on your keyboard will increase or
decrease the value that the arrow keys move the header by.

THE PAGE UP KEY

Pressing the Page Up key while in macro placement will increase the value of the arrow key movement.
When placing a macro member, the default imperial unit that the arrow keys will move by is one inch
(1"). Pressing the Page Up key will change the increment so that the member is moved by one foot (1’)
each time an arrow key is pressed. If the member is moving at a sixteenth of an inch at a time, clicking
the Page Up key will change the increment to one inch; pressing it again will change to one foot. To
decrease the value of movement, press the Page Down key.

THE PAGE DOWN KEY

Pressing the Page Down key while in macro placement will decrease the value of the arrow key
movement. When placing a macro member , the default imperial unit that the arrow keys will move by
is one inch (1"). Pressing the Page Down key will change the increment so that the member is moved by
a sixteenth of an inch each time an arrow key is pressed. If the member is moving one foot (1’) at a
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time, clicking the Page Down key will change the increment to one inch; pressing it again will change to
a sixteenth. To increase the value of movement, press the Page Up key.

THE HOME KEY

Pressing the Home key while placing a member will center the member. If you are placing a member
into an area or plane, this will move the member so that it is centered (in the area or plane). If you are
placing a door or window into a wall, pressing the Home key will center the header in the wall.

THE END KEY

Pressing the End key while placing a header will change the placement point of the header from the
center of the header to one of the ends. Pressing End again will change the placement point to the
other end. Pressing the End key a third time will return the placement point to the center of the header.

Macros Menu (Continued)

Panel Break Mode — The Panel Break Mode tools are the first part of a larger effort to offer full
floor panelization in GS Plan. These Panel Break Mode tools allow you to easily break-up large
existing floor framing areas into floor panel sized framing areas, based on your preset floor panel
size.

When you are first drawing a framing area for floor panels, you are desighing the outer boundary
of each area (where each area is the entire region where the framing members run in the same
direction) without regard to where panel breaks will occur. Then enter "Panel Break Mode", by
clicking on the Panel Break Mode option in the Macros pull-down menu. GS Plan will display the
Framing Area boundaries, Openings, and Obstructions, shadows the Construction Lines and
Bearings (except non-load bearing walls and headers), and turns off the other member types.

You can right-click in the middle of a framing area to display a pop-up menu with the following
commands: Auto Split, Parallel Split, Bearing Split, Rejoin Panels, Split Edge, Set Panel ID, and Set
Nail Edge.

=  Select the Auto Split command to automatically split the Area parallel to the framing,
starting at the Parallel Side and creating panels of the preset width across the area.

=  Select the Parallel Split command to split the area along a line parallel to the framing at
the cursor location, and enter Adjust Split mode (as explained below), allowing the user to
fine-tune the split location, if necessary.

=  Select the Bearing Split command to split the area along the (non-parallel) bearing that is
closest to the cursor location.

= Select the Rejoin command to automatically rejoin the panel your mouse cursor is in with
the adjacent panel.

=  Select the Split Edge command to split the line between 2 like areas, then drag either of
the new edges to the desired location.

You can click the left mouse button on a common panel boundary (whether parallel to the framing
or not) and GS Plan will enter Adjust Split mode. In this mode, the panel widths on either side of
the selected panel boundary are displayed as "live" dimensions (similar to the ones used in the
Quick Header command), and the boundary selected can be dragged from side to side
(perpendicular or parallel to the framing) using the same controls as are available in Quick Header,
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including using Page Up/Page Down to change the granularity of the arrow keys (feet, inches, and
sixteenths, or m, dm, cm, and mm). As the panel boundary is adjusted, the other sides of the two
areas are adjusted accordingly, so that the extents of the framing don’t change. These
adjustments will not allow either area to become less than 0’ wide.

Floor Deck Edit Mode —
Stretch Model —

Multiple Entity Input —

LATERAL MENU oD B
Default Settings. ..
The Lateral toolbar provides users with commands to define information used in IT InsertSIP...
P
the lateral design of the structure. % ;”’:;;m

I

[

25

Fh create shear Lines

Default Settings — [y Erase Shear Lines

Insert SIP — The Structural Insulated Panel Insert Strong Wall command

allows you to place a Simpson Strong Wall member in your model’s walls. After selecting the

command, the Select Strong Wall window will appear. Choose the Strong Wall member to be
placed and then click OK. Then use the Macro Placement keys to move the Strong Wall to the
proper location.

Below is the Select Strong Wall Window. To select a Strong Wall to place in the model, highlight
the name in the list and then click the OK button. Click the Cancel button to abort the Insert
Strong-Wall command and return to the Main GS Plan window.

Move SIP — This command allows you to move existing Structural Insulated Panel Strong Wall
members using the Macro Placement commands. After selecting the command, you will be asked
to select the Strong Wall that you want to move. Use the mouse to click on the member. Establish
the new location, then press the Enter key. Pressing the Escape key at any time will remove the
member from the model. To return to the standard GS Plan input mode, press the Escape key or
click the right mouse button while no strong walls is selected.

Delete SIP — The Delete Structural Insulated Panel Strong Wall command allows you to remove
Strong Wall members from your model. After selecting the command, you will be asked to select
the Strong Wall that you want to delete. Use the mouse to click on the member. The member will
be permanently removed from the model. To return to the standard GS Plan input mode, press
the Escape key or click the right mouse button.

Create Shear Lines — The Create Shear Line allows you to define and view the transverse and
longitudinal shear lines of your model. To edit the walls used in a shear line, click on the shear line
at this point. The walls that are being used as a part of this shear line will highlight. To include a
wall in the shear line, move the mouse cursor over a wall and click the left mouse button. Clicking
a highlighted wall will exclude it from a shear line. When only the walls needed are highlighted,
clicking the right mouse button will return you the shear line selected screen. At this point you can
select another shear line to edit, or click the right mouse button a second time to return to the
main model window.

Erase Shear Lines — Select Erase Shear Lines to remove all shear lines from the model.

Wind Loads —
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MATERIALS MENU Materials Design KeyBuld® Help

Gy Assign Non Structural Materials

The Materials toolbar provides users with commands to assign non- %mmﬂmmﬂmmm
. e . Generate Structural Materials List
structural materials to specific portions of your model as well as generate S Output Window / Door Schedu
material lists to load into KeyMan. B OutputFloors to GSS

GSS Floor Output Settings...
Assign Non-Structural Materials — The Assign Non-Structural Lolea i)

Materials command allows you to assign expanders that have been Output Members to LOC fil

defined in KeyMan to specific portions of your model. In other

words, you can set up an expander in KeyMan (i.e. an interior wall expander that contains drywall,
drywall screws, and paint) and apply those materials to the geometric data created by your model
(i.e. apply those materials based on your interior wall square footage). Previously, the only way
you could assign non-structural materials (called expanders in KeyMan) to a model was to assign
them on the General Information screen on the Other Materials tab. This method was ineffective
because only one expander could be applied to each category for the entire model. The Assign
Non-Structural Materials option, however, allows you to assign each expander as specifically as
necessary, so the interior wall example above could be applied to the living room, but a different
expander (i.e. one that contained wallpaper or thicker drywall) could be applied to a different
room. The possibilities are endless and allow you complete control over the non- structural
materials that will be applied to your model.

Note: this command can only be used if you have created Expanders in KeyMan. If you have not
yet done that, please refer to the KeyMan help or contact your

salesperson for assistance. | Geometric Categories x|
. . . . . . Roof SF -
Selecting this command will open the Geometric Categories window, Roof Fshed s=
. . . . . Roo' n Area SF
pictured at right. This window is used to choose one or more Extror Gables
. . . adder Framing
categories to assign materials to your model. Soffit SF
Soffit Eaves SF
Soffit Rakes SF
Geometric Categories — Select (highlight) one or more categories to i S
. . Fi Rakes LF
assign non-structural materials. oo F Ry Foeling LF
Roof Hip Flashing LF
Roof Valley Flashing LF
Roof Step Flashing LF
COMMAND BUTTONS Roof Fiat Fiashing LF =
All Off — Click this button to deselect all of the categories in the list concel |
above.

OK — Click the OK button to move on to the next step and assign non-structural materials to the
selected categories (see below for more information).

Cancel — Click the Cancel button to exit this screen without assigning non-

structural materials to your model. Material Expansion Lege
. . . . Roof SF
After you select categories from the Geometric Categories screen, click Roof Finished SF
Roof Plan Area SF

OK. The Material Expansion Legend window pictured at right will open.
When this screen is first opened, the Geometric Categories you chose will
be displayed. If you selected default non-structural materials on the
Other Materials tab of the General Information screen, those defaults will
be listed below the appropriate category. When you add another
material (using the Add Material button described below), that new
material will be displayed in a different color in this box and will
correspond to the color displayed on the model.

Add Material |

Reset Category Materials to
Default
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Once you have the appropriate material showing in this list, select it and then click on the portion
of the model to which you wish to assign it. For example, select Exterior Wall Expander #1 from
the list and then click on an exterior wall. That wall will turn green, which is the same color that
the expander name is shown in in the list. When you add subsequent materials and apply those to
your model (by highlighting them in this list and then clicking on the appropriate portion of the
model) their colors will be different, so that you can differentiate materials and where they have
been applied.

Command Buttons

Add Material — To add a different material (called an Expander in KeyMan) to the list above so
that you can apply it to parts of your model, first highlight the geometric category to which you
wish to add the material. Then click this button and select the new material from the drop down
that appears on the category name. The new material will be added to the list below the category
name and you are now ready to assign it to portions of your model.

Reset Category Materials to Default — If you have mistakenly added materials to the list and
assigned them to parts of your model, you may click this button to return the model to its default
state (i.e. the default materials you selected on the Other Materials tab of the General
Information screen will be re-applied to the appropriate portions of the model).

Change Categories — Click this button to change which Geometric Category (or categories) to
which you are applying materials.

Return — Click this button to return to the Main GS Plan window, saving any changes you have
made to the materials in your model.

The online document includes an extensive example at this point. “To summarize, here is an
example of applying two types of exterior wall expanders to a model...”

MATERIAL CATEGORY DESCRIPTIONS & MEASURES

Following is a description of the categories including how they are measured and an expander
product that might be applied to that geometric data:

Roof SF — This measurement is taken from the surface area
(square footage) of roof planes plus the square footage of
overhangs in your model. All roof planes including those
under overframing areas, are included in this measurement.
Openings are not subtracted from the total square footage.

Example Measurement: For a roof that is 30’ x 40’ with a
6/12 pitch and a 1’ overhang, each plane will be about 752
square feet. The total square footage for this roof would be
approximately 1,504 square feet.

Example Application: Calculating material requirements for %" roof sheathing.

Exterior Gables SF — This is the exterior square footage of all
gables on your job.
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Example Measurement: For two gables on a 30’ span, 6/12 slope building, the total
measurement will be about 225 SF.

Example Application: Calculating material requirements for 7/16" OSB sheathing.

Ladder Framing LF — This measurement is based on the linear
footage of ladder panel members generated by gable overhangs
(based on the number of pieces and the length of the framing).

Example Measurement: On a 30-foot gable, with a 1’ overhang,
each ladder panel will be 3’ long (assuming a 24" backspan). If
the ladder panels are places at 24" on-center, and a panel is
forced at the peak, 19 panels will be generated. This generates a
total linear footage of 57 linear feet of ladder framing.

Example Application: Calculating material requirements for 2 x 8
overhang framing for a gable overhang.

Soffit SF — This measurement is taken from the square footage
generated by overhangs. This measurement includes both the
Eave and Rake measurements (see below).

Example Measurement: On a 30’ x 40’ gable roof, with 1’
overhangs and a 6/12 pitch, the eaves would generate 42 square
feet each (40’ length with 1’ overhang on each end). The rakes
would generate 34 square feet each (since the corner overhang
was accounted for by the eave). The total square footage ends up
being 152.

Example Application: Calculating material requirements for vinyl
soffits.

Soffit Eaves SF — This is the square footage of overhang at the
tail ends of trusses.

Example Measurement: On a 30’ x 40’ gable roof with 1’
overhangs, the eaves would generate 42 square feet each (40’
length with 1’ overhang on each end). The total square footage
ends up being 84.

Example Application: Calculating material requirements for vinyl
soffits.

Soffit Rakes SF — This is the square footage of overhang on the
ends of gables, taking slope into account.

Example Measurement: On a 30’ x 40’ gable roof, with 1’
overhangs and a 6/12 pitch, the rakes would generate 34 square
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feet each (since the corner overhang was accounted for by the eave). The total square
footage ends up being 68.

Example Application: Calculating material requirements for vinyl soffits.

Fascia LF — This measurement is taken from the linear
measurement of all overhang lines. This measurement includes
both the Eave and Rake measurements. Lines are not extended
for exterior corners, but overlap for interior corners, so the
measurement should average out. This measurement does not
account for angled cuts or fascia width.

Example Measurement: If a 30’ by 40" house has 6/12 pitch roof
with an overhang of 1’, the total measurement would be 156 LF
(which also takes into account the pitch of the roof).

Example Application: Calculating material requirements for face
board trim.

Fascia Eaves LF — This is the linear feet of fascia measured along
the eaves (linear footage of overhangs at the tail ends of
trusses). This measurement does not account for angled cuts or
fascia width.

Example Measurement: On a 20’ by 30’ gable roof with a 2’
overhang, 68 linear feet of fascia would be generated.

Example Application: Calculating material requirements for face
board trim.

Fascia Rakes LF — This is the linear feet of fascia measured along
the rakes (linear footage of overhangs at gable ends). This
measurement does take into account the slope of the roof, but
does not account for angled cuts or fascia width.

Example Measurement: On a house with a 30’ span, 1’ overhang,
and 6/12 slope, the actual measurement on the end would be
about 36'.

Example Application: Calculating material requirements for face
board trim.

Exterior Wall Full SF — This measurement is the square
footage of the exterior sides of all the exterior walls in your
model. This measurement does not subtract the square
footage of door and window openings from the total
measurement.

Example Measurement: An 8 wall 10’ long will come out to
80 SF, regardless of openings.

Example Application: Calculating material requirements for 7/16" OSB sheathing.
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Exterior Wall Part SF — This measurement is the square
footage of the exterior sides of all the exterior walls in your
model minus the square footage of door and window
openings in these walls.

Example Measurement: An 8’ wall 10’ long will come out to
80 SF. If the wall has a 3’ by 4’ window and a 3’ by 6’ door
(equaling 30 SF) your final measurement will be 50 SF.

Example Application: Calculating material requirements for aluminum siding.

Exterior Window Trim LF — This is calculated by adding the
measurements for the top, bottom, and sides of all exterior
window rough openings. This measurement does not take into
account angled cuts or trim width.

Example Measurement: A window with a rough opening of 3’
by 4 would have a final value of 14 LF.

Example Application: Calculating material requirements for 1 x 4
wood trim.

Exterior Window Trim Top LF — This is calculated by adding the
widths of all window openings on exterior walls. This
measurement does not take into account angled cuts or trim
width.

Example Measurement: A structure with 10 three-foot wide
window openings would generate 30 linear feet of expander.

Example Application: Calculating material requirements for 1 x 4

wood trim.

Exterior Window Trim Sides LF — This is calculated by adding
the linear feet of the side dimensions of all window openings
on exterior walls. This measurement does not take into
account angled cuts or trim width.

Example Measurement: A structure with five openings that are
four feet tall would have a total of 40 linear feet of expander
(each opening has two 4 foot tall sides, so 8 total linear feet
per opening times five equals 40).

Example Application: Calculating material requirements for 1 x

4 wood trim.

Exterior Window Trim Bottom LF — This is calculated by adding
the linear footage of the bottom of all window openings on
exterior walls. This measurement does not take into account
angled cuts or trim width.

Example Measurement: A structure with eight openings that
are four feet wide would generate a total of 32 linear feet.
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Example Application: Calculating material requirements for 1 x 4
wood trim.

Exterior Door Trim LF — This is calculated by adding the
measurements for the top and sides of all exterior door rough
openings. This measurement does not take into account angled
cuts or trim width.

Example Measurement: A three-foot wide, seven-foot tall door
would generate 17 linear feet of expander.

Example Application: Calculating material requirements for 2 x 4
wood bucks.

Exterior Door Trim Top LF — This is calculated by adding the
linear footage of the top dimensions of all door openings on
exterior walls. This measurement does not take into account
angled cuts or trim width.

Example Measurement: A structure with 2 three-foot wide
exterior doors and 1 six-foot wide door would generate 12
linear feet of expander.

Example Application: Calculating material requirements for 2 x
4 wood bucks.

Exterior Door Trim Sides LF — This is calculated by adding the
linear footage of the side dimensions of all door openings on
exterior walls. This measurement does not take into account
angled cuts or trim width.

Example Measurement: One 7’ tall door would generate 14
linear feet of expander.

Example Application: Calculating material requirements for 2 x 4

wood bucks.

Exterior Outside Corners LF — This is the
total number of protruding corners on the
outside of exterior walls multiplied by the
height of the wall. This measurement is for
the corner only, so if materials are needed
for both sides of the corners, this number
will need to be doubled.

Example Measurement: On an L shaped
house there are five outside corners. If the
wall height is 8’, then the total for outside
corners would be 40 LF.

Example Application: Calculating material
requirements for corner trim.
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Exterior Inside Corners LF — This is the total
number of inward turning corners on the
outside of exterior walls multiplied by the
height of the wall. This measurement is for
the corner only, so if materials are needed
for both sides of the corners, this number
will need to be doubled.

Example Measurement: On an L-shaped
house there is one inside corner. If the wall
height is 8’, then the total for inside corners would be 8 LF.

Example Application: Calculating material requirements for corner trim.

Exterior Wall Part LF — This is the total linear footage of external
walls (as measured along the bottom of the wall) minus the linear
footage of door openings.

Example Measurement: If a house measures 30’ by 40’ and has
two 3’ doors, then the total measurement of exterior wall is 134
LF.

Example Application: Calculating material requirements for
starter strip or angle iron.

Exterior Wall Top Plate LF — This is the total linear footage of
exterior wall, as measured along the top of the wall to account for
raked walls. Door openings are not removed from the total
measurement.

Example Measurement: If a house measures 30’ by 40, then the
total linear footage would be 140, regardless of door openings.

Example Application: Calculating measurements for a second top
plate, to be attached to panels in the field.

Interior Wall Full SF — This measurement is taken from one
side (the inside) of the exterior walls in your model and
from both sides of your interior walls. This measurement
does not subtract the square footage of door and window
opening from the total measurement.

Example Measurement: An 8’ tall exterior wall 10’ long will
come out to 80 SF, regardless of openings. However, an 8’ tall interior wall 10’ long will come
out to 160 SF, regardless of openings. Therefore the total square footage reported for these
two walls would be 240 Sq. Ft.

Example Application: Calculating material requirements for interior drywall.
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Interior Wall Part SF — This measurement is taken from one
side (the inside) of the exterior walls in your model and
from both sides of your interior walls. This measurement
subtracts the square footage of door and window openings
from the total measurement.

Example Measurement: An 8’ exterior wall 10’ long will
come out to 80 SF. If the wall has a 3’ by 4’ window and a
3’ by 6’ door (totaling 30 SF of openings) your final measurement will be 50 SF. An 8’ interior
wall 10’ long with the same openings (totaling 30 SF of openings) will generate 100 SF
(because both sides of the wall are measured).

Example Application: Calculating material requirements for interior wall paint.

Ceiling SF — This measurement is based on the square
footage of ceiling planes in your model, so you must have
ceiling planes defined for the area to be calculated. Stair
or roof openings are not subtracted from this footage.

Example Measurement: In a two story, 10’ x 20’ structure,
each level would generate 200 square feet of ceiling, thus
the entire model would generate 400 square feet total.

Example Application: Calculating material requirements for
drywall.

Floor SF — This measurement is taken from the surface of
floor areas in your model. This footage is the same
regardless of stair openings.

Example Measurement: In a two story, 10’ x 20’ structure,
each floor generates 200 square feet of floor. The entire
structure generates 400 square feet of floor.

Example Application: Calculating material requirements for
%" OSB sheathing.

Interior Window Trim LF — This is calculated by adding the
measurements for the top, bottom, and sides of all interior
window rough openings. This measurement will not account
for angled cuts or trim width. Dimensions will be added once
for exterior windows (for the inside of the wall) and twice for
interior walls (both sides of the wall if there are windows in an
interior wall).

Example Measurement: A 3’ by 4’ window opening would
generate 14 linear feet of expander.

Example Application: Calculating material requirements for 1 x
4 wood trim.
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Interior Door Trim LF — This is calculated by adding the
measurements for the top and sides of all interior door rough
openings. This measurement will not account for angled cuts or
trim width. Dimensions will be added once for exterior doors
(for the inside of the wall) and twice for interior doors (both
sides of the wall).

Example Measurement: A seven-foot tall, three foot wide door
opening would generate 17 linear feet of expander.

Example Application: Calculating material requirements for 2 x

4 wood bucks.

Interior Wall Full LF — This measurement is calculated by
adding the total linear footage of the interior side of exterior
walls and two times the linear footage of interior walls (to
account for both sides of the interior walls). The measurement
is taken from the bottom of the walls and includes the
measurements for all openings.

Example Measurement: If the exterior of a structure is 30" by
40’, 140 linear feet of expander is generated. If there is 45
linear feet of interior wall, then an additional 90 feet of
expander is generated, producing a total of 230 linear feet.

Example Application: Calculating material requirements for
crown moulding.

Interior Wall Part LF — This measurement is calculated by
adding the total linear footage of the interior side of exterior
walls and two times the linear footage of interior walls (to
account for both sides of the interior walls). The measurement
is taken from the bottom of the walls and does not include the
measurements for openings.

Example Measurement: A structure with 30" by 40’ of exterior
wall, with two 3’ doors would generate 134 linear feet. If there
is 45 feet of interior wall, with four 2’ doors, 74 more linear feet
are generated (45 - 8 =37, 37 x 2 = 74). The total linear footage
generated is 208.

Example Application: Calculating material requirements for base trim.

Interior Wall Top Plate LF — This is the total linear foot
measurement of interior walls, which includes the interior side
of exterior walls and both sides of interior walls. This
measurement is taken along the top of the wall so that it takes
into account raked walls, and includes the length along all
openings.

Example Measurement: Three interior walls, one 10°, one 17/,
and one 9’ would generate a total of 36 linear feet.

Example Application: Calculating material requirements for
crown moulding.
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Foundation CF — This footage is calculated by generating the total
volume of all non-frame walls. If sixteenth inch walls are entered in
Model (usually to pass loads for option walls), these walls are also
included in the measurement. This category cannot be assigned using
the Assign Non-Structural Materials command in GS Plan.

Example Measurement: An 8" wide, 10’ tall, 20’ long wall would have
a final measurement of about 134 CF.

Example Application: Calculating material requirements for concrete
for foundation walls.

Foundation SF — This footage is calculated by generating the surface
area for one side of all non-frame foundation walls. If sixteenth inch
walls are entered in GS Plan (usually to pass loads for option walls),
these walls are also included in the measurement.

Example Measurement: A 10’ tall, 20’ long wall would have a final
measurement of 200 SF, regardless of wall thickness.

Example Application: Calculating material requirements for
foundation sealant.

Foundation LF — This footage is calculated by generating the
linear footage for all non-frame foundation walls. If sixteenth
inch walls are entered in GS Plan (usually to pass loads for
option walls), these walls are also included in the
measurement.

Example Measurement: A 20’ by 30’ house would have 140 LF
of foundation wall, regardless of wall height or thickness.

Example Application: Calculating material requirements for sill sealer.
Slab CF — This is the total volume of all Concrete
Slab areas used in your model.

Example Measurement: A 10’ by 20’ slab that is 4"
deep will have a final measurement of about 67 CF.

Example Application: Calculating material
requirements for concrete mix.

Slab SF — This is calculated using the surface of all
Concrete Slab areas in your model.

Example Measurement: A 10’ by 20’ slab will have
a final measurement of 200 SF, regardless of depth.

Example Application: Calculating material
requirements for carpet.
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Generate Non-Structural Materials List — Choose this command to generate the list of geometric
data and non-structural materials that have been applied to that data in this model. The files
(Level_10.mmn, for example) are level specific and can be used in KeyMan® to load the geometric
data and expanders from this job for use in your bid.

Generate Structural Materials List — Choose this command to generate a list of structural
materials that exist in this model (i.e. beams, girders). The files (Level_10.mms, for example) are
level specific and can be used in KeyMan® to load the structural materials from this job for use in
your bid. Remember that these members have not been engineered and therefore we
recommend running the job through Structure™ before loading the structural materials in
KeyMan®. If you run the job through Structure™, these files will be overwritten during the Select
Solutions process.

Output Window/Door Schedule — This feature allows you to generate and output a schedule of all
the doors and windows in an open job. The schedule is separated into groups of Doors and
Windows per level in the job. The schedule includes the Count or Quantity, Component, Product,
Plies, Rough opening width, Rough opening height, Sill height, and Header.

If one product is assigned to an opening header, that product will appear in the schedule. If
multiple products are assigned to an opening header the first product in the product list will be
listed in the schedule. If no product is assigned to an opening header, the product will be listed as
'No Selection' and the Plies will not be right.

To generate the schedule click on the Output Window / Door Schedule option in the Materials
pull-down menu or toolbar.

Output Floors to GSS —

GSS Floor Output Settings —
Option Materials Output —
Structural Options Materials List —

Output Members to LOC File —

Design KeyBuild® Help
DESIGN MENU Check Mode!
Edit Trusses
Check Model — Reconsoldate All Trusses
Truss Label Presets
Edit Trusses — ectiEges

Reconsolidate All Trusses —
Truss Label Presets —

Import Hangers —
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KeyBuld® Help
GS BUILD MENU Kepsds
The GS Plan menu allows you to quickly switch from one GS Plan® program to another. ﬁm
Simply click on one of the available programs from the menu, and GS Plan will save the GsSOutput

current job and close, then open the current level of the current job in the GS Plan®
program selected. Please note that if you choose KeyMan® or KeyBeam®, GS Plan will remain open.

()

o
/

GS Beam — ...opens the GS Beam application...

‘ﬁ GS Truss — ...opens the GS Truss application...

@] essoutput -
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HELP MENU

<

Contents — Displays the Table of Contents for the GS Plan 5.0 Designer’s

Manual.

Help
&) Contents
What's New

Visit Website

@ About KeyBuld®...

What’s New — Displays the Release Notes for GS Plan 5.0, including enhancements and

Visit Website — Launches you internet browser and automatically navigates to the Keymark home

page.

About GS Plan — Displays the About
information box pictured at right.

© 2014 Keymark Enterprises, LLC. ALL RIGHTS RESERVED

KeyBuid®, Model™, Structure™, KeyPlot®, KeyPanel®,
KeyTruss®, Keylat®, KeyOpt™, KeyMan®, KeyPlan®,
KeyComm®, KeyWind™, KeyBuildCAD™ and KeyUp™ are
trademarks or registered trademarks of Keymark Enterprises, LLC.

Keymark Enterprises, LLC. www.keymark.com
6707 Winchester Cirde Phone : (303) 443-8033
Boulder, CO 80301 Fax: (303) 443-9054

Keymark Enterprises LLC [1915746734]
Start Date: 8/1/2014 Expiration Date: 1/28/2015

@ KeyBuid 5.001 (Buld 741) C
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Plan Toolbars

The 20 Plan toolbars contain a subset of the most commonly used commands and functions available
from the Plan menu bar. Toolbars can be added or subtracted from the Main GS Plan Window in two
ways:

1. Click on the Tools menu and scroll down to the Toolbars option. On the sub-menu that appears to
the right, click on the toolbar that you want to add or remove from your view (those toolbars that
are already showing will have a checkmark next to them in the sub-menu).

2. Right click in a gray area of the GS Plan Window (for example, the gray area to the right of the
Help menu). On the menu that appears, click on the toolbar you want to add or subtract from your
view (those toolbars that are already showing will have a checkmark next to them).

THE ANNOTATIONS TOOLBAR

x|
The Annotations toolbar provides quick access to commands for... | £8[snvw| 7| ] R
Lbl Model Entity Labels — The Annotations toolbar.

il Draw Dimension Lines — A Dimension Line is an annotation that is used to display the distance

== petween two points. Dimension Lines are saved with the job and included in Layout Plots
generated from GS Plan. Please note that they will not be included in plots from GS Plan
Structure. To draw a Dimension Line, select the Draw Dimension Lines command from the Entities
| Annotations pull-down menu or from the new Annotations toolbar.

Point-to-Point Dimension Lines — A Point-to-Point Dimension Line displays the actual distance
between two selected end-points and is drawn parallel to a line connecting the selected end-
points.

7| Horizontal Dimension Lines — A Horizontal Dimension Line displays the Horizontal distance
between two selected end-points

Vertical Dimension Lines — A Vertical Dimension Line displays the Vertical distance between two
selected end-points.

Auto Dimensions Filter —

/| Draw Arbitrary Lines —

BN |2

[Z]] Draw or Edit Text Box —
Edit Annotation Attributes —

THE HEADER MACROS TOOLBAR

The Header Macros toolbar provides users with commands to... |
alzlEls ]

H Quick Header — The Quick Header command allows you to place

7 headers into interior and exterior framed walls. Executing Quick Header
will first display the Define Component window, allowing you to define
the opening that you want to place. Once you have defined the door or window that you want to
place, and clicked OK, you will be prompted to select a wall to place the header in. To specify a
wall for placement, click on the center of the wall. The header placement lines will then appear.

The Header Macros
toolbar.
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Use the keyboard to define the exact location of the header. When the header is in the proper
location, press the Enter key. You will be returned to your previous view, again being prompted to
select a wall to place the header in.

To choose a new header, press the Escape key or click the right mouse button. This will return you
to the Define Component window. At this point, you can choose a new header to place, then click
the OK button to place it, or click the Cancel button to return to the Main window.

Below is the Define Component x|

Window. See below for more
information on each field.

Component Part #: Set Component |
Component Type — Choose the type R.O.Szefdxh): [260  x [260 SetComp. Assy. |
of opening component you want to Header Depth: [94 Unset Comp. |
use, Door or Window. The fields that Header Height: [680
are available below will change based LeftMin. Bearing: [ 18 No. Trimmers: [ -1
on the Component Type you select. Rioht Min. Bearing: [ 13 No. kg Stucs: [-1

TrmWwidth: [30 No.Uppersds:[-1

Component Part # — This is the name No. Ples: |
of the component that you are Product: [ No Product Assigned
currently viewing. To change, or L
choose a component, click the Define s r(: G save Aspefouts |
Component button. Note: it is not
necessary to define a component, you [ —— = |

may input an opening based on rough
opening dimensions only.

R.O. Size (wd x ht) — This is the exact size of the opening to be placed in the wall. Enter the width
of the opening in the first field, and the height in the second.

Header Depth — This is the exact depth of the material that will be header deplh‘
as the header. This value is entered in inches and sixteenths of an
inch.

opening

Header Height — This is the distance from the bottom of the
wall to the top edge of the opening.

height height
header
Left Min. Bearing — This is the total width of any members that will be
supporting the left side of the header. This value is entered in inches and opening
sixteenths of an inch.

i

header width

Right Min. Bearing — This is the total width of any members that will be
supporting the right side of the header. This value is entered in inches and
opening sixteenths of an inch.
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Trim Width — This is the closest that either end of this opening can get to another opening or an
intersection wall. This value is entered in inches and sixteenths of an inch.

No. Plies —
Product —

No. Trimmers -
No. King Studs —
No. Upper Sills —

Door Side — This is the direction that the door should swing. Inside and Outside refer to the room
that the door is placed into.

COMMAND BUTTONS

Set Component — Click this button to select a x|
component from the list of doors and windows

you have created in KeyMan. Below is the Set Window Type: [(an
Components window. See below for more

information.

When you first enter this screen, all door or
window components are displayed (depending

on the component type you chose on the Only first 2,000 qualifying windows
. . retrieved; please narrow your selec-
previous screen). To narrow the list, select the tion crteria and press Update List. oK | cancel |

component type in the column on the right
and/or other options such as Swing or Location.
Then click the Update List button to filter the component list based on the selected options.
Highlight the component you wish to place and click the OK button. If no components appear in
the list, make sure that the KeyMan® path is set correctly

on the File, Set Paths screen. x|
Box 2)-162 -
Set Comp. Assy. — Clicking on the Set Component Assembly C“fg;::“ @Eﬁ%ﬁoﬁwzm :]
command button opens the Set Component Assembly ) @@ i e
dialog box pictured at right. e s SO -
Component File — Tipe: | #pngs: [0
R.O. Size (wd x ht): |D-I'HJ x |D-I'HJ
Type —
Her. Height: [oo0 Depth:  [00
# Openings — o | il
R.O. Size (wd x ht) —
Hdr Height —
Hdr Depth —

Unset Comp. — When a component is selected, the rough opening size is pre-determined and
therefore those fields are grayed out. If you wish to change this door or window from having a
component to having a rough opening, click this button. The Component Part # field will be
cleared and the rough opening fields will become available.
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Save As Defaults — Click the Save As Defaults button to store the information in this window and
bring it up every time a new header is being defined.

OK — Click the OK button to apply the information entered in this window and return to the Main
window.

Cancel — Click the Cancel button to return to the Main window without making any changes to the
selected header or header being placed.

Products —

Move Header — The Move Header command allows you to move existing headers. When you
select Move Header from the Macros menu, you will be prompted to select a header to move.
When you click on a header, the header placement lines will appear. Use the keyboard to define
the new location for the header. When the location has been defined, press the Enter key. You will
then be prompted to select another header to move. To return to the main GS Plan™ window,
click the right mouse button or press the Escape key.

Note: Clicking the right mouse button or pressing the Escape key while a header is selected (while
the placement lines are visible) will cause the header to be deleted.

Delete Header — The Delete Header command is used to remove existing headers from a model.
When you select Delete Header from the Macros menu, you will be prompted to select a header
to delete. Move you cursor over a header, and click the left mouse button. The header will be
removed from the wall. You will then be prompted to select another header to remove. Click the
right mouse button or press the Escape key to return to the Main window.

Snap Header — The Snap Header macro allows the use of the ends of Construction Lines to create
snapping points for placement of headers within walls. Snap Header works in much the same way
as Quick Header with some minor differences. To access the Snap Header command click on the
Snap Header option in the Headers sub-menu of the Macro pull-down menu or the Snap Header
button in the Header Macros toolbar.

When selected, Snap Header, like Quick Header, displays the Define Component dialog. When
component selection has been completed, again like Quick Header, you are asked to select a wall
for insertion of the selected component. When a wall has been selected, the typical header
placement cursor along with appropriate dimension line information is displayed. It is at this point
that Snap Header behavior will differ from Quick Header.

If Snap Header detects either endpoint of a Construction Line within the boundaries of the
selected wall, the point is added to a list of available snapping points. If any snap points are
associated with the selected wall, the header placement cursor will only be allowed to traverse
between these snap points as the cursor is dragged using either the mouse or the arrow keys.

Except for the Page Up and Page Down keys, the current Quick Header keystroke/mouse
functionality applies to Snap Header, including the End key to change the location along the rough
opening where dimensions are drawn.

If Snap Header does not detect any available snapping points, the current Quick Header drag
functionality is employed.

Regardless of whether or not snap points are being used to place the header component, an
additional feature of Snap Header allows you to input a specific offset dimension to either side of
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THE GS BUILD TOOLBAR

The Keymark toolbar provides users with commands to...

Y

the target header component. Upon entering Snap Header, one of the dimensions on either side
of the placement cursor will be highlighted in red. The Page Up and Page Down keys, as well as
the middle-mouse scroll wheel, can be used to toggle the highlighted dimension from one side of
the placement cursor to the other. Either, clicking the middle mouse button, or pressing the Space
Bar key will bring up the Input Header Offset dialog:

Header Products —

Verify Components — The Verify Components command allows you to view and change door and
window components used. Select Verify Components from the Headers sub-menu to label each of
the component headers. The labels will correspond to the list on the right side of the window.
Headers that were entered as rough openings (not as components) will also have a label next to
them. Click on a header in the Plan View of the model to view or change its properties. To return
to the Main window, click the right mouse button.

Enhancements have been made to the Verify Components macro to make it more useful in quality
control checking. In Verify Components mode of previous

versions of GS Plan, components were labeled together as long [Set Selection Criteria x|
as they had the same Component Part Number. Now you can

choose additional criteria to group components by including I Product

Assigned Product, Header Height, Number of Plies, Rough ™" Header Height

Opening Size, and Left/Right Minimum Bearing. For Products, if I [BEEetoiies

¥ Rough Opening Size
™ Left / Right Minimum Bearings

multiple products are assigned to a header, the first product in
the product list will be used. To set the criteria, click the new
Set Criteria button in Verify Components to access the Set
Selection Criteria dialog box shown below. Check the boxes of
the properties you would like included in the labeling of
components.

When in Verify Components mode, you can click on a header to access its properties. If you
change any properties, you will now be asked whether you want to "apply updates to all like
headers?" If you click yes, those changes will be applied to all like headers with the same label.

Change Components — The Global Change Components command allows you to change a door
and window component and have that change affect all components of that type in your model
(including in any options). Select Global Change Components from the Headers sub-menu and
then select one of the components you wish to change. The Define Component window
(described above) will appear. If the door or window was entered as a component, the Set
Component and Unset Comp will be available. Click the Set Component button to change the
component for this window or door. Click the Unset Comp button to delete the component and
instead enter rough opening dimensions. When you click OK, the change will affect the selected
component as well as all the components that were the same as that one.

Move Snap Header —

The GS Build
toolbar.

GS Beam

GS Truss
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THE OPTIONS TOOLBAR

The Options toolbar provides users with commands to... The Options
toolbar.

Create/Edit Option —

Select Options —

Copy/Xfer Option —

Copy Selected Entities Option —

Option Materials Output —

Bl ==

THE PANEL TOOLBAR =

The Panel toolbar provides users with commands to...

1-

£l

=
THE ROOF PLANES TOOLBAR 3| %] 7 (B8] X< | @ @

The Roof Planes toolbar provides users with commands to... The Roof Planes toolbar.

b4

Create Planes —

‘i Extend Plane -

Auto Extend Single -
Auto Extend All -

Clip Off Corner —

Five Sided Bay Window —

Three Sided Bay Window —

@& 7 [H 4 |

| Selection & Snap k|
THE SELECTION & SNAP TOOLBAR ] 3
The Selection & Snap toolbar provides users with commands to...
The Selection &
Set Snap Grid — Snap toolbar.

B
@I Set Visual Grid —
5| Deselect All -
@ Select Item(s) -
L] select All Visible -

THE STANDARD TOOLBAR x|
sle|z|v|v|o|za ¢ e e k]

108 The Standard toolbar.




The Standard toolbar provides users with commands to...

E:l Set Levels — The Set Levels command allows you to view and edit information about all the levels
in the current model, as well as create new levels. For additional information, please see the

®)

L (21 B P VR ST SN SR

section within this document entitled...

Set Visibility — The Set Visibility command allows you to pick which entities should be displayed in
the drawing area, and which should be hidden. If a member type name has a check next to it in
the Set Visibility Window, it will be displayed in the Drawing Area. If the member is not checked, it
will not be shown. To check (or un-check) a member type, click in the box to the left of the name.
Below is the Set Visibility window. See below for more information on each field.

Member Types — Place a checkmark next to the
member types that you want to be visible in the
model. Uncheck the member types that you do not
want to be visible.

All On (1) — Click the All On button (or press the 1
key on your keyboard) to place a check in every box,
and all member types will be displayed.

All Off (2) — Click the All Off button (or press the 2
key on your keyboard) to remove the check from
every box, and no member types will be displayed.

OK — Click the OK button to apply the information
above and return to the main GS Plan™ window.

|

[V Construction Lines [V Hip End Lines
[# Bearings [V Eraming Members

[V Load Walls/Hdrs ¥ Roof Members

¥ Non-oad Wals Hdrs [V Celing Members
[V AreaBoundaries ¥ Floor Members
[ Qpenings/Obstructions [V Hip End Members
[V Load Boundaries/Lines IV Ladder Panels
¥ Roof Planes [V Hangers
[V Ceiing Planes [¥ Floor [v Roof
[v Overhang Lines [V Annotations
¥ Joist Holes [¢ Sheathing
[V Gable Lines [¥ Shadow Lines

ok | monmy AlOFF[2) |

Cancel — Click the Cancel button to reset the information in the window (as it was when you

entered) and return to the main GS Plan™ window.

Apply — This button is grayed out until you make a change to the checkboxes above. Click this
button to apply the changes in this screen immediately and see how the changes affected your

model without having to close this window.
Bearings —

Planes —

Extend Plane -

Areas —

Show/Edit Truss Profiles —
Zoom/Pan Window —

Plan View —

Animate -

Solid Model —-

Set Properties —

Select Item(s) —
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THE STRUCTURE COMMANDS TOOLBAR

The Structure toolbar provides users with commands to perform all =
the functions of the Structure program, from generating loads to [eveio =] Bllor| a6 =1 |

creating plots. Note: The buttons on the Structure Commands

. . . . The Structure Commands toolbar.
toolbar will be unavailable until you save your job.

[Level Drop-Down List] — Click the Levels button on the Structure Commands toolbar |Level 10 vI
to select a job level. Selecting a level makes that level both active and visible. If you had
other levels active, visible or shadowed, those levels will be turned off.

[&]] Set Structure Defaults — Click the Set Structure Defaults button to run one or more of the Design
== and Member Placement steps of designing the structure. These steps will generate loads, analyze
the materials and place members.

il Vibration Conditions — Click Vibrations Conditions on the Structure Commands toolbar to open

' the General Information window and view the Vibration Conditions tab. This gives you easy access
to change your Vibration Condition settings while designing a job, since you will likely change
those settings per level. (THE VIBRATION CONDITIONS TAB IN GENERAL INFO NO LONGER EXISTS.)

j@ Generate Loads — Generate Loads is the first command that must be run on each level of your job.
Click the Generate Loads button to:

1. transfer loads from the level above,

2. generate loads within the current level,
3. verify all loads are supported, and
4

verify all members are supported.

If you are designing a multi-story building, upper levels must be run through Generate Loads
before lower levels so that loads can be properly transferred from level to level.

If any problems occur while the steps above are being run, you will receive a message in the
Message Log. There are three types of messages: warnings, errors and constraints. If you receive
any error or constraint messages, you need to fix those problems in the model and click Generate
Loads again in order to continue. If you receive a warning message, that problem in the model can
likely be fixed in the field and you can continue designing your job. The table below describes
warning, error and constraint messages.

Member Selection — Click Member Selection to choose products for each member in the job. First
click a member type (Framing Areas, Joist Areas, Girder, Beams, Headers, Non-Load Bearing
Headers or Posts), then select the members. Click Select to choose a product for the selected
members. You can also view a calc sheet for any member or open a member in the Beam program
for further review.

=

= Selected — Selected shows the numbers of the selected members. In the picture above, all
the joist areas are selected so it displays 1-12 in the Selected field. This field can also be
used to select members. The numbers for each member can be found next to the member
type they represent in the Display Area below. Enter or select the numbers of the
members for which you want to select products. There are several ways to select
members:

— Type the number(s) of the member(s) into the Selected field

—  Click the plus (+) and minus (-) buttons to add or remove all members
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— Click and drag to draw a box around the members in the Display Area
— Left click on a single member to add it to the Selected list

— Right click on a single member to remove it from the list

Selected Product — This field displays the material and plies, lams, or spacing used for the
selected members. If the selected members have different solutions, the word "various"
will be displayed. If you see "***No Solution***", you will need to choose a product that
works for this member.

Select — Click Select to choose products for the selected members.

Message Box — This area gives you hints on the next step you need to perform. In the
picture above, it says "Left adds/right removes" meaning that you click a member to add it
to the Selected list, right-click a member to remove it from the Selected list.

Price — This field displays the total price for the level you are currently designing. This total
is based on the prices entered on the Pricing tab on the General Information window. If
you choose a material during the Member Selection process that is not listed on the
Pricing tab, you will be prompted to enter a price for that material and it will be entered
into the table on the Pricing tab as well.

Display Area — This area shows you the current level. When you click a member type such
as Girders, those members will be highlighted in the Display Area. Click on a member to
select it, or click and drag to draw a box around multiple members at once. Hover over a
member to see its product solution.

Framing Areas — Click Framing Areas to display all the Framing Areas in the Display Area.
For every area in your job, a Framing Area is displayed here.

Joist Areas — Click Joist Areas to display all joist areas in the Display Area. A Joist Area is
made up of a section of a Framing Area where there is a common design (a part of the
Framing Area where the members have the same length and loading).

Girders — Click Girders to display all girder members in the Display Area. Girders are flush
support members (defined as girder, not truss girder or girder by others).

Beams — Click Beams to display all beam members in the Display Area. Beams are dropped
support members (defined as a Beam, not Beam by Others).

Headers — Click Headers to display all load bearing headers in the Display Area. Headers
are members framed above door or window openings (defined as headers in a load
bearing wall).

Non-Load Bearing Headers — Click Non-Load Bearing Headers to display all non-load
bearing headers in the Display Area. Non-load bearing headers are members framed
above non-bearing door openings (defined as headers in non-load bearing walls).

Posts — Click Posts to display all posts in the Display Area.

Calc Sheet — Click Calc Sheet to display the design information for the selected member(s).
The calc sheet for the first of the selected members will be displayed. If there are
additional calc sheets to view, click Next to move to the next sheet. Click Print at the top
of the Calc Sheet window to print these pages.

Open KYB — Click Open KYB to open the currently selected member in the Beam program.

Exit — When you have finished selecting solutions for each member, click Exit.
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Member Placement — Click Member Placement to place joist accessories as well as generate a list
of all the designed materials in the current level along with component, expander, and hanger
information. This information will be used to create a material file that can be displayed on plots
and imported into KeyMan or TMS.

Joist accessories include rim, blocking, web stiffeners, and cantilever reinforcements. All the
accessories required by the design are placed during Member Placement and appear directly in
your job. Their placement is affected by the presets on the Joist Accessories, Blocking & Rim, and
the Web Stiffeners & Cantilevers tabs of the General Info window.

To adjust any members placed during Member Placement, use the commands on the Modify
menu, such as Trim/Extend Lines and Shift/Copy Selected. To add additional framing materials,
click Entities and then click Additional Framing.

If any member on the current level does not have a solution, you will receive a message that one
or more members does not have a solution. Click Member Selection to check for the failing
member and find a material that will work.

NOTE: Generate Loads and Member Selection need to be run on the current level before you can
run Member Placement. If these steps have not been done, they will be run for you when you click
Member Placement.

NOTE: If you place any additional framing materials (such as rim and blocking) prior to running
Member Placement, those members will not be deleted before the Member Placement process
adds new ones. You will receive a message in the Message Log that says there are overlapping
members. Click on the message to see the location of the warnings in the model and make
corrections as needed.

Hanger Selection — Click the Hanger Selection button on the Structure Commands toolbar to view
and edit hanger information for the current level.

= Hanger List — Click on a plus sign (+) to view more information about that hanger. Click the
minus sign (-) to hide that hanger's information

=  Select Hanger — Click Select Hanger to choose a hanger for the selected connection. The
list will be made up of hangers from your KeyMan/TMS Inventory followed by Simpson
Strong-Tie hangers that work for the condition. Click a hanger in the list and then click OK.
You will receive a message if no solution can be found for a selected hanger, and that
hanger will be marked as a Special Order hanger on the output.

= Select from Inventory — Click Select from Inventory to choose a hanger from your Keyman/
TMS Inventory. The list will only be made up of hangers from your KeyMan/TMS
Inventory. Click a hanger in the list and then click OK.

= Edit Hanger — Click Edit Hanger to edit the depth and species of the carrying member.
=  OK-Click OK to exit the Select Hangers window and save your changes.

=  Cancel — Click Cancel to exit the Select Hangers window without saving any changes.
Additional Framing — This button allows you to easily add additional framing to your job such as
rim and blocking. Click the Additional Framing button and then draw a line where you want the

members to be placed. Choose the type of members to place (Rim Joist, Blocking, Bracing, etc), set
the properties and product and then click OK. The additional framing will be added to the job. To
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enter a crush block, click on the location you want it placed and then press the down arrow and 0.
You can then use the shift/copy selected command to copy this crush block to multiple locations.

Structure Outputs — Click the Structure Outputs button on the Structure Commands toolbar to
generate several different types of output including plots, calc sheets, cut lists and KeyBeam files.
The table below contains descriptions of each option.

Framer's Plot — Click Structure Outputs and then click Framers Plot to open KeyPlot and
generate a builder’s layout. The Framer’s Plot contains a layout of the level, a hanger list,
and a consolidated materials list. The labels for the members are consolidated as well,
with like members (members of the same material and length) bearing the same label.

Loads Plot — Click Structure Outputs and then click Loads Plot to open KeyPlot and
generate an engineering layout. The Loads Plot contains a layout of the level and a hanger
list. The labels for the members are independent to each member, and correspond to the
label on the Calc Sheet.

Print Calc Sheets — Click Structure Outputs and then click Print Calc Sheets to print a
calculation sheet for every design member (except By Others or Truss members) on the
current level.

Print Hanger Calcs — Click Structure Outputs and then click Print Hanger Calcs to print a list
of the calculations used to pick the hangers used on the current level.

Print Hanger Table — Click Structure Outputs and then click Print Hanger Table to print the
Hanger Table (the same one that is generated for plots).

Print Cut List — Click Structure Outputs and then click Print Cut List to print the Cut List (the
same one that is generated for plots).

Print Member Load Report — Click Structure Outputs and then click Print Member Load
Report to print a loads report for any "by others" members (Beam by Others, Framing
Member by Others or Girder by Others) in the current level. Since no products are actually
sized for these members, this is the only way to see any load information for them.

Create KeyBeam Files — Click Structure Outputs and then click Create KeyBeam Files to
generate a .kyb file for each design member (except By Others and Truss members) on the
current level. You can open .kyb files in KeyBeam.

Structural Materials List (MMS File) — Click Structure Outputs and then click Structural
Materials List (MMS File) to generate a list of structural materials that exist in the model.

NOTE: Member Selection must be run successfully in order to generate a Framer's Plot or Loads
Plot, Print Calc Sheets, or Print Hanger Calcs.

The Structure Status Information window shows you the status of the Design and Member
Placement steps for each level in your job. In the example below, the Design and Member
Placement steps have already been run on Level 15, as shown by the green check marks. The
Design steps are set to run on Levels 5 and 10 and Member Placement is set to run on Level 5, as
shown by the gray background around the red Xs.
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@ Structure Status Information @
Memb. Message Log
Level | Design Flacement
15 s v
10 X X
5 x X
Run Batch | Close I

= [evel —This field lists each level included in the job. For each level, you can see whether or
not Design and Member Placement have been run successfully. You see a red X in those
columns if those steps have not been run successfully; a green check mark if they have
been run successfully.

Click the boxes for the steps you wish to run on each level. The box background will be
gray when that step is set to run. In the image above, Design and Member Placement will
be run for Level 5, while only Design is set to run for Level 10. Since Design must be run on
upper levels before lower levels, if you click the Design box on Level 5, any levels above
that one will show gray boxes for Design as well.

= Message Log — Displays a log of the progress analyzing the job. For successful batches, you
see a "RESULT: SUCCESS, ALL_DONE" message. For unsuccessful batches, you see a
"RESULT: FAILURE, ALL_DONE" message. The error is then highlighted in the message log
so you can adjust the model or your settings.

=  Run Batch — A batch is a set of steps the program will run. Click Run Batch to run the steps
selected in the Level List above. While the batch runs, you see a progress bar that
indicates the progress of the batch.

= Cancel Process — Click this button during a batch to cancel the process. The current
process stops and you see "RESULT: Canceled" in the Message Log.

= (Close — Click to close the window and return to the Main Build Window.

THE TOGGLE MACROS TOOLBAR

x
The Toggle Macros toolbar provides users with commands to... GG dEdGdbdk dEdE S|
Toggle Load/Bearing — Toggles between load bearing and non- The Toggle Macros toolbar.

Cfe
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load bearing...The Load Bearing Toggle allows you to switch walls on the active level from bearing
to non-bearing and back with a single mouse click. Walls will be displayed as follows: Load Bearing
walls will be displayed in green. Non-load Bearing walls will be displayed in purple.

Toggle Roof/Floor — Toggles between roof and floor...The Roof/Floor Toggle allows you to view
and change walls on the active level from roof bearing to floor bearing and back by clicking on
them. Walls will be displayed as follows: Roof supporting members will be displayed in green.
Floor supporting members will be displayed in purple.

Toggle Interior/Exterior — Toggles between interior and exterior...The Interior/Exterior Toggle
allows you to switch walls on the active level from interior to exterior and back with a single mouse
click. Walls will be displayed as follows: Interior members will be displayed in green.

Exterior members will be displayed in purple.

Toggle Wall/Header Widths — The Wall/Header Widths Toggle allows you to view and change the
widths of all wall and header members on the current level. Each of the different wall or header
width will be displayed in a different color. A key to these colors will be displayed on the right side
of the main window.

To change the width of a wall or header, click the width to which you want to change from the

sidebar and then click on the wall or header that you want to change. To change a member to a
width that is not listed on the sidebar, click the Other entry, then enter the new wall width and
click the OK button. The new width will be listed as an option on the sidebar.

To change all members to a specific width, click the Global Change button. You will then be
prompted to select which types of walls should be changed: Interior, Exterior or both. Click the OK
button to change all of the members specified to the currently selected width.

Toggle Overhang Lengths—

Toggle Framed Foundation/Non-Framed — Toggles between Framed, Foundation, and Non-
Framed...The Framed/Non Framed Toggle allows you to switch walls on the active level from
framed to non-framed and back with a single mouse click. Walls will be displayed as follows:
Framed walls will be displayed in green. Non Framed walls will be displayed in purple.

Toggle Top Track Elevations — The Top Track Elevation Toggle allows you to change the heights of
walls on the active level by change their top plate elevations. Each existing wall height will be
displayed in a different color. To add a new wall height, click the "Other" entry in the list on the
right and enter the new top of plate elevation. This number will be added to the list. Select the
height you wish to assign from the list on the right and then click on the wall to apply it to. The
wall height will change, but the bottom plate will be held in its previous location.

Toggle Wall/Header Heights — The Wall / Header Height toggle allows you to toggle Wall and
Header Heights for the active level. When in Toggle Wall/Header Height mode, walls will be
visible and colored according to the wall height legend on the right side of the screen. To change
wall heights, left-click on the appropriate wall height in the legend, then left-click on each wall to
change. To add new wall heights, click on the Other button, enter the new wall height in the Set
New Wall Height dialog box, and click OK. To Globally Change wall heights, changing all wall
heights of the active level, click on the appropriate wall height, then click the Global Change
button, and finally check the appropriate boxes in the Toggle Wall/Header Values dialog box and
click OK.
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Toggle Bearing Properties — The Toggle Bearing Properties option allows you to apply the
properties of a selected bearing to other existing bearings. When in Toggle Bearing Properties
mode, the visibility will change so only bearings are visible. You will be prompted to 'Select
Template Bearing,' where you will click on an existing bearing to be the template bearing. The Set
Bearings Properties dialog box will come up for you to verify or change the bearing template
properties. These are the properties that will be applied to other bearings. Once the template
bearing properties are set, click OK to begin applying these properties to other bearings or Cancel
to not apply the template bearings properties. You will be prompted to Select Target Bearing.
The properties of each bearing you click on will change to match the templates properties. You
can continue to toggle bearing properties until you right-click with the mouse or press the Escape
key.

F

EE Toggle Bears on Earth — Toggles between Bears on Earth and Bears Not on Earth...

THE TOP TOOLBAR
The Top toolbar provides users with commands to... [
r.op. [000
] 1-
roeJoos
| Wall Panel Tools x|
THE WALL PANEL TOOLBAR "

The Wall Panel toolbar provides users with commands to...

Display and Modify Corner Laps —

Relap All Walls to Default -

The Wall Panel toolbar.

Frame One Wall -
Frame All Walls —
Unframe One Wall —

Unframe All Walls —

EZEEE>D

Panel Application —
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GENERAL INFORMATION TABS & SETTINGS

Job Info Tab
i

Deflection Crteria | Joist Accessories | Blocking&Rim | MaterialLists | Cutlengths | Colors&line Types | PlotLabels |
Jobifo | JobSettings | Loadifo | FramingMembers | OtherMatedals |  Panel Setings | Design Settings

I™ lob Name: I™ Salesman ID: |
™ Customer ID: [~ JoblD [
™ Customer Address: [~ Ste Address:

[ Job Comments:

Select checkbaxes to include fields on calc sheets

| OK I Cancel

Job Name — Type the name of this job (up to 12 characters).

Salesman ID — Type the salesman's ID number (up to three characters).

Customer ID — Type the customer's ID number (up to six characters).

Job ID — Type the Job ID (up to 32 characters).

Customer Address — Type the customer’s name and address.

Site Address — Type the address of the site where this job will be built.

Job Comments — Type any additional information that you want associated with this job.
OK — Click OK to save the changes.

Cancel — Click Cancel to return to the previous window.
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Job Settings Tab
i

_ Deflection Crteria | Joist Accessories | Blocking&Rm | MaterialLists | Cutlengths | Colors&Line Types | PlotLabels |
Job Info JobSettings | Loadifo | FramingMembers | OtherMaterials | PanelSettings | Design Settngs |

Designer:
Boof Pich: [g /12 = |
Wal Width: [3.3 Company Address:
_ l— ‘our Company Name Here
B> 00 ompany Address Here
any Address Here
™ Metric Units: any Phone Number Here
[~ Hi Pre Unis:
I~ FFIISS Units: Extend Planes: (* By intersection lines
¥ Glued Flooring: € By adiacent planes
I™ Bearing as Floor: Plot Program: (%' KeyPlot
™ Unique Rim Labels: " Bxport Plot DXF
™ Unigue Girder Labels:
Save as Defaults Restore Defaults

[ ok ] coca |

Roof Pitch — Enter the default roof pitch that you want to use for this job. Click the up and down arrows
to change the pitch format between:

= Slope over 12
= Slope over 10
= Degrees

=  Percentage

If you select slope over twelve (#/12), the first number represents the rise for #
every twelve units of run (as in a 6/12 roof slope).

If you select slope over ten (#/10), the first number represents the rise for every
ten units of run (as in a 4/10 roof slope).

If you select degrees (#°), the number entered represents the slope in degrees (as
in a 30° slope). This is based on a horizontal line being 0°, so a vertical line would 4 W

be input as 90°.

If you select percentage (#%), the number entered represents the percentage of
slope. A flat roof is 0% and a 45-degree angle is 100%. #%
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Wall Width — Type the default width of the walls in this model.
Wall Height — Type the default height of walls in this model.
Designer — Type the name of the designer for this job. This information appears on all output.

Company Address — Type your company’s name, address, and phone number. This information appears
on all output.

Metric Units — Select this box to use Metric units of measure instead of the default Imperial units.

METRIC
The default value in metric units is millimeters. Possible formats include:

=  m-—meters
= dm - decimeters
= cm - centimeters

=  mm - millimeters

If a value is entered with no measurement (e.g., entered as 1000 instead of 1000m or 1000cm) it is
assumed to be in mm. To force a value to use a specific unit of measure, simply include the letters
above (e.g. 3m means 3 meters)

IMPERIAL

The default format in Imperial units is feet — inches — sixteenths of an inch. Possible formats include:
= 10 =ten feet
= 3-8 =three inches, eight sixteenths (or half) of an inch (a common wall width default value)
= 10-5-8 =ten feet, five inches, eight sixteenths of an inch
= (0-5-8 =five inches, eight sixteenths of an inch

Although the default is feet — inches — sixteenths of an inch, you may enter that value in multiple
ways. You could enter two feet as 2+0+0, 2, 24in, 24", 2ft, 2’, or 2.00 and all would result in 2-0-0.
Certain fields will force you to input only inches and sixteenths of an inch.

Hi Pre Units — Select this box to force the application to use more precise numbers. Numbers display
with four decimal places (as in a 3.5000 wall width), allowing measurements to be input to 1/10,000th
of an inch for Imperial or to 1/100th of a millimeter for Metric.

FFIISS Units — Select this box to type FFIISS (Foot-Foot-Inch-Inch-Sixteenths-Sixteenths) numbers without
additional symbols. This lets you input dimensions more quickly because you are only typing numbers.
For a 10-3-8 span, type 100308 instead of 10-3-8 or 10+3+8.

Glued Flooring — Select this box to indicate that you want the structural analysis of the floor design to
include the sheathing as glued and nailed to the joists. Clear this box to analyze the floor as nailed only,
which is a more conservative design. This setting is reported on joist calc sheets.

Bearing as Floor — Select this box to set your bearings to support floors by default. When you input a
bearing such as a wall or girder, the Floor check box is selected.

Unique Rim Labels — This field affects only machinery files output using the commands on the Materials
menu. Select this box to ensure that each piece of rim gets a unique label. If this box is cleared, rim that
is alike in length and product gets the same label in the machinery file. Since these labels are used by the
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machinery to mark the pieces and those labels are used to place the pieces, some users prefer that the
pieces are labeled consecutively instead of by like length/product.

Unique Girder Labels — This field affects only machinery files output using the commands on the
Materials menu. Select this box to ensure that each girder gets a unique label. If this box is cleared,
girders that are alike in length and product gets the same label in the machinery file. Since these labels
are used by the machinery to mark the pieces and those labels are used to place the pieces, some users
prefer that the pieces are labeled consecutively instead of by like length/product.

EXTEND PLANES
Select one of the following as your default method for extending roof planes:

= By intersection lines — The default and the most commonly used option for extending planes.
When you select to extend a plane, all possible intersection lines are displayed and you must
click on each line in a clockwise order.

= By adjacent planes — Lets you extend planes by clicking on an adjacent wall or adjacent plane,
instead of clicking on potential intersection lines.

PLOT PROGRAM
Select the program you want to use for plots.
=  Plot — generates the plot in KeyPlot.

= Export Plot DXF — generates a DXF from KeyPlot that can be opened in any other CAD program.
This option automates the steps of opening KeyPlot and generating DXFs for you.

COMMAND BUTTONS

Save as Defaults — Click Save as Defaults to store all information on this tab as the default information.
Each time you start a new job, these settings are used.

Restore Defaults — Click Restore Defaults to replace all settings on this tab with the default settings that
you saved previously using Save as Defaults.

OK — Click OK to save the changes.

Cancel — Click Cancel to return to the previous window.
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Load Info Tab

i
_ Deflection Crteria | Joist Accessories | Blocking&Rm | MaterialLists | Cutlengths | Colors&Lline Types | Plotlabels |
Jobifo | Job Settings Loadinfo | FramingMembers | OtherMaterisls | PanelSettings | Design Settings |
Floor Loads " Roof Loads '
Top Chord / Joist Live |40.000 psf Top Chord /Rafter Live |21}.D0(]p§
Top Chord / Joist Dead [15.000 psf loadCase [Roor ]
Bottom Chord Live [0.000 psf Top Chord /Rafter Dead [10.000 psf
Bottom Chord Dead [0.000 psf Bottom Chord Live [0.000 psf
‘Wall Loads Bottom Chord Dead |10.000 psf
Exteror Wall Weight [10.000 psf ™ Distribute Overframing Loads
Interior Wall Weight [7.000 psf ¥ Adust Dead Load For Pich
Foundation Wall Weight I‘ID.O(]Opd
Non-Framed Wall Weight [10.000 pcf :
| [~ Tributary Area
¥ Combine Trusses Load Waming Max Girder Tributary Width IZM)
Save as Defaults Restore Defaults [
[ ok | cance

FLOOR LOADS

Top Chord/Joist Live — Type the gravity loads for top chord/joist live to be applied to floor members in
psf (pounds per square foot) for Imperial users and kN/m2 (kilonewtons per square meter) for Metric
users.

Top Chord/Joist Dead — Type the gravity loads for top chord/joist dead to be applied to floor members
in psf (pounds per square foot) for Imperial users and kN/m2 (kilonewtons per square meter) for Metric
users.

Bottom Chord Live — Type the gravity loads for bottom chord live to be applied to floor members in psf
(pounds per square foot) for Imperial users and kN/m2 (kilonewtons per square meter) for Metric users.

Bottom Chord Dead — Type the gravity loads for bottom chord dead to be applied to floor members in
psf (pounds per square foot) for Imperial users and kN/m2 (kilonewtons per square meter) for Metric
users.

WALL LOADS

Exterior Wall Weight — Type the exterior wall weights in psf (pounds per square foot) for Imperial users
and kN/m2 (kilonewtons per square meter) for Metric users.

Interior Wall Weight — Type the interior wall weights in psf (pounds per square foot) for Imperial users
and kN/m2 (kilonewtons per square meter) for Metric users.
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Foundation Wall Weight — ???

Non-Framed Wall Weight — Type the non-frame wall weight in pcf (pounds per cubic foot) for Imperial
users and kN/cu m (kilonewtons per cubic meter) for Metric users.

[OTHER]

Combine Trusses Load Warning — Select this box to see a warning in Edit Trusses when you attempt to
combine trusses that have different loads.

ROOF LOADS

Top Chord/Rafter Live — Type the gravity loads for top chord/rafter live to be applied to roof members
in psf (pounds per square foot) for Imperial users and kN/m2 (kilonewtons per square meter) for Metric
users.

Load Case — Select the load case. This affects the percentage of increase in allowable stresses, based on
the length of time that a load is present on a member or series of members. Select from the following
four load cases:

= Live 100%: 10 years - occupancy live load

= Snow 115%: 2 months - snow load

=  Roof 125%: 7 Days - construction load

=  Wind 133%: 1 day - wind or earthquake loads

Top Chord/Rafter Dead — Type the gravity loads for top chord/rafter dead to be applied to roof
members in psf (pounds per square foot) for Imperial users and kN/m2 (kilonewtons per square meter)
for Metric users.

Bottom Chord Live — Type the gravity loads for bottom chord live to be applied to roof members in psf
(pounds per square foot) for Imperial users and kN/m2 (kilonewtons per square meter) for Metric users.

Bottom Chord Dead — Type the gravity loads for bottom chord dead to be applied to roof members in
psf (pounds per square foot) for Imperial users and kN/m2 (kilonewtons per square meter) for Metric
users.

Distribute Overframing Loads — When this checkbox is activated, GS Plan distributes the loads created
by overframing trusses to the framing below. Typically this causes point loads on the trusses below.
When not activated, the application ignores the additional load created by overframing trusses, since
the load is assumed to be covered by the dead load applied to the trusses below.

Adjust Dead Load for Pitch — Typically, dead loads are applied in a projected method which is traditional
and less conservative. Select this box if you want to apply dead loads along the rake, taking into account
the pitch of the roof. This option applies more dead load and is therefore more conservative.

TRIBUTARY AREA

Max Girder Tributary Width -
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COMMAND BUTTONS

Save as Defaults — Click Save as Defaults to store all information on this tab as the default information.
Each time you start a new job, these settings are used.

Restore Defaults — Click Restore Defaults to replace all settings on this tab with the default settings that
you saved previously using Save as Defaults.

OK — Click OK to save the changes.

Cancel — Click Cancel to return to the previous window.
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Framing Members Tab

i
Deflection Crteria | Joist Accessories | Blocking&Rim | MaterialLists | Cutlengths | Colors&line Types | PlotLabels |
" Jblfo | JobSettings | Loadinfo Framing Members | OtherMaterials |  Panel Settings |  Design Settings |
Ful Widh  Flange Width
Roof Tnuss [13~ ~ [o0
Roof TussGrder [13 | [00
HoorTw[T |D.g—
Floor Truss Girder [38~ oo

Blocking Panels
% Place along reference line
" Place pempendicular to joist

Save as Defaults Restore Defaults Designed Products

[ ok ] coca |

Roof Truss Full Width — Type the width of the standard (non-girder) truss material (in inches and
sixteenths of an inch) to be used by default in the roof.

Roof Truss Flange Width —

Roof Truss Girder Full Width — Type the width of the girder truss material (in inches and sixteenths of an
inch) to be used by default in the roof.

Roof Truss Girder Flange Width —

Floor Truss Full Width — Type the width of the standard (non-girder) truss material (in inches and
sixteenths of an inch) to be used by default in the floor.

Floor Truss Flange Width —

Floor Truss Girder Full Width — Type the width of the girder truss material (in inches and sixteenths of
an inch) to be used by default in the floor.

Floor Truss Girder Flange Width —

BLOCKING PANELS

These two radio buttons are used to define how you want blocking panels placed when you draw a line
diagonally through a section of joists.

Place along reference line — When this radio button is selected, blocking panels are placed along the
reference line (so they line up with the diagonal line you draw).
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Place perpendicular to joist — When this radio button is selected, blocking panels are placed
perpendicular to joists.

COMMAND BUTTONS

Save as Defaults — Click Save as Defaults to store all information on this tab as the default information.
Each time you start a new job, these settings are used.

Restore Defaults — Click Restore Defaults to restore (replace) all settings on this tab with the default
settings that you saved previously using the Save as Defaults button.

Designed Products — Click the Designed Products button to access the Product List window and define
the materials you plan to use for the categories listed below. The materials you choose in these
categories will be used in the analysis during member selection.

Floor Beam
Floor Girder
Floor Joist
Roof Beam
Roof Girder

Roof Joist

For more information, see Product List window and Field Descriptions.

OK — Click OK to save the changes.

Cancel — Click Cancel to return to the previous window.
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Other Materials Tab
x

_ Deflection Citeria |  Joist Accessories | Blocking&Rm | Material Liss | Cutlengths | Colors& Line Types |  Plot Labels |
Jobifo | JobSettings | loadifo | Framing Members Other Matedials |  Panel Setings | Design Settings |

Geometric Category I Material Expansion -

Roof SF None

Roof Finished SF None

Roof Plan Area SF None

Exteror Gables SF None -

Ladder Framing LF MNone

Sofft SF None

Soffit Eaves SF None

Sofft Rakes SF None

Fascia LF None

Fascia Eaves LF None

Fascia Rakes LF None

Roof Ridge Fashing LF None

Roof Hip Fashing LF None

Roof Valley Rashing LF None |
ALOF Save As Defauits Restore Defauts |

0K Cancel
| | |

This window allows you to set up expanders to be applied to different geometric categories. Expanders
are set up in the management program and are groups of materials that can be applied to a specific
geometric category. For example, you might set up a Roof expander that contains roof sheathing, roof
felt, and roof shingles. You assign a coverage to each of those materials (for example a 4 x 8 piece of
roof sheathing covers 32 square feet). Then, when that roof expander is applied to a job that has 1000
square feet of roof area, the management program does the math to figure out how much of each of
those roof materials need to be added to the job. Using the 4 x 8 sheathing example, 32 sheets of roof
sheathing material would be added to your materials list since 1000 sq. ft. divided by 32 square feet of
coverage equals 31.25 and that number is rounded up to 32.

WARNING! Expanders must be defined in the management program before they can be assigned on this
window. If you do not set up expanders in the management program, none will be available to select on
this window.

Geometric Category — This list displays all of the geometric categories available. Click on the name of a
category to display all of the available expanders for that category. If the expander (group of materials
that will be applied based on the geometric data) you want to select is not available, you must exit the
application and add the expander in the management program.

Material Expansion — The Material Expansion list will display the expander currently assigned to each of
the geometric categories. Click on the name of an expander to list all of the available expanders for that
category. More information, including a list of the different geometric categories including examples of
how they are calculated, a picture of where the measurement comes from, and an example of an
expander product that might be applied to that geometric data will be coming soon!
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COMMAND BUTTONS

All Off — Click the All Off button to change the material expansion for each geometric category to none.

Save As Defaults — Click Save As Defaults to store all information on this tab as the default information.
Each time you start a new job, these settings will be used.

Restore Defaults — Click Restore Defaults to replace all settings on this tab with the default settings that
you saved previously using Save As Defaults
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Options Tab
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GS Wall Settings Tab

General Info x|

_ Deflection Crteria | Joist Accessores | Blocking&Rm | MatedalLists | Cutlengths | Colors&LineTypes | FlotLabels |
Jobifo | JobSettings | Loadifo | FramingMembers | OtherMatenals | Options ~ GSWal Settings | Design Settings

Rues Fie:
|Basic Steelrul =

[~ Automatic Wall Framing
[V Force Panel Update
[V Show File Open Dialog

Save as Defaults Restore Defaults

Rules File — This field provides a drop-down list of...
Automatic Wall Framing — When this checkbox is activated, GS Plan...
Force Panel Update — When this checkbox is activated, GS Plan...

Show File Open Dialog — When this checkbox is activated, GS Plan...

COMMAND BUTTONS

Save as Defaults — Clicking on the Save as Defaults command button saves the current settings entered
into the GS Wall Settings tab as the user’s default settings.

Restore Defaults — Clicking on the Restore Defaults button...
OK — Clicking on the OK button saves the user’s changes and closes the General Info dialog box.

Cancel — Clicking on the Cancel button discards the user’s changes and closes the General Info dialog
box.
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Design Settings Tab

X
_ Deflection Crteria | Joist Accessories | Blocking4Rm || MateralLits | Cutlengths | Colors & Line Types | Piot Labeis
Jobifo | JobSetngs | Loadifo | FramingMembers | OtherMatedals |  Panel Settings Design Settings
W aximum Member Length IBU ft Deflection Criteria: Increased -
Maximum Alowable Spacing:  [24 ) Buiding Code: [lec/re -]
(Standard Loads on Bearings)
(Non-engineered default spacing)

Alowable Spacings {in)

Roof ~ Floor

(]8.00 - []8.00 -~

V1200 (v12.00 Bracing | Both Top and Bottom =]

¥16.00 (¥)16.00 _

¥119.20 13.20 Material List [Fran-16 -]

24.00 (¥]24.00 Dimensional Fomat

030 = 320 =

EI r':-.-_rrv_..,--_':l ﬂl l"‘.-;-.,g'\.-,_.l ¥ Include non-engineered members in calc sheet output

Ignore Waming M
[ Overhang Load Transfer
Save System Defaults
[ ok ]| Coce |

Maximum Member Length — The maximum length allowable for joist members. If a joist member is
longer than the length entered in this field, you will receive a Constraint message in the Message Log
during Member Placement.

Maximum Allowable Spacing — The maximum allowable spacing for joist members.

ALLOWABLE SPACINGS

There are two columns that contain allowable spacings: one for Roof and one for Floor. The program will
only attempt to design members at spacings that are selected in this area. Additionally, if a selected
spacing is larger than the Maximum Allowable Spacing defined above, it will be ignored.

ROOF
Add -

Remove —

FLOOR
Add -

Remove —
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Deflection Criteria — Select the deflection criteria you wish to use: Minimum, Increased, or Custom. The
deflection criteria for each of these three types are defined on the Deflection Criteria tab.

Building Code — Select the building code you are using to design this structure. This will be displayed on
all output. There are currently nine options to choose from:

= NBC - National Building Code

=  UBC - Uniform Building Code

= SBC - Standard Building Code

=  NBCC/OBC - National Building Code of Canada/Ontario Building Code
= NBCC-2005 — National Building Code of Canada 2005

= NBCC-2010 — National Building Code of Canada 2010

= (OBC-2006 — Ontario Building Code 2006

=  QOther —any other Building Code

= Non Engineered — Loads not applied, no engineering code used

= |BC/IRC - International Building Code / International Residential Code

NOTE: NO LOADS ARE APPLIED to framing members when Non-Engineered is the selected Building Code.
No member calculation reports will be generated and all plots will have a small symbol in the lower left
corner noting that layout has not been engineered.

Bracing —

Material List Dimensional Format — Choose the dimensional output format you wish to see on your
output: feet - inches - 16ths (3-4-8), feet - inches - 8ths (3-4-4), or feet - inches - fractional inches (3’ 4
’yzll).

Include non-engineered members in calc sheet output — There is an option on Print Calc Sheets on the
Structure Commands toolbar which prints all calc sheets for the current level. Check this box to also
output a calc sheet for non-bearing headers during that batch, even though they are non-engineered
members.

IGNORE WARNING MESSAGES

Overhang Load Transfer — Select this box to ignore warning messages for overhang loads that cannot be
transferred to a gable or bearing member during Generate Loads.

COMMAND BUTTONS

Save System Defaults — Click Save System Defaults to store all information on this tab as the default
information. Each time you start a new job, these settings will be used.

OK -

Cancel —
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Deflection Criteria Tab

i
' Joblfo | JobSettings | Loadinfo | FramingMembers | OtherMaterials | PanelSettings | Design Settings |
Deflection Crteria | Joist Accessores | Blocking8Rm | Materallits | Cutlengths | Colors&Line Types | Piot Labeis

Minimums Increased Custom
j [es0 480 80
RER Live v v e
Total u]Z-w L/|240 L[240
o Live v/zs0 L0 e
Totd  Uf2%0 vz /[3%0
Fiat Roof Live UI?.ED U|360 UI?.ED
Total u]2-‘-0 /240 ulzm
Aok Live uiz.‘.o v[240 w360
Total  L/|180 L/|[180 L[240
Maxdimum Live Load Deflection |9.99 in |1 n
Reset System Data | Save as Defauts |
[ ok ] coca |

L/ Values: If necessary, adjust the Live L/ and Total L/ values for each of the three groups of deflection
criteria (Minimum, Increased and Custom). Deflection Criteria are usually represented as a ratio — Span
over Limit (i.e. L/360). The L stands for length of the span. The larger the limit, the smaller amount of
deflection allowed. For example, for a 60 foot member and a limit of 360, the calculation would be 60
ft/360 = .1667 x 12 (to convert it to inches) = 2 inches of maximum deflection.

FLOOR JOIST
LIVE
Minimums -
Increased —
Custom —
TOTAL
Minimums -
Increased —

Custom —

FLOOR BEARING
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LIVE
Minimums —
Increased —
Custom —
TOTAL
Minimums -
Increased —

Custom —

FLAT ROOF
LIVE
Minimums -
Increased —
Custom —
TOTAL
Minimums —
Increased —

Custom —

SLOPED ROOF
LIVE
Minimums -
Increased —
Custom —
TOTAL
Minimums —
Increased —

Custom —

135



Maximum Live Load Deflection — Maximum live load deflection is the maximum distance a member can
move before it fails. Enter the Maximum Live Load Deflection value you wish to use, in inches for
imperial or millimeters for metric. By default, it is set to a high value of 9.99 inches so that absolute
maximum deflection does not control the calculation. You can enter a separate value for the Maximum
Live Load Deflection to be used when you select the Custom Deflection Criteria directly under the
Custom column.

COMMAND BUTTONS

Reset System Data — Click this button to reset the values above to the defaults that were set when you
first installed the software.

Save as Defaults — Click Save as Defaults to store all information on this tab as the default information.
Each time you start a new job, these settings will be used.

OK -

Cancel —
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Joist Accessories Tab

x|
. Joblfo | JobSettings | Loadinfo | FramingMembers | OtherMaterials | PanelSettings | Design Settings |
Deflection Crteia ~ Joist Accessores | Blocking8Rm | MatedalLits | Cutlengths | Colors&Line Types | Piot Labels |
J-For INTBRG B addtem |
|-For INTBRGWLOAD
For CANTWALL
For EXTBRG

+
[+
+
=
B
@-For CANTCLOSURE Move Up
@ For ADJPARALLEL
@-For DIFFDEPTH Move Down
)-For pARALLEL —
@ For ANGLED |
-For SIDERIM
-For MIDSPANBLOCK Delete |
+ Roof Joist Framing
@ For RINTERG =
- For RINTBRGWLOAD —I
- For RCANTWALL
@ For REXTBRG
@ For RCANTCLOSURE |
. FOr MAR IDARALL I
[ ok ] coca |

The main categories in the Joist Accessories tree structure include: Floor Joist Framing, Roof Joist
Framing, and Ceiling Joist Framing. Below each main category are the possible framing conditions. The
table below describes the possible framing conditions that could require joist accessories and the

commands found on the Joist Accessories tab.

NOTE! The names of the conditions below are the names used in the Floor Joist Framing category.
When displayed for the Roof Joist Framing section, the names will start with the letter “R.” The names
in the Ceiling Joist Framing category begin with the letter “C.”

FLOOR JOIST FRAMING

INTBRG (Floor: Interior Bearing) — This framing condition occurs when a
joist runs across a bearing member and is often referred to as mid-span
bearing. This condition is used when there is no load from above being
supported at this location.

INTBRGWLOAD (Floor: Interior Bearing with Load) — This framing condi-

tion is similar to INTBRG, but a load from above is being supported.

CANTWALL (Floor: Cantilever Wall) — This framing condition occurs
whenever the ends of the joists run past the end bearing. This category
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determines how the top of the bearing is framed (NOT the ends of the joists, that is

determined by the CANTCLOSURE category).

EXTBRG (Floor: Exterior Bearing) — This framing condition occurs when
the end of the joists fall on an exterior bearing wall (or beam).

CANTCLOSURE (Floor: Cantilever Closure) — This framing condition occurs
whenever the ends of the joists run past the end bearing. This category
determines how the ends of the joists are framed (NOT the top of the
bearing, that is determined by the CANTWALL category).

ADJPARALLEL (Floor: Adjacent Parallel) — This framing condition occurs
when an area ends at the face of a perpendicular area. This category
determines how the ends of the area should be framed (not the side of
the perpendicular area).

DIFFDEPTH (Floor: Different Depth) — This framing condition occurs when
two areas of different depth end on a common bearing.

PARALLEL (Floor: Parallel) — This framing condition occurs when two areas
of the same depth end on a common bearing.

ANGLED (Floor: Angled) — This framing condition occurs when two areas
meet on a wall, but the areas are neither parallel nor perpendicular to
each other (the members run at some other angle).

SIDERIM (Floor: Side Rim) — This framing condition occurs at the parallel
sides of a framing area (as opposed to the ends).

MIDSPANBLOCK (Floor: Mid-Span Blocking) — This framing condition
occurs in the middle of the span of joists.
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ROOF JOIST FRAMING

RINTBRG (Roof: Interior Bearing) — This framing condition occurs when a joist
runs across a bearing member and is often referred to as mid-span

bearing. This condition is used when there is no load from above being
supported at this location.

RINTBRGWLOAD (Roof: Interior Bearing with Load) — This framing condition is
similar to INTBRG, but a load from above is being supported.

RCANTWALL (Roof: Cantilever Wall) — This framing condition occurs whenever
the ends of the joists run past the end bearing. This category determines

how the top of the bearing is framed (NOT the ends of the joists, that is
determined by the CANTCLOSURE category).

REXTBRG (Roof: Exterior Bearing) — This framing condition occurs when the end
of the joists fall on an exterior bearing wall (or beam).

RCANTCLOSURE (Roof: Cantilever Closure) — This framing condition occurs
whenever the ends of the joists run past the end bearing. This category
determines how the ends of the joists are framed (NOT the top of the
bearing, that is determined by the CANTWALL category).

RADJPARALLEL (Roof: Adjacent Parallel) — This framing condition occurs when an
area ends at the face of a perpendicular area. This category determines

how the ends of the area should be framed (not the side of the

perpendicular area).

RDIFFDEPTH (Roof: Different Depth) — This framing condition occurs when two
areas of different depth end on a common bearing.

RPARALLEL (Roof: Parallel) — This framing condition occurs when two areas of
the same depth end on a common bearing.

RANGLED (Roof: Angled) — This framing condition occurs when two areas meet
on a wall, but the areas are neither parallel nor perpendicular to each
other (the members run at some other angle).

RSIDERIM (Roof: Side Rim) — This framing condition occurs at the parallel sides
of a framing area (as opposed to the ends).

RMIDSPANBLOC (Roof: Mid-Span Blocking) — This framing condition occurs in
the middle of the span of joists.

CEILING JOIST FRAMING

CINTBRG (Ceiling: Interior Bearing) — This framing condition occurs when a joist
runs across a bearing member and is often referred to as mid-span

bearing. This condition is used when there is no load from above being
supported at this location.
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CINTBRGWLOAD (Ceiling: Interior Bearing with Load) — This framing condition is
similar to INTBRG, but a load from above is being supported.

CCANTWALL (Ceiling: Cantilever Wall) — This framing condition occurs whenever
the ends of the joists run past the end bearing. This category determines

how the top of the bearing is framed (NOT the ends of the joists, that is
determined by the CANTCLOSURE category).

CEXTBRG (Ceiling: Exterior Bearing) — This framing condition occurs when the end
of the joists fall on an exterior bearing wall (or beam).

CCANTCLOSURE (Ceiling: Cantilever Closure) — This framing condition occurs
whenever the ends of the joists run past the end bearing. This category
determines how the ends of the joists are framed (NOT the top of the
bearing, that is determined by the CANTWALL category).

CADJPARALLEL (Ceiling: Adjacent Parallel) — This framing condition occurs when an
area ends at the face of a perpendicular area. This category determines

how the ends of the area should be framed (not the side of the

perpendicular area).

CDIFFDEPTH (Ceiling: Different Depth) — This framing condition occurs when two
areas of different depth end on a common bearing.

CPARALLEL (Ceiling: Parallel) — This framing condition occurs when two areas of
the same depth end on a common bearing.

CANGLED (Ceiling: Angled) — This framing condition occurs when two areas meet
on a wall, but the areas are neither parallel nor perpendicular to each
other (the members run at some other angle).

CSIDERIM (Ceiling: Side Rim) — This framing condition occurs at the parallel sides
of a framing area (as opposed to the ends).

CMIDSPANBLOC (Ceiling: Mid-Span Blocking) — This framing condition occurs in

the middle of the span of joists.

COMMAND BUTTONS

Add Item — Click Add Item to add a solution type to the highlighted condition to the left. Click here for
more information about Adding and Editing joist accessory solutions.

Move Up — The program will try the listed solutions based on their order in the list. It tries the first
solution type listed, then the second, then the third, and so on until it finds a solution type that works
for that condition. Highlight an item in the box to the left and then click the Move Up button to move it
up in the list (and therefore have that solution tried earlier in the process).

NOTE: The Nothing type will always work for every condition, so you likely don't want that solution at
the top of the list.

Move Down — The program will try the listed solutions based on their order in the list. It tries the first
solution type listed, then the second, then the third, and so on until it finds a solution type that works
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for that condition. Highlight an item in the box to the left and then click the Move Down button to move
it down in the list (and therefore have that solution tried later in the process).

NOTE: The Nothing type will always work for every condition, so you likely don't want that solution at
the top of the list.

Delete — Click this button to remove the highlighted solution from the list.

Edit — Click this button to edit the highlighted condition. Select a new type, change the material or edit
the properties of the material such as cut length. Click here for more information about Adding and
Editing joist accessory solutions.

OK -

Cancel —
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Blocking & Rim Tab

x
. Joblfo | JobSettings | Loadinfo | FramingMembers | OtherMaterials | Panel Settings | Design Seftings |
Deflection Crteda | Joist Accessories ~ Bocking 8Rm | MatedslLists | Cutlengths | Colors&Line Types | Plotlsbels |
I™ Dont label “typical” blocking [~ Combine fim shorter than: [ it
™ Combine blocking shorter than: [ in ™ Report im as total pieces
I~ Report blocking as total pieces I Ignore Rim Usage
[~ Treat side rim as joist
Rim nesting width: |‘I in
Bloor Joists every: |8 # Minimum ladder length: |0 ft
Boof Joists every: [8 ft Ladder cut length: |U ft
Ceiling Joists every: |2 ft Place ladder starting from: | v|
| 0K I Cancel

BLOCKING SETTINGS

Don't Label "Typical" Blocking — Select this check box if you don't want to label blocking panels that fall
between two joists that are a standard distance apart (12", 16", 19.2" or 24"). Clear this check box to
label every blocking panel on the plot. When you select this option, the Report blocking as total pieces
option will be unavailable.

Combine Blocking Shorter Than — Select this check box to combine all blocking panels shorter than the
specified length into one overall piece. Blocking panels longer than the specified length will be
maintained individually. The length should be entered in decimal inches.

Report Blocking as Total Pieces — Select this box to report blocking as a total number of pieces to the
materials list for plots and output files. The number of pieces will be determined by the total length of
required blocking divided by the cut length you entered for this type of blocking on the Joist Accessories
tab. When you select this option, the Don't label "typical" blocking and Combine blocking shorter than
options will be unavailable.

JOIST RIM SETTINGS

Combine Rim Shorter Than — Select this check box to combine all rim shorter than the length specified
into one overall piece. Rim longer than the specified length will be maintained individually. The length
should be entered in decimal feet. When you select this option, the Report rim as total pieces option will
be unavailable.
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Report Rim as Total Pieces — Select this box to report rim as a total number of pieces to the materials
list for plots and output files. The number of pieces will be determined by the total length of required
rim divided by the cut length you entered for this type of rim on the Joist Accessories tab. When you
select this option, the Combine rim shorter than option will be unavailable.

Ignore Rim Usage — Select this option to ignore the usage of the rim when consolidating pieces. This
results in better consolidation since end rim and side rim might be the same material, for example.

Treat Side Rim as Joist — Select this box to treat the side rim as a joist. This allows the side rim material
to be labeled the same as the joist area on plots.

Rim Nesting Width —

MID-SPAN BLOCKING SETTINGS

Floor Joists Every — Enter a length in feet, for Imperial, or mm, for Metric. Any floor joist area that is
greater than the length specified will receive mid-span blocking.

Roof Joists Every — Enter a length in feet, for Imperial, or mm, for Metric. Any roof joist area that is
greater than the length specified will receive mid-span blocking.

Ceiling Joists Every — Enter a length in feet, for Imperial, or mm, for Metric. Any ceiling joist area that is
greater than the length specified will receive mid-span blocking.

LADDER SETTINGS

Minimum Ladder Length — Enter the minimum distance ladder members should be drawn from the
outside edge of the rim. If the defined Minimum Ladder Length is greater than the distance from the
outside edge of the rim to the first joist member, ladder members will also be placed to the first and
second joists.

Ladder Cut Length — This is the cut length to which the application will consolidate the ladder materials
if the Report Blocking as Total Pieces option is checked above.

Place Ladder Starting From — Choose either Mid span or From End. If you choose Mid span, ladder
members will be placed from the mid-point of the rim and then measured out towards the ends. If you
choose From End, ladder members will be placed the specified Ladder Spacing from the end point of the
rim and then placed at the specified Ladder Spacing along the rim.

COMMAND BUTTONS
OK -

Cancel —
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Material Lists Tab

x
" Joblfo | JobSettings | Loadinfo | FramingMembers | OtherMaterals | PanelSettings | Design Settings |
Deflection Crteria | Joist Accessories | Blocking & Rim Matedal Lists | Cutlengths | Colors&Line Types | Flot Labels |
Al | '
= Aoor Framing Material Add He
J Floor Joists Add Schedule |
R Rim Joists
R Cantilever Rim Joists Add ftem |
= Ceiling Framing Material
C Ceiling Rafters Delete |
C Ceiling Ridge Boards
C Ceiling Beams Edt |
= Roof Framing Material : -
R Stick Rafters Material Table Formatting
R Rafters | |
T Product
R Overframe Rafters I~ Product Name Tz:usz—
= Beam & Ledger Material e 50-54
B Focr Bagiie Consolidation 12005250-54
B Roof Beams Column Format
B Ridge Beams |Type Gty Product Length =l
G Floor Girders (o]
(2 Roof firrdere Ll__:s‘ﬂ-_“"b_'?w
[ ok ] cemce |

This window allows you to configure the material lists shown on your plots by placing types of materials
into different sections and naming those sections.

MATLST — This box lists all the types of members found in the program and where they will be located in
the materials list in the plot program. This box displays a tree of names, the first name being the File
name, the second are the Schedules, and the last are the Items, each of which are described below.

File — (Default is MATLST) This name is what you want the materials list layout to be saved as.
This name must be six or fewer characters with no spaces. To add a file, click Add File. To edit
the file name, select it and click Edit.

Schedules — These are the heading or section names for the material list. These names can be
formatted however you want and there is no limit to how many you can have. To edit a
schedule name, select it and click Edit. To add a New Schedule, click Add Schedule.

Items — Items are types of materials such as floor joists and roof girders. Items should be placed
under the schedule where you want them to appear in the materials list. For example, you may
want a schedule named Headers and you might want to add the roof headers and floor headers
items to that schedule. You cannot control the item names. However, you do have the ability to
control where in the list the item is placed, and what single letter will be used to label that item.

To move an item into another schedule, drag the item name to the appropriate schedule. The
item will be added to the bottom of that schedule’s list. To edit an item, select the item and click
Edit. To remove an item from the materials list, select the item name and click Delete.
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COMMAND BUTTONS

Add File — The file name is what you want the materials list layout to be saved as (the default is
MATLST). Click Add to add a new one. This name must be six or fewer characters with no spaces. To edit
the file name, select it and click Edit.

Add Schedule — Click Add Schedule to add a new heading or section name to your materials list. These
names can be formatted however you choose and there is no limit to how many you can have.

Add Item — Click Add Item to add a new item to a schedule. The items should be placed under the
Schedule as you want them to appear in the materials list. The item names are not user controlled and
are chosen from a pre-defined list. You do, however, have the ability to control where in the list the item
is placed, and what single letter will be used to label that item. If you click Add Item and the item you
wish to add is not in the list, it has most likely already been added to another schedule.

Delete — Click Delete to delete the selected item.

Edit — Click Edit to edit the selected item.

MATERIAL TABLE FORMATTING

Product Name Consolidation — Select Product Name Consolidation if you do NOT want like items to
have their names printed twice. If the product on line 1 matches the product of line 2, line 2 will show
"v" symbols in the product name location to show that the product is the same as the one above. Clear
this check box if you want do not wish to consolidate the product names. The product names will be
listed again even if the product on line 2 is identical to the product on line 1. The display to the right will
change automatically to show you which option is currently selected and how it will affect your
materials list.

Column Format — Choose the order or the columns on the materials list, either: Type, Quantity, Product,
Length (the format specified by NDS) or Type, Quantity, Length, Product.

Subtotal by Product — Select Subtotal by Product to print the subtotaled length under each product type
on the materials list.
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Cut Lengths Tab

X
. Joblfo | JobSettings | Loadinfo | FramingMembers | OtherMaterials | Panel Settings | Design Settings |

Deflection Crteia | Joist Accessores | Blocking8Rm | Materallits  Cutlengths | Colors & Line Types | Piot Labels |

Members will be cut to the nearest length indicated: zero is not a valid cut length.

Glulams |D.0625 i (-1 means nearest foot for <&
" nearest even foot for >8)

Steel Beams ID.[)625 in

LGS |D.0625 in

0K Cancel
| | |

Glulams — Enter what increment, in decimal inches, the program should use when calculating cut
lengths. Type -1 to track materials by the foot for members under eight feet and the nearest two feet
for members eight feet or greater. Type 24 to track materials by the nearest even foot, which is the
typical way that glulams are stocked and shipped. Type 1 to track material to the nearest foot. Type
.0625 (1/16") to report the length to the nearest sixteenth of an inch. This cut length is for any member
added using the Glulam material type.

Steel Beams — Enter what increment, in decimal inches, the program should use when calculating cut
lengths. Since steel beams are usually manufactured to the exact specifications of the plan, leave this at
the default of 0.625. This cut length affects only hot formed steel beams, which are selected from the
Steel product type.

LGS -
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Color & Line Types Tab

Line Types

General Info x|

" Joblfo | JobSettings | Loadinfo | Framing Members i
Deflection Crteria | Joist Accessories | Blocking&Rm | MaterialLists | Cutlengths  Colors&line Types | Plot Labels |

oad Bearing Wals ——
Non-Load Bearing Walls .
Flush Walls
Load Bearing Headers
Non-Load Bearing Headers ———————————————mr
Posts _—
Labels
Roof Planes I
Ceiling Planes @ @ =————— ==
Overhangs e
Roof Beam
Roof Beam by others
Roof Girder
Roof Girder by others
Ridge Beam
Ridge Boards —
Ceiina Ridoe Boards =

Panel Settings |  Design Settings |

LINE TYPES

This is a list of all the different members that can be displayed on plots. To the right of each member
name is a sample of the line being used to draw that member. You can change how these lines look on
your plots by changing the line properties using the fields to the right (colors and line styles).

COLORS

This is the color that will be used when the selected member is drawn in the plot program. If <None> is
selected, then the selected member will not be drawn at all in the plot program. If you are using a pen
plotter (as opposed to laser or ink jet), you will need to set up your pen numbers. The pen number for

each color is listed below:
= Black—PenO
= Blue—Penl
= Green-—Pen?2
= Cyan-Pen3
= Red-Pen4
= Magenta—Pen5
= Brown-Pen6
=  White—Pen?7

= Grey—Pen8

=  Bright Blue—Pen9

=  Bright Green —Pen 10

=  Bright Cyan—Pen 11

= Bright Red — Pen 12

= Bright Magenta — Pen 13
=  Bright Yellow — Pen 14

= Bright White — Pen 15



NOTE! The colors that are used in the plot program may not correspond to the colors of the pens in
your plotter. The displayed colors are only used to differentiate where a different pen will be used.
Also, Pen #0 (Black) cannot be used by many plotters. You should verify that your plotter will plot
with a pen #0 before assigning any members to this pen.

LINE STYLES

The Line Styles list displays all of the line types available. Click a line type to and then select a
style for that type from the list. The selected line type will change to reflect the line style you
selected.

[OTHER]

Thickness — Select the thickness for the selected line type. As you change the size, the size will
change in the Line Types box as well. Thickness is an effective tool for making good quality
plots.
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Plot Labels Tab

i
' Joblfo | JobSettings | Loadinfo | FramingMembers | OtherMaterals | PanelSettings | Design Settings
Deflection Criteria |  Joist Accessories | Blocking&Rim | Material Lists | Cutlengths | Colors&Line Types  Plot Labels
Settings Example Layouts  Label Size
Label Preic | —mog{— Type General [006 Caic ID [0.0625
Label #Stye [T +] (Label)1 # Hanger 004 iy
pmmwww} | I"me’sPlnt:PoHLnadshyLnadee
(. Pass Thu Framing Minimum Point Load [0 bs
Spacing Suffx [ (n) I~ Custom Beam and Girder by Others Labels
|7| 1ude Plies w/Label (Beam and Girder) . | [Be‘:rnbyﬂthe:s IGude.'byElt}-rers
Ply Suffoc
Plot Label Formatting
Joists | Consolidation Label =]
Beams | Consolidation Label =l
Rim | Consolidation Label =l
Blocking | Consolidation Label =l
Hangers | Consolidation Label =l
Posts | Consolidation Label =
[ ok ] coca |
SETTINGS

Label Prefix — Type a one or two character label prefix to be applied to the front of each label on the
plots.

Label # Style — For labels with single digits, you can choose whether to display a leading 0 (zero), for
example 1 or 01.

Include Spacing w/ Label (Joist) —
Spacing Suffix —
Include Plies w/ Label (Beam and Girder) —

Ply Suffix —

PLOT LABEL FORMATTING
Select the member for which you want to format a label.
JOISTS
= Consolidation Label — Product (Qty / Cut Length) —
= Calc Label — Product (Qty / Cut Length) —

Consolidation Label — Select this option to generate a consolidation label for each group of
like materials (same material and length). Fewer consolidation labels are generated than
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BEAMS

RIM

calc labels because the calc labels take into account loading. For example, J3, where all joists
of the same material and length receive the same label. The information that you enter is
displayed in the Preview field.

Calc Label — Select this option to generate a calc label for each group of like materials based
on their material, span, and loading. More calc labels are generated than consolidation
labels because calc labels take into account loading. For example, A2, where all joists of the
same material, length and loading all receive the same label. The information that you enter
is displayed in the Preview field.

Consolidation Label — Product (Plies X Cut Length) — For members that have a number of

plies, such as beams and girders, choose whether to display the plies with label. You can
include the number of plies on the label. The information that you enter is displayed in the
Preview field. Select this option to add cut length to the label format. The information that
you enter is displayed in the Preview field.

Calc Label — Product (Plies X Cut Length) — For members that have a number of plies, such as
beams and girders, choose whether to display the plies with label. You can include the
number of plies on the label. The information that you enter is displayed in the Preview field.
Select this option to add cut length to the label format. The information that you enter is
displayed in the Preview field.

Consolidation Label — Select this option to generate a consolidation label for each group of
like materials (same material and length). Fewer consolidation labels are generated than
calc labels because the calc labels take into account loading. For example, J3, where all joists
of the same material and length receive the same label. The information that you enter is
displayed in the Preview field.

Calc Label — Select this option to generate a calc label for each group of like materials based
on their material, span, and loading. More calc labels are generated than consolidation
labels because calc labels take into account loading. For example, A2, where all joists of the
same material, length and loading all receive the same label. The information that you enter
is displayed in the Preview field.

Product — Select this option to add product descriptions to the label format. The information
that you enter is displayed in the Preview field.

Consolidation Label — Select this option to generate a consolidation label for each group of
like materials (same material and length). Fewer consolidation labels are generated than
calc labels because the calc labels take into account loading. For example, J3, where all joists
of the same material and length receive the same label. The information that you enter is
displayed in the Preview field.

BLOCKING

Product — Select this option to add product descriptions to the label format. The information
that you enter is displayed in the Preview field.

Consolidation Label — Select this option to generate a consolidation label for each group of
like materials (same material and length). Fewer consolidation labels are generated than
calc labels because the calc labels take into account loading. For example, J3, where all joists
of the same material and length receive the same label. The information that you enter is
displayed in the Preview field.
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HANGERS

=  Product — Select this option to add product descriptions to the label format. The information
that you enter is displayed in the Preview field.

= (Consolidation Label — Select this option to generate a consolidation label for each group of
like materials (same material and length). Fewer consolidation labels are generated than
calc labels because the calc labels take into account loading. For example, J3, where all joists
of the same material and length receive the same label. The information that you enter is
displayed in the Preview field.

POSTS

=  Product — Select this option to add product descriptions to the label format. The information
that you enter is displayed in the Preview field.

= (Consolidation Label — Select this option to generate a consolidation label for each group of
like materials (same material and length). Fewer consolidation labels are generated than
calc labels because the calc labels take into account loading. For example, J3, where all joists
of the same material and length receive the same label. The information that you enter is
displayed in the Preview field.

LABEL SIZE

General — Type the label size, in decimal inches, for general labels on the Plot.
Hanger — Type the label size, in decimal inches, for hanger labels on the Plot.
Calc ID — Type the label size, in decimal inches, for Calc ID labels on the Plot.

Framer's Plot: Point Loads by Load Case — Select this option to display point loads (typically posts) on
the Framer's Plot by Load Case. The loads are separated into live, dead, snow, and others. They are
displayed on the Framer's Plot (for example, 137# live, 40# dead, 400# snow). If you are using a
Canadian building code, these loads are un-factored. If you do not select this option, point loads
displayed on the Framer's Plot are the total load (for example, 22004). If you are using a Canadian
building code, the total load is the total factored load.

Pass Thru Framing Minimum Point Load —

Custom Beam and Girder by Others Labels —
= Beam by Others —
= Girder by Others —
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WORKING WITH OPTIONS

Drawing an Option

Drawing option entities is essentially the same procedure as drawing base house entities. You have
access to the same entity types, the same Modify commands, the same Display commands, and the
same Macros as if you were drawing any GS Plan model. The only difference is that, in Draw Option
mode, you cannot alter any existing base house entity.

To underscore this restriction, all base house entities will appear to be shadowed (dark blue color). You
can select a base house entity to check its properties or to trim/extend an option entity to it. You can
also delete it from the option (but not from the base house) by selecting it and pressing Delete. All
other Modify commands will be disabled (grayed out) for the selected base house entity.

Deleting a base house entity from an option is an important concept. Take the example presented
below in Figure X, in which we want to model a simple rectangular house with an optional rectangular
structure to the right.

‘A A
- Il 1
|
|
'B
1C & [

To provide physical access to the option, you should (while drawing the option):

1. Delete the base house wall from A to C.
2. Draw a beam from A to B.

3. Draw a wall fromBto C.

Other option entities are also possible (e.g. a door header in an option wall from A to C), but they all
begin with deletion of the original base house wall.

Other base house entities are handled similarly. For example, suppose you wanted to extend the
framing area (in the level below) to include floor joists beneath the option. You would (while drawing
the option):

1. Delete the base house framing area. (The associated framing members will also disappear.)

2. Draw a new framing area around the base house and the option. (The associated framing
members will then become part of the current option.)

Your model will now have entities on two levels belonging to the same option, a common situation.
Note that both framing areas and their respective framing members will co-exist in the .may file when
you save the job. Thus, base house entities that have been deleted from an option are not really
forgotten, they are just suppressed until you return to the base house.

Using the Modify - Undo command (to reverse the effect of a previous single-entity modification)
acquires special behavior when used in conjunction with options. If you modify an option entity —
including deletion of a base house entity — and then undo the modification, the status quo will be
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restored exactly as if you modified and "undid" a base house entity. However, if you modify the entity
and then restore the base house or switch to a different option, the Undo command will be disabled;
you cannot modify an entity belonging to one option and then recover it in another. To enable the
Undo, you must first return to the option from which the modification took place. Of course, since Undo

only recalls the previous Modify command, any subsequent single-entity modification will preclude
"undoing" the original option modification.

Although you cannot modify a base house entity in Draw Option mode, you can still use it for reference
purposes. As mentioned above, you can select it for use in trimming/extending an option entity. You
can choose a base house entity as the parallel side of an option framing area. You can extend option
planes to base-house planes (but not vice-versa), as illustrated by the following optional front wing:

However, you cannot select a base house framing area or plane for use in constructing a hip end. To
draw the hip roof option pictured in Figure X, you should first delete the two gable roof planes and
framing area belonging to the base house (left). Then draw and extend the three option planes and a
new framing area (over the same region as the base house area). Finally, draw the hip end line. The

result will be a separate set of planes, area, framing members and hip members belonging just to the
hip-end option.

......

Overhang lines belonging to the base house should likewise be deleted and redrawn (as part of the
option), unless they intersect option planes along the same 3D lines. In the previous example, the two
left overhangs belonging to the base house were deleted and a new overhang line drawn for the hip

face plane. The other four base house overhangs retain their original geometry and do not have to be
redrawn.

Dimension lines always belong to the option being drawn. Since dimension lines are not associative, GS
Plan cannot tell whether a dimension line really applies to a particular option; therefore, you should be
careful not to dimension base house entities in Draw Option mode. Base house entities will be visible
while you are drawing option dimensions, but base house dimension lines will not. Indeed, it is not

possible to "delete" a base house dimension line (from a specific option) the way you can "delete" a
base house entity.
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If you need to dimension a plan including two or more options simultaneously, you should extract the
model to a .lay file and create "hybrid" dimension lines from Structure.

Adding a Sub-Option

To add a sub-option, select its parent (the option to which the sub-option will belong) and click on the
Sub-Option button. In this example, assume we want to add the sub-option "Three-Car Garage" under
"Elevation A." After clicking Sub-Option, we have typed "Three-Car Garage" under Select/Enter New
Option, followed by the Add/Modify Option button. The results are depicted in Figure X below.

Note the asterisk now appearing after "New Option #1", x|
denoting that "New Option #1" now has one or more Select/Enter New Option
sub-options. Also note that the sub-option name | Sub-Option #2 Clear Sclection |
New *1*

appears under its parent option, slightly. Sub-Opton £1° Modfy Excde Opton |
We could also continue adding more sub-option names Sub-Option [
by pressing the Clear Selection button (to clear the — |
current selection) and type another Sub-Option name. Excuson) | "Hes sub-optons
The new Sub-Option (Sub-Option #2) is added Sub-Option #2
underneath Sub-Option #1 and also shown as indented.
When you are drawing a Sub-Option, entities belonging
to all higher levels of the current hierarchy will be _

- ) Draw Option | [ RetunToBaseHouse |
displayed in shadow mode. Thus, you can delete

entities from the current Sub-Option, regardless of

which level of the hierarchy they belong to, as long as they are forebears of the current option. In the
previous example, you could delete "New Option #1" entities from "Sub-Option #1", just as you could
delete entities belonging to the base house itself. (In this context we really mean “pseudo-delete”,
because the deleted entities remain as part of the model when visibility of the corresponding parent
option is restored.)

Excluding Options from Each Other

To eliminate the possibility that a novice user might select or extract conflicting options, the Create/Edit
Option dialog box allows you to identify "mutually exclusive" options. From the upper list box, select any
one of the conflicting options. Then in the lower list box [Exclusion(s)], select those options you wish to
exclude. Finally, click on the Modify/Exclude button. Thereafter, in the Select Options dialog box, it will
no longer be possible to select conflicting options.

x|

An example of the Create/Edit Option dialog box, with Select/Enter New Option
mutually excluded options, is shown in Figure X at right. [repace Clear Selection |

C|Osed|—:?|‘,'Ef . .
It is not necessary to exclude options reciprocally. That gEEE;i%W odziem |
is to say, if Option A excludes options B and C, Option B T Sub-Option |
will automatically exclude A and C, and Option C will f:gfi:';“oﬁﬁémm e onn |
automatically exclude A and B. Excuson(s) T sub-options

DR Tray Ceiing -]
To reverse the exclude process, simply re-select one of et
the excluded options in the upper list box and de-select
the other one(s) in the lower list box; then click again on
the Modify/Exclude Option command button. Draw Option [ [ RetunToBaseHouse |
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Do not confuse excluded Options with "excluded base house entities." (i.e. base house entities that
have been deleted from a particular option.) The two concepts have nothing to do with each other.

Using Macros with Options

In general you can use Macro commands (Generate Members, Quick Header, etc.) in Draw Option mode,
just as you can when drawing the base house. (Bearing in mind the usual proviso that base house
entities can be referenced but not modified.) The following paragraphs outline specific rules that apply
to each macro. For the sake of conciseness, "current option" means whatever option currently appears
at the top of the Create/Edit Option dialog box; "base house" refers to base house entities not excluded
(i.e. deleted) from the current option.

1.

10.

Generate Members is restricted to framing areas and hip ends belonging to the current option
(and, of course, on the active level).

Quick Header will only insert headers into walls belonging to the current option. (The reason
base house walls are not eligible is that the insertion process subdivides a wall into two
segments, which would be an implicit modification of a base house entity.)

Move Header will only reposition a header belonging to the current option.

Verify Components will display designated window and door components for headers belonging
to both the base house and the current option, but will only allow modifications to the latter.

Delete Header will only remove headers belonging to the current option.

Extrude Bearings will extrude walls (including header walls) of the current option to planes
belonging either to the base house or to the current option.

Create Planes will create planes around a designated exterior boundary, regardless of whether
boundary lines are comprised of base house or option entities. However, the auto-extend
macros (Extend Single and Extend All) will only pay attention to option planes. Thus, you can
readily create a completely different roof system as an option for the same base house walls.
You can also auto-create a roof system for a separate option structure (such as a detached
garage) without affecting the base house. But if you are simply creating roof planes for a pop-
out (e.g. a bay window option), you are better off drawing and extending them manually.

Ceiling Planes, Skylight and Dormer macros will display "live dimensions" to either base house or
option entities, whichever is closer. Of course the planes, openings, walls, gables and framing
members thereby created will all belong to the current option.

Toggle macros (Load-Bearing, Roof/Floor, Interior/Exterior, Wall/Header Widths) will display
corresponding properties of, and allow modification to, current option entities only. The base
house will be shadowed for reference purposes.

Stick-framing macros (Stick Areas and Ridge Boards) will create rafters or ridge boards for planes
belonging either to the base house or to the current option
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GLOSSARY OF TERMS

B/C Upset — See “Bottom Chord Upset.”
Beam —

Bottom Chord Upset — The distance of the vertical cut at the outside end of
a bottom chord of a truss that is left flat when it is beveled.

Cut Joist —

Dimension Line — A Dimension Line is an annotation that is used to display
the distance between two points. Dimension Lines are saved with the job
and included in Layout Plots generated from GS Plan. Please note that they Beam

will not be included in plots from _

Flush Wall —

Gable — Non-structural trusses that are placed at exposed ends of truss
layouts.

Girder — An element that provides the primary support for loads.

Girder by Others —

Header -

Heel Height — The vertical distance from the wall to the top of the plane.

Ledger -

Overhang — The part of the roof frame that extends past the support

bearings.
Flush Wall
Ridge Board — A non-structural member that is used to keep rafters

aligned.

Seat Cut — The amount of the rafter that sits flat on the bearing when the ceiling plane slopes upward
from the wall. In other words, the flat distance from the outside of the wall to the beginning of the
slope.

Slope — The roof line's degree of incline based on the ratio of its rise to its run.

Snap Point — A snap point is a specified location on the snap grid or at the end of a member to which the
user’s cursor can automatically align.

Strut —
T/C Depth — See “Top Chord Depth.”

Top Chord Depth — The width of the roof framing member used as the top chord in a truss or the width
of the top part of a rafter.

Truss Girder —
Valley — The place where two sloping roof planes meet.

Wall -
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Set Bearing Properties for a Wall
Bearing Type — Wall

Reference Line — All objects drawn in GS Plan are
placed in relation to a Reference Line. Objects can
be rendered on Center of the Reference Line, or to its
Right or Left.

Beg. Height — This field defines the height of your
new wall at its starting point.

Flat Btm. —

End Height — This field defines the height of your
new wall at its end point.

Flat Btm. —

# Plies — This field is disabled when Wall is selected
as the Bearing Type.

Ply Width — The Ply Width field defines the thickness

Setbearngproperties i
Bearing Type: Reference Line:
C Left € Center = Right

Girder

Beam Beg. Height: IT Flat Btm. I
Header

Truss Girder End Height: IQ-D-O Flat Btm. |
Girder By Others .

Beam By Others # Plies: | 1

Flush wall X

Cut Joist Ply width: [ 3-8

Ridge Board —

Ledger Wb Depth: [0

Strut Product: [ No Product Assigned

Location: (" Interior %' Exterior
I™ Continuous tabel: |
I™ Field-Framed ™ Floor
[~ Nen-oad bearing
[™ Bears on Earth
Wal Type IFramed 'l

of a single ply of material used for construction. For walls, this is the width of the plate.

Mbr Depth — This field is disabled when Wall is selected as the Bearing Type.

Product — This is a read-only field that displays the specific material, if any, that has been designated for

use in the construction of your wall.

Location — The Location field designates your wall as existing on the Interior or Exterior of the structure.
This classification effects the framing rules that will be applied to the wall’s construction.

Label — This field is disabled when Wall is selected as the Bearing Type.

Continuous — When the Continuous checkbox is activated, GS Plan will use the properties within this
dialog box, as currently defined, for each subsequent Wall that is created. The user will not be
prompted to define the properties again for additional walls.

Field-Framed — This field is disabled when Wall is selected as the Bearing Type.

Floor — When the Floor checkbox is activated, the wall being defined is designated as supporting floor-

framing members.

Non-Load Bearing — When this checkbox is activated, the Wall is treated by GS Plan as non-structural.

Bears on Earth — When this checkbox is activated, the Wall (whose properties are being defined within
this dialog box) serves as the ultimate and final destination for all loads applied to it. No loads are

transferred to bearings beneath this wall.

Wall Type — As the name implies, the Wall Type field identifies the kind of wall being defined. There are

three options: Framed, Foundation, and Non-Framed.
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OK — If you are creating a new bearing, clicking on the OK button will place the new bearing in accord
with the properties defined in this dialog box. If you are modifying the properties of an existing bearing,
clicking on the OK button will apply your changes and close the Set Bearing Properties dialog box.

Delete/Cancel — If you are creating a new bearing, clicking on the Delete button will close the Set
Bearing Properties dialog box and return you to the main window without placing your bearing. If you
are modifying the properties of an existing bearing, this button will read Cancel rather than Delete.
Clicking on the Cancel button will discard your changes and close the Set Bearing Properties dialog box.

Reserved — This command button is disabled when Wall is selected as the Bearing Type.

Products — This command button is disabled when Wall is selected as the Bearing Type.

Set Bearing Properties for a Girder

Bearing Type — Girder x
Reference Line — All objects drawn in GS Plan are HEEEEEE -~ -~ .-
placed in relation to a Reference Line. Objects can _ < e _ o
be rendered on Center of the Reference Line, or to its Beg. Heoht: | _
ight: [0-0-0
Right or Left. E"“""‘_*
= Ples: |1—

Beg. Height — This field is disabled when Girder is =

Mbr Depth: I 12-0

selected as the Bearing Type.

Product: | No Product Assigned

Flat Btm. — This command button is disabled when

Girder is selected as the Bearing Type. s Eecl
glyp I contruos tabel: [

End Height — This field is disabled when Girder is I Fid Frgmed e l': et

selected as the Bearing Type. L N = e

Flat Btm. — This command button is disabled when

Girder is selected as the Bearing Type. [ ] Delete Reserved Products

# Plies — This field defines the number of plies of

material to be used in the construction of your
girder.

Ply Width — The Ply Width field defines the thickness of a single ply of the material that will be used to
construct your girder.

Mbr Depth — The Member Depth field is used to specify the depth dimension of the girder
being defined. (See the figure at right.)

Product — This is a read-only field that displays the specific material, if any, that has Member Depth
been designated for use in the construction of your girder.

Location — The Location radio buttons are disabled when Girder is selected as the Bearing Type.
Label -

Continuous — When the Continuous checkbox is activated, GS Plan will use the properties within this
dialog box, as currently defined, for each subsequent Girder that is created. The user will not be
prompted to define the properties again for additional girders.
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Field-Framed — When the Field-Framed checkbox is activated, the girder being defined will not appear
on individual panel plots and will not be included in the materials lists for those plots.

Ledgered — If the Ledgered checkbox is activated, GS Plan permits framing members to hang from the
side of the girder, rather than having to be supported by the top of the girder.

Define Posts —

Floor — When the Floor checkbox is activated, the girder being defined is designated as supporting floor-
framing members.

Non-Load Bearing — This field is disabled when Girder is selected as the Bearing Type.
Bears on Earth — This field is disabled when Girder is selected as the Bearing Type.

OK — If you are creating a new bearing, clicking on the OK button will place the new bearing in accord
with the properties defined in this dialog box. If you are modifying the properties of an existing bearing,
clicking on the OK button will apply your changes and close the Set Bearing Properties dialog box.

Delete/Cancel - If you are creating a new bearing, clicking on the Delete button will close the Set
Bearing Properties dialog box and return you to the main window without placing your bearing. If you
are modifying the properties of an existing bearing, this button will read Cancel rather than Delete.
Clicking on the Cancel button will discard your changes and close the Set Bearing Properties dialog box.

Reserved — This command button is disabled when Girder is selected as the Bearing Type.

Products — Clicking on the Products command button will open a PST Product Priority dialog box, which
can be used to add to, or modify, the list of materials available for use in the construction of your girder.
For more information about the features and functions of the PST Product Priority dialog box, see the
section within this document entitled “Defining Product Priorities.”

Set Bearing Properties for a Beam

Bearing Type — Beam

ﬂ

Reference Line — All objects drawn in GS Plan are R
placed in relation to a Reference Line. Objects can Clleft € Center  Right
be rendered on Center of the Reference Line, or to Beg.Height: [0:00
its Right or Left. EndHeight: [000

sohes: [T
Beg. Height — This field is disabled when Beam is plywidth: [38
selected as the Bearing Type. MbrDepth: [120

Product: | No Product Assigned

Flat Btm. — This command button is disabled when

Beam is selected as the Bearing Type. Locaon: € Inferior Exterior
™ Continuous Label: l—

End Height — This field is disabled when Beam is I Field-Framed I Floor

selected as the Bearing Type. I~ Define Posts :: e Dearhy

Flat Btm. — This command button is disabled when
Beam is selected as the Bearing Type.

OK I Delete Beam Type Products

# Plies — This field defines the number of plies of

material to be used in the construction of your
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beam.

Ply Width — The Ply Width field defines the thickness of a single ply of the material that
will be used to construct your beam.

Mbr Depth — The Member Depth field is used to specify the depth dimension of the beam
being defined. (See the figure at right.)

.. . . o Lo Member Depth
Product — This is a read-only field that displays the specific material, if any, that has

been designated for use in the construction of your beam.
Location — The Location radio buttons are disabled when Girder is selected as the Bearing Type.

Label —

Continuous — When the Continuous checkbox is activated, GS Plan will use the properties within this
dialog box, as currently defined, for each subsequent Beam that is created. The user will not be
prompted to define the properties again for additional beams.

Field-Framed — When the Field-Framed checkbox is activated, the beam being defined will not appear
on individual panel plots and will not be included in the materials lists for those plots.

Define Posts —

Floor — When the Floor checkbox is activated, the beam being defined is designated as supporting floor-
framing members.

Non-Load Bearing — This field is disabled when Girder is selected as the Bearing Type.
Bears on Earth — This field is disabled when Girder is selected as the Bearing Type.

OK — If you are creating a new bearing, clicking on the OK button will place the new bearing in accord
with the properties defined in this dialog box. If you are modifying the properties of an existing bearing,
clicking on the OK button will apply your changes and close the Set Bearing Properties dialog box.

Delete/Cancel — If you are creating a new bearing, clicking on the Delete button will close the Set
Bearing Properties dialog box and return you to the main window without placing your bearing. If you
are modifying the properties of an existing bearing, this button will read Cancel rather than Delete.
Clicking on the Cancel button will discard your changes and close the Set

Bearing Properties dialog box. x|
Beam Type — Clicking on the Beam Type command button will open a Set & Normal Beam

Beam Properties dialog box like the one pictured at right. Use this dialog L=

box to designate the beam as one of the following:

= Normal Beam — When Normal Beam is selected, the beam will
extend down from the top of plate height and support framing members from below.

= Ridge Beam — When Ridge Beam is selected, the beam will extend down from the roof plane
that it is placed below, to support framing members from below.

Products — Clicking on the Products command button will open a PST Product Priority dialog box, which
can be used to add to, or modify, the list of materials available for use in the construction of your beam.
For more information about the features and functions of the PST Product Priority dialog box, see the
section within this document entitled “Defining Product Priorities.”
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Set Bearing Properties for a Header

Bearing Type — eader %
Reference Line — All objects drawn in GS Plan are Reference Line:
placed in relation to a Reference Line. Objects can Lt o R
be rendered on Center of the Reference Line, or to Beg. *"f"“= 500 PR
its Right or Left. Endrieghe [500 SEDeTa|
= Plies: I—
Beg. Height — This field defines the height of your Ply width: [ 55
Mbr Depth: I 0-0

new header at its starting point.

Product: |NoPdectAWQ'Ed

Flat Btm. -

Location: (" Interior (¥ Exterior

End Height — This field defines the height of your I Continuous Label: [

new header at its end point. Fisiframes L _
™ Nen-oad bearing

I= [Benez on Enrt

Wall Type |Framed "I
[ ] Delete HeaderInfo | Products |

Flat Btm. -

# Plies — This field is disabled when Header is
selected as the Bearing Type.

Ply Width — The Ply Width field defines the thickness
of a single ply of the material that will be used to construct your header.

Mbr Depth — This field is disabled when Header is selected as the Bearing Type.

Product — This is a read-only field that displays the specific material, if any, that has been designated for
use in the construction of your header.

Location — The Location field designates your header as existing on the Interior or Exterior of the
structure. This classification effects the framing rules that will be applied to the header’s construction.

Label — This field is disabled when Header is selected as the Bearing Type.

Continuous — When the Continuous checkbox is activated, GS Plan will use the properties within this
dialog box, as currently defined, for each subsequent Header that is created. The user will not be
prompted to define the properties again for additional headers.

Field-Framed — This field is disabled when Header is selected as the Bearing Type.

Floor — When the Floor checkbox is activated, the header being defined is designated as supporting
floor-framing members.

Non-Load Bearing — When this checkbox is activated, the Header is treated by GS Plan as non-structural.
Bears on Earth — This field is disabled when Girder is selected as the Bearing Type.

Wall Type — As the name implies, the Wall Type field identifies the kind of wall in which the header
being defined will be placed. There are three options: Framed, Foundation, and Non-Framed.

OK — If you are creating a new bearing, clicking on the OK button will place the new bearing in accord
with the properties defined in this dialog box. If you are modifying the properties of an existing bearing,
clicking on the OK button will apply your changes and close the Set Bearing Properties dialog box.
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Delete/Cancel - If you are creating a new bearing, clicking on the Delete button will close the Set
Bearing Properties dialog box and return you to the main window without placing your bearing. If you
are modifying the properties of an existing bearing, this button will read Cancel rather than Delete.
Clicking on the Cancel button will discard your changes and close the Set Bearing Properties dialog box.

Header Info — Clicking on the Header Info
command button will open a Define
Component dialog box, like the one pictured
at right. For more information about the
features and functions associated with this
dialog box, see “Defining Component
Properties” on page .

Products — Clicking on the Products
command button will open a PST Product
Priority dialog box, which can be used to
add to, or modify, the list of materials
available for use in the construction of your
header. For more information about the
features and functions of the PST Product
Priority dialog box, see the section within

this document entitled “Defining Product
Priorities.”

Set Bearing Properties for a Truss Girder

Bearing Type — Truss Girder

Reference Line — All objects drawn in GS Plan are
placed in relation to a Reference Line. Objects can
be rendered on Center of the Reference Line, or to
its Right or Left.

Beg. Height — This field is disabled when Truss Girder
is selected as the Bearing Type.

Flat Btm. — This field is disabled when Truss Girder is
selected as the Bearing Type.

End Height — This field is disabled when Truss Girder
is selected as the Bearing Type.

Flat Btm. — This field is disabled when Truss Girder is
selected as the Bearing Type.

# Plies — This field defines the number of plies of
material to be used in the construction of your truss
girder.

x
Component Type: (* Window
" Door
Component Part =: | Set Component |
R.O. Size{wd x ht): |22-O-0 x |2-6-0 Set Comp. Assy. |
Header Depth: |94 Unset Comp. |
Header Height: |6-3-0
Left Min. Bearing: |16 No. Trimmers: | -1
Right Min. Bearing: I 18 No. King Studs: I -1
Trim Width: |30 No.u;perﬂs:l-l
No. Plies: |
Product: | No Product Assigned
Door Side: ? :.u Save As Defaults |
oK | Cancel products |
x
Bearing Type: Reference Line:
CLeft € Center = Right
Beg. Height: | 0-0-0
End Height: | 0-0-0
Girder By Others
Beam By Others # Plies: | 1
Flush Wal
Cut Joist Ply width: [ 18
Ridge Board B
Ledger Mbr Depth: |

Product: | No Product Assigned

Location: € [nterior & Exterior
I~ Continuous Label: |
r Field-Framed I Ledgered r Floor
I_ I 0 “ing
OK I Delete

Ply Width — The Ply Width field defines the thickness of a single ply of the material that will be used to

construct your truss girder.
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Mbr Depth — This field is disabled when Truss Girder is selected as the Bearing Type.

Product — This is a read-only field that displays the specific material, if any, that has been designated for
use in the construction of your truss girder.

Location — The Location radio buttons are disabled when Truss Girder is selected as the Bearing Type.
Label — This field is disabled when Header is selected as the Bearing Type.

Continuous — When the Continuous checkbox is activated, GS Plan will use the properties within this
dialog box, as currently defined, for each subsequent Truss Girder that is created. The user will not be
prompted to define the properties again for additional truss girders.

Field-Framed — When the Field-Framed checkbox is activated, the truss girder being defined will not
appear on individual panel plots and will not be included in the materials lists for those plots.

Ledgered — If the Ledgered checkbox is activated, GS Plan permits framing members to hang from the
side of the truss girder, rather than having to be supported by the top of the girder.

Floor — When the Floor checkbox is activated, the truss girder being defined is designated as supporting
floor-framing members.

Non-Load Bearing — This field is disabled when Truss Girder is selected as the Bearing Type.
Bears on Earth — This field is disabled when Truss Girder is selected as the Bearing Type.

OK — If you are creating a new bearing, clicking on the OK button will place the new bearing in accord
with the properties defined in this dialog box. If you are modifying the properties of an existing bearing,
clicking on the OK button will apply your changes and close the Set Bearing Properties dialog box.

Delete/Cancel - If you are creating a new bearing, clicking on the Delete button will close the Set
Bearing Properties dialog box and return you to the main window without placing your bearing. If you
are modifying the properties of an existing bearing, this button will read Cancel rather than Delete.
Clicking on the Cancel button will discard your changes and close the Set Bearing Properties dialog box.

Reserved — This command button is disabled when Truss Girder is selected as the Bearing Type.

Products — This command button is disabled when Truss Girder is selected as the Bearing Type.

Set Bearing Properties for a ‘Girder

by Others’ x
Bearing Type: Reference Line:
Bearing Type — Girder by Others el C et Center & Right
Girder
Reference Line — All objects drawn in GS Plan are ;iilé ) 2::: |—| —
placed in relation to a Reference Line. Objects can be . Ili e
rendered on Center of the Reference Line, or to its . Pywdt: [35
Right or Left. lag;;' Board e
Strut Product: [No Product Assigned
Beg. Height — This field is disabled when Girder by
Others is selected as the Bearing Type. Location: €™ Tnterior & Exterior
e 4 . ™ Continuous Labet: |
Flat Btm. — This field is disabled when Girder by [ Fiekd-Framed I i | Boor
Others is selected as the Bearing Type. [ Defeposts T
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End Height — This field is disabled when Girder by Others is selected as the Bearing Type.
Flat Btm. — This field is disabled when Girder by Others is selected as the Bearing Type.

# Plies — This field defines the number of plies of material to be used in the construction of a ‘Girder by
Others.’

Ply Width — The Ply Width field defines the thickness of a single ply of the material that will be used to
construct a ‘Girder by Others.

Mbr Depth — The Member Depth field is used to specify the depth dimension of the
‘Girder by Others’ being defined. (See the figure at right.)

Product — This is a read-only field that displays the specific material, if any, that has Member Depth
been designated for use in the construction of your ‘Girder by Others.’

Location — The Location radio buttons are disabled when Girder by Others is selected as the Bearing
Type.

Label — This field is disabled when Girder by Others is selected as the Bearing Type.

Continuous — When the Continuous checkbox is activated, GS Plan will use the properties within this
dialog box, as currently defined, for each subsequent Girder by Others that is created. The user will not
be prompted to define the properties again for additional girders by others.

Field-Framed — When the Field-Framed checkbox is activated, the girder being defined will not appear
on individual panel plots and will not be included in the materials lists for those plots.

Ledgered — If the Ledgered checkbox is activated, GS Plan permits framing members to hang from the
side of the girder, rather than having to be supported by the top of the girder.

Define Posts —

Floor — When the Floor checkbox is activated, the ‘Girder by Others’ being defined is designated as
supporting floor-framing members.

Non-Load Bearing — This field is disabled when Girder by Others is selected as the Bearing Type.
Bears on Earth — This field is disabled when Girder by Others is selected as the Bearing Type.

OK — If you are creating a new bearing, clicking on the OK button will place the new bearing in accord
with the properties defined in this dialog box. If you are modifying the properties of an existing bearing,
clicking on the OK button will apply your changes and close the Set Bearing Properties dialog box.

Delete/Cancel - If you are creating a new bearing, clicking on the Delete button will close the Set
Bearing Properties dialog box and return you to the main window without placing your bearing. If you
are modifying the properties of an existing bearing, this button will read Cancel rather than Delete.
Clicking on the Cancel button will discard your changes and close the Set Bearing Properties dialog box.

Reserved — This command button is disabled when Girder by Others is selected as the Bearing Type.

Products — This command button is disabled when Girder by Others is selected as the Bearing Type.

Set Bearing Properties for a ‘Beam by Others’
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Bearing Type — Beam by Others
X

Reference Line:
Cleft  © Center  Right

Beg.Height: [000 Fiat Btm |

Reference Line — All objects drawn in GS Plan are
placed in relation to a Reference Line. Objects can
be rendered on Center of the Reference Line, or to

its Right or Left. Edbeht: [750 _ ren |
= Plies: I

Beg. Height — This field is disabled when Beam by — I;S—

Others is selected as the Bearing Type. m;pm: =

Flat Btm. — This field is disabled when Beam by
Others is selected as the Bearing Type.

Location: € Interior )
- abel: I
End Height — This field is disabled when Beam by ::i:"ﬂ"::‘:ﬂ : ==
Others is selected as the Bearing Type. TR N
I™ ee
Flat Btm. — This field is disabled when Beam by
Others is selected as the Bearing Type.
| OK I Delete

# Plies — This field defines the number of plies of
material to be used in the construction of a ‘Beam
by Others.’

Ply Width — The Ply Width field defines the thickness of a single ply of the material that will be used to
construct a ‘Beam by Others.’

Mbr Depth — The Member Depth field is used to specify the depth dimension of the ‘Beam
by Others’ being defined. (See the figure at right.)

Product — This is a read-only field that displays the specific material, if any, that has Member Depth
been designated for use in the construction of your ‘Beam by Others.’

Location — The Location radio buttons are disabled when Beam by Others is selected as the Bearing
Type.

Label — This field is disabled when Girder by Others is selected as the Bearing Type.

Continuous — When the Continuous checkbox is activated, GS Plan will use the properties within this
dialog box, as currently defined, for each subsequent Beam by Others that is created. The user will not
be prompted to define the properties again for additional beams by others.

Field-Framed — When the Field-Framed checkbox is activated, the beam being defined will not appear
on individual panel plots and will not be included in the materials lists for those plots.

Define Posts —

Floor — When the Floor checkbox is activated, the ‘Beam by Others’ being defined is designated as
supporting floor-framing members.

Non-Load Bearing — This field is disabled when Beam by Others is selected as the Bearing Type.

Bears on Earth — This field is disabled when Beam by Others is selected as the Bearing Type.
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OK — If you are creating a new bearing, clicking on the OK button will place the new bearing in accord
with the properties defined in this dialog box. If you are modifying the properties of an existing bearing,
clicking on the OK button will apply your changes and close the Set Bearing Properties dialog box.

Delete/Cancel — If you are creating a new bearing, clicking on the Delete button will close the Set
Bearing Properties dialog box and return you to the main window without placing your bearing. If you
are modifying the properties of an existing bearing, this button will read Cancel rather than Delete.
Clicking on the Cancel button will discard your changes and close the Set Bearing Properties dialog box.

Reserved — This command button is disabled when Beam by Others is selected as the Bearing Type.

Products — This command button is disabled when Beam by Others is selected as the Bearing Type.

Set Bearing Properties for a Flush Wall

Bearing Type — Flush Wall x
Bearing Type: Reference Line:
Wal C Left € Center * Right

Beam Beg. Height: [9-0-0 Flat Btm.

Header

Truss Girder End Height: I 9-0-0 Flat Btm.

Reference Line — All objects drawn in GS Plan are
placed in relation to a Reference Line. Objects can
be rendered on Center of the Reference Line, or to its
Right or Left.

Beam By Others = ples: [
Beg. Height — This field defines the height of your o Board s B
H ; : Ledger Mbr Depth: [ 12:0
new flush wall at its starting point. Strut Product: [ .
Flat Btm. - . _ .
Location: (" Interior (% Exterior
End Height — This field defines the height of your If: CEIED) Labat | —
new flush wall at its end point. - = Norfoed bearing
I” Bears on Earth
Flat Btm. - Wal Type [Framed 7]
# Plies — This field is disabled when Flush Wall is x| e eserved | products |

selected as the Bearing Type.

Ply Width — The Ply Width field defines the thickness
of a single ply of the material that will be used to construct your flush wall.

Mbr Depth — The Member Depth field is used to specify the depth dimension of the flush
wall being defined. (See the figure at right.)

Product — This is a read-only field that displays the specific material, if any, that has Member Depth
been designated for use in the construction of your flush wall.

Location — The Location field designates your flush wall as existing on the Interior or Exterior of the
structure. This classification effects the framing rules that will be applied to the flush wall’s
construction.

Label — This field is disabled when Flush Wall is selected as the Bearing Type.

Continuous — When the Continuous checkbox is activated, GS Plan will use the properties within this
dialog box, as currently defined, for each subsequent Flush Wall that is created. The user will not be
prompted to define the properties again for additional flush walls.
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Field-Framed — This field is disabled when Flush Wall is selected as the Bearing Type.

Floor — When the Floor checkbox is activated, the flush wall being defined is designated as supporting
floor-framing members.

Non-Load Bearing — This field is disabled when Flush Wall is selected as the Bearing Type.

Bears on Earth — When this checkbox is activated, the Flush Wall (whose properties are being defined
within this dialog box) serves as the ultimate and final destination for all loads applied to it. No loads
are transferred to bearings beneath this wall.

Wall Type — As the name implies, the Wall Type field identifies the kind of flush wall being defined.
There are three options: Framed, Foundation, and Non-Framed.

OK — If you are creating a new bearing, clicking on the OK button will place the new bearing in accord
with the properties defined in this dialog box. If you are modifying the properties of an existing bearing,
clicking on the OK button will apply your changes and close the Set Bearing Properties dialog box.

Delete/Cancel — If you are creating a new bearing, clicking on the Delete button will close the Set
Bearing Properties dialog box and return you to the main window without placing your bearing. If you
are modifying the properties of an existing bearing, this button will read Cancel rather than Delete.
Clicking on the Cancel button will discard your changes and close the Set Bearing Properties dialog box.

Reserved — This command button is disabled when Flush Wall is selected as the Bearing Type.

Products — This command button is disabled when Flush Wall is selected as the Bearing Type.

Set Bearing Properties for a Cut Joist

Bearing Type = Cut Joist T S— E
Reference Line — All objects drawn in GS Plan are Bearing Type: Reference Line:
placed in relation to a Reference Line. Objects can = Pyl v i
be rendered on Center of the Reference Line, or to its et Beg. Heght: [0:00
Right or Left. Crder By Cters i
Ble:': By ltljthers # lies: | 1
Flush Wal -
Beg. Height — This field is disabled when Cut Joist is W Ply Widh |
selected as the Bearing Type. Ledger M Depth: [
Strut Product: [ No Product Assigned
Flat Btm. — This command button is disabled when
Cut Joist is selected as the Bearing Type. SR (Dl Ok
I Continuous Label: l—
End Height — This field is disabled when Cut Joist is L ke F Boor
selected as the Bearing Type. [ foore oot
Flat Btm. — This command button is disabled when
Cut Joist is selected as the Bearing Type. [ ok | e

# Plies — This field is disabled when Cut Joist is

selected as the Bearing Type.
Ply Width — This field is disabled when Cut Joist is selected as the Bearing Type.

Mbr Depth — This field is disabled when Cut Joist is selected as the Bearing Type.
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Product — This is a read-only field that displays the specific material, if any, that has been designated for
use in the construction of your cut joist.

Location — The Location radio buttons are disabled when Cut Joist is selected as the Bearing Type.
Label — This field is disabled when Cut Joist is selected as the Bearing Type.

Continuous — When the Continuous checkbox is activated, GS Plan will use the properties within this
dialog box, as currently defined, for each subsequent Cut Joist that is created. The user will not be
prompted to define the properties again for additional cut joists.

Field-Framed — This field is disabled when Cut Joist is selected as the Bearing Type.

Floor — When the Floor checkbox is activated, the cut joist being defined is designated as supporting
floor-framing members.

Non-Load Bearing — This field is disabled when Cut Joist is selected as the Bearing Type.
Bears on Earth — This field is disabled when Cut Joist is selected as the Bearing Type.

OK — If you are creating a new bearing, clicking on the OK button will place the new bearing in accord
with the properties defined in this dialog box. If you are modifying the properties of an existing bearing,
clicking on the OK button will apply your changes and close the Set Bearing Properties dialog box.

Delete/Cancel - If you are creating a new bearing, clicking on the Delete button will close the Set
Bearing Properties dialog box and return you to the main window without placing your bearing. If you
are modifying the properties of an existing bearing, this button will read Cancel rather than Delete.
Clicking on the Cancel button will discard your changes and close the Set Bearing Properties dialog box.

Reserved — This command button is disabled when Cut Joist is selected as the Bearing Type.

Products — This command button is disabled when Cut Joist is selected as the Bearing Type.

Set Bearing Properties for a Ridge Board

Bearing Type — Ridge Board

xq
Reference Line — All objects drawn in GS Plan are R ——
placed in relation to a Reference Line. Objects can
be rendered on Center of the Reference Line, or to

its Right or Left.

 Left " Center  Right

e - F—
Beg. Height — This field is disabled when Ridge Board e Pywdth: [33
is selected as the Bearing Type. ;

Flat Btm. — This command button is disabled when

Ridge Board is selected as the Bearing Type. locaton: ¢ Interior @ Exterior
. ™ Continuous Label: I

End Height — This field is disabled when Ridge Board I Field-Framed I Eloor

is selected as the Bearing Type. IE ke

Flat Btm. — This command button is disabled when

Ridge Board is selected as the Bearing Type. o] — —
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# Plies — This field defines the number of plies of material to be used in the construction of your ridge
board.

Ply Width — The Ply Width field defines the thickness of a single ply of the material that will be used to
construct your ridge board.

Mbr Depth — The Member Depth field is used to specify the depth dimension of the ridge
board being defined. (See the figure at right.)

Product — This is a read-only field that displays the specific material, if any, that has Member Depth
been designated for use in the construction of your ridge board.

Location — The Location field designates your ridge board as existing on the Interior or Exterior of the
structure. This classification effects the framing rules that will be applied to the ridge board’s
construction.

Label — This field is disabled when Flush Wall is selected as the Bearing Type.

Continuous — When the Continuous checkbox is activated, GS Plan will use the properties within this
dialog box, as currently defined, for each subsequent Ridge Board that is created. The user will not be
prompted to define the properties again for additional ridge boards.

Field-Framed — This field is disabled when Ridge Board is selected as the Bearing Type.
Floor — This field is disabled when Ridge Board is selected as the Bearing Type.

Non-Load Bearing — This field is disabled when Ridge Board is selected as the Bearing Type.
Bears on Earth — This field is disabled when Ridge Board is selected as the Bearing Type.

OK — If you are creating a new bearing, clicking on the OK button will place the new bearing in accord
with the properties defined in this dialog box. If you are modifying the properties of an existing bearing,
clicking on the OK button will apply your changes and close the Set Bearing Properties dialog box.

Delete/Cancel - If you are creating a new bearing, clicking on the Delete button will close the Set
Bearing Properties dialog box and return you to the main window without placing your bearing. If you
are modifying the properties of an existing bearing, this button will read Cancel rather than Delete.
Clicking on the Cancel button will discard your changes and close the Set Bearing Properties dialog box.

Reserved — This command button is disabled when Ridge Board is selected as the Bearing Type.

Products — Clicking on the Products command x|
button will open a PST Product Priority dialog box,

Reference Line:
which can be used to add to, or modify, the list of € Left € Center © Right
materials available for use in the construction of Beg.Height: [000
your ridge board. For more information about the EndHeght: [000
features and functions of the PST Product Priority #ples:[y
dialog box, see the section within this document Fly Wdth: | 3.8
Mbr Depth: ,12-0—

entitled “Defining Product Priorities.”

Product: | No Product Assigned

Set Bearing Properties for a Ledger Lomtion | Clineizy Flegeny
g p f g ™ Continuous Label: [—
Bearing Type — Ledger I cidfrmed r':Ek’“
J= [Be5rs
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Reference Line — All objects drawn in GS Plan are placed in relation to a Reference Line. Objects can be
rendered on Center of the Reference Line, or to its Right or Left.

Beg. Height — This field is disabled when Ledger is selected as the Bearing Type.

Flat Btm. — This command button is disabled when Ledger is selected as the Bearing Type.

End Height — This field is disabled when Ledger is selected as the Bearing Type.

Flat Btm. — This command button is disabled when Ledger is selected as the Bearing Type.

# Plies — This field defines the number of plies of material to be used in the construction of your ledger.

Ply Width — The Ply Width field defines the thickness of a single ply of the material that will be used to
construct your ledger.

Mbr Depth — The Member Depth field is used to specify the depth dimension of the ledger
being defined. (See the figure at right.)

Product — This is a read-only field that displays the specific material, if any, that has Member Depth
been designated for use in the construction of your ledger.

Location — This field is disabled when Ledger is selected as the Bearing Type.
Label — This field is disabled when Ledger is selected as the Bearing Type.

Continuous — When the Continuous checkbox is activated, GS Plan will use the properties within this
dialog box, as currently defined, for each subsequent Ledger that is created. The user will not be
prompted to define the properties again for additional ledgers.

Field-Framed — This field is disabled when Ledger is selected as the Bearing Type.

Floor — When the Floor checkbox is activated, the ledger being defined is designated as supporting floor-
framing members.

Non-Load Bearing — This field is disabled when Ledger is selected as the Bearing Type.
Bears on Earth — This field is disabled when Ledger is selected as the Bearing Type.

OK — If you are creating a new bearing, clicking on the OK button will place the new bearing in accord
with the properties defined in this dialog box. If you are modifying the properties of an existing bearing,
clicking on the OK button will apply your changes and close the Set Bearing Properties dialog box.

Delete/Cancel - If you are creating a new bearing, clicking on the Delete button will close the Set
Bearing Properties dialog box and return you to the main window without placing your bearing. If you
are modifying the properties of an existing bearing, this button will read Cancel rather than Delete.
Clicking on the Cancel button will discard your changes and close the Set Bearing Properties dialog box.

Reserved — This command button is disabled when Ledger is selected as the Bearing Type.

Products — Clicking on the Products command button will open a PST Product Priority dialog box, which
can be used to add to, or modify, the list of materials available for use in the construction of your ledger.
For more information about the features and functions of the PST Product Priority dialog box, see the
section within this document entitled “Defining Product Priorities.”
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Set Bearing Properties for a Strut

Bearing Type — Strut ]
Reference Line — All objects drawn in GS Plan are Bearing Type: S - - -
Ve ft (¥ Center C Right
placed in relation to a Reference Line. Objects can e _ = = _ th
be rendered on Center of the Reference Line, or to Header E;::h I—I _reten |
russ Girder ight: | 0-0-0 F
itS nght or Left .CrnrderGBydomers —l
Bleasr:ay fthers = Ples: [ 1
Flush Wal )
Beg. Height — This field is disabled when Strut is Cut Joist co
- Ridge Board Mbr Depth: I}S—
selected as the Bearing Type. &“— .
Product: | No Product Assigned
Flat Btm. — This command button is disabled when - -
Locaon: = Interior
Strut is selected as the Bearing Type.
glyp  continous tabel: [
End Height — This field is disabled when Strut is I e ram ::
selected as the Bearing Type. I B
Flat Btm. — This command button is disabled when
Strut is selected as the Bearing Type. ok |  Deete T s

# Plies — This field defines the number of plies of
material to be used in the construction of your strut.

Ply Width — The Ply Width field defines the thickness of a single ply of the material that
will be used to construct your strut.

Mbr Depth — The Member Depth field is used to specify the depth dimension of the strut
being defined. (See the figure at right.)

Member Depth
Product — This is a read-only field that displays the specific material, if any, that has

been designated for use in the construction of your strut.
Location — This field is disabled when Strut is selected as the Bearing Type.
Label — This field is disabled when Strut is selected as the Bearing Type.

Continuous — When the Continuous checkbox is activated, GS Plan will use the properties within this
dialog box, as currently defined, for each subsequent Strut that is created. The user will not be
prompted to define the properties again for additional struts.

Field-Framed — This field is disabled when Strut is selected as the Bearing Type.
Floor — This field is disabled when Strut is selected as the Bearing Type.

Non-Load Bearing — This field is disabled when Strut is selected as the Bearing Type.
Bears on Earth — This field is disabled when Strut is selected as the Bearing Type.

OK — If you are creating a new bearing, clicking on the OK button will place the new bearing in accord
with the properties defined in this dialog box. If you are modifying the properties of an existing bearing,
clicking on the OK button will apply your changes and close the Set Bearing Properties dialog box.

Delete/Cancel - If you are creating a new bearing, clicking on the Delete button will close the Set
Bearing Properties dialog box and return you to the main window without placing your bearing. If you
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are modifying the properties of an existing bearing, this button will read Cancel rather than Delete.
Clicking on the Cancel button will discard your changes and close the Set Bearing Properties dialog box.

Reserved — This command button is disabled when Strut is selected as the Bearing Type.

Products — Clicking on the Products command button will open a PST Product Priority dialog box, which
can be used to add to, or modify, the list of materials available for use in the construction of your strut.
For more information about the features and functions of the PST Product Priority dialog box, see the
section within this document entitled “Defining Product Priorities.”

= Continuous — When drawing certain bearings (for example exterior walls), members with
the same properties are placed one after another. When the Continuous checkbox is
activated, all bearings being drawn will have the same properties. This means that you
will not be prompted to define the bearing properties each time a new bearing member is
input. They will receive the same properties as the previous bearing, until the Bearing
command is exited (by picking another entity to input) or restarted (by selecting Bearings
from the Entities menu, Classic Sidebar, or Standard toolbar).

= Reference Line — This is the side of a drawn line on Right Center

which you want the body of an entity to fall. This is Erli:t”

determined based on the start and ending points.
Center keeps the Reference Line in the middle of the
bearing and half of the bearing falls to either side. In
the examples at right, a bearing of each orientation ID Start
displayed, with the start point at the bottom and the Fort
ending point at the top.

= Non-Load Bearing — If you are defining a partition wall, or any other wall that will not
support loads transferred from above, the Non-Load Bearing checkbox should be
activated.

=  Wall Type — ...the list of potential values includes:
*  Framed -
¢ Foundation —

¢ Non-Framed — If you are defining a wall, and it is going to be built any way other
than conventional framing, the Non-Framed flag should be set.

* Header Info — Clicking on the x|

Header Info command button T (e
will open a Define Component " Door
dialog box, like the one Componentparts: [ SetComponent |
pictured at right. For more R.O.Szefwdxht): [2200  x [260 setComp. Assy. |
information about the Header Depth: [9-+ UnsetComp. |
features and functions Header Height: [660
associated with this dialog kefthan. Bearng: [ 1.5 No. Tmers: | -1
box, see “Defining Right Min. Bearing: [ 15 No. King Studs: [ -1

. TrmWidth: [30 No.Uppersis:[-1
Component Properties” on N
page __. Product: | No Product Assigned

BOCUSIcES i _:_' Save As Defaults |

oK | Cancel products |




= Following is an explanation of the fields and buttons available in the Define Component
dialog box:

*

Component Type — Select the type of component you wish to use; Door or
Window.

Component Part # — This is x

the name of the component
that you are currently
viewing. To change, or
choose a component, click
the Set Component button.
When you click on the Set

Door Type:

Loc: Interior 'I
Component button a
. Swing: (any) >
Window Components or a e -
i retrieved; please narrow your selec- Group:
Door Components dialog box L
will open (depending upon Updatelst |
whether you have selected o« | cancel |

Door or Window as your

Component Type in the

Define Component dialog box). For more information on these component dialog
boxes, see the section within this document entitled “Selecting Door & Window
Components.”

Note: It is not necessary to define a component. You may, instead, input an
opening based on rough-opening dimensions only.

R.O. Size (Wd x Ht) — This is the exact size of the opening to be placed in the wall.
Enter the width of the opening in the first field, and the height in the second.

Header Depth — This is the exact depth of the material that will be used as the
header. This value is entered in inches and sixteenths of an inch.

Header Height — This is the distance from the bottom of the wall to the top edge
of the opening.

Left Min. Bearing — This is the total width of any members that will be supporting
the left side of the header. This value is entered in inches and sixteenths of an
inch.

Right Min. Bearing — This is the total width of any members that will be
supporting the right side of the header. This value is entered in inches and
sixteenths of an inch.

Trim Width — This is the closest that either end of this opening can get to another
opening or an intersection wall. This value is entered in inches and sixteenths of
an inch.

No. Plies — This field is used to define the number of plies used to construct the
designated bearing.

Product —
No. Trimmers —

No. King Studs —
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*

*

No. Upper Sills —

Door Side — This is the direction that the door should swing. Inside and Outside
refer to the room that the door is placed into.

COMMAND BUTTONS

L 4

Set Component — Click this button to open a dialog box that will allow you to
select a component from the list of doors and windows you have created in
KeyMan. For more information about the Door Components dialog box and the
Window Components dialog box, see the section within this document entitled
“Selecting Door & Window Components.”

Set Comp. Assy. —

Unset Comp. — When a component is selected, the rough opening size is pre-
determined and therefore those fields are grayed out. If you wish to change this
door or window from having a component to having a rough opening, click this
button. The Component Part # field will be cleared and the rough opening fields
will become available.

Save As Defaults — Click the Save As Defaults button to store the information in
this window and bring it up every time a new header is being defined.

OK — Click the OK button to apply the information entered in this window and
return to the Main Model™ window.

Cancel — Click the Cancel button to return to the Main Model™ window without
making any changes to the selected header or header being placed.

Products — Clicking on the Products button opens a View/Edit Product List window
like the one pictured at right. This window allows you to specify what materials
you want to use for this header.
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Selecting Door & Window Components

When you first enter this screen, all door or window
components are displayed (depending on the
component type you chose on the previous screen).
To narrow the list, select the component type in the
column on the right and/or other options such as
Swing or Location. Then click on the Update List
button to filter the component list based on the
selected options. Highlight the component you wish
to place and click on the OK button. If no
components appear in the list, make sure that the
KeyMan path is set correctly on the File, Set Paths
screen.
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Door Type:

Loc:
Swing:
Only first 2,000 qualifying doors
retrieved; please narrow your selec- Group:
tion criteria and press Update List.
| OK I




MENU

APPENDIX C: GS PLAN MENUS & TOOLBARS

SUB-MENU(S)

kon

CtrkS

Fie

Save As...

Options Extract As...

Export DXFFile..

Merge...

Load Shadow Job...

GS Build...

Print Drawing

Plot Layout

Print Trussss

General Informaion

Save Defauls

Reset Products

ReSync Job

Set Paths

Auto Save & Undo Settings

Ext

TOOLS

Point Srap

MgpointSnap

Intersaction Snap

Perpendicular Snap

XYZ Srap

Grid Snap

o [#N|F X > |0)

Ortho

Set SnapRules...

Set Snap Grid...

Selection & Snap

Set Visual Grid...

Selection & Snap

Set Levek...

Tools; Standard

DeselectAll

Selection & Snap

Select

Standard; Selection & Snap

Select All Visble

Selection & Snap

gnter Point...

Took

-
8]

Set Top of Wall..

Toos

Show Coordnates

Took

Show Messages

Show Structure Flegs

Check Bearings

Check Geometry

Options

Creae/Edit Option

Select Options

Copy/Xfer Option

Copy Seleaed Entties

176




MENU
TOOLS

(Cont'd)

SUB-MENU(S)

Hot-Key TOOLBAR
Options

Took

Selection & Snap

Modify

Entities

DBy

Macros

Heade's

Roof Panes

Toggles

Laea

Maerias

Options

GS Wall

GS WallTods

Desgn

Structure Commands

Annotations

GS Buid

View Schemes

Labeling

Output

Design Toobar

T.0.P. Toolbar

Custom Toobars

MODIFY

Set Line Length...

Set LineAngle...

Mod#y

Move Endpoint

Modfy

SpitLine..

Modfy

JoinLines

Modffy

LA ]

Trim/Extend Lines

Modfy

Trim/Extend Twolines

Modfiy

Offsex Line/Array...

Modfy

Reverse Reference Line

sjo|x |~ |—|n |3

Modfy

Ma ke Polygon Edgss...

Modfy

Set Propeties

Modfy; Standard

Undo

CtriZ Modfy

Redo

Cri+Y Modffy

Shit/Copy Selected...

s Modiy

Rotate Selected...

Modffy

| s8] o] s]alb] ]

(&

Mirror Selected...

Mod#y




SUB-MENU(S)

MODIFY Delete Selected
(Cont'd)  [&5] Changelevel..
Sht/Copy Model..
Q)| RotateModel [Temporary)... Modiy
| set PropertiesMode Modfy
fPy| Relap Corners GS Wall Tools
™| Reip Cornersto Defaut GS Wall Toos
ENTITIES  [54]| Constructlines Entities
E' Bearings Entities Standard
27| Aress Entities Standard
53| Openings Entties
®|| Obsructions Entities
<7|| Panes Entities Standard
Ll Loas Entiies
S_]l Overhangs Entities
@] singeTrus Entties
|| HipEnds Entities
ixil| AnnotationsPiot Entties
[l Additiona Framing Entties
=]|| Hanges Entties
|| JostHoles
“:‘: Annotations
Lb! Model Entty Labels Curl | Annotaions
= Draw Dimension Lines Ctrkd | Annotaions
iz Draw Arbitrary Lines Ctr+Q. | Annotations
43! Draw or Edit Text Box Ctr+T | Annotations
R Edit Annotation Attributes... Ctr+0 | Annotations
Options...
=] Point-to-Point Dimension Lines Ctri+l | Annotations
| Horizontal Dimension Lines Ctr+2 | Annotations
n Vertical DmensionLines Ctr+3 | Annotations
s Auto Dimensions Fikter Ctrif Annotations
DISPLAY I_Bj_q Zoom Window
|| Zoom Ful
®|| Zoom Last
] Rotate..
[ Plan View
@ Anmae
)| soidModel Display; Standard
25| Design Toobar Display
Z|| Show/Edit TrussProfies Display; Standard
|| show Wall Profies Diplay
Lﬁ] Show Planes & Overhangs Dsplay
Show Member Width

Show Panel Framing
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DISPLAY
(Cont'd)

SUB-MENU(S)
Force Panel Updae

Set Colors..

Set Visbity...

Set View Scheme

View Scheme Settings

MACROS

Generate Members

hiE

Re-Profile Members

Undo AllTopChord Edis

Undo All Bottom Chord Edits

Re-Elevae Roof Members

Headers

L)

Header Products...

Quick Header...

Move Header

Snzp Heade...

Verify Components

Global Change Components..

Delete Header...

Bl EJEIEE

Move Snap Header

Extrude Bearings

Create Veneser Wall

Roof Planes

_greae Planes...

Extend _Manual

Roof Planes; Standard

Extend Sngle

Roof Planes

Extend Al

Roof Planes

Clp Off Corner

Roof Plenes

Five-Sided Bay Window

Roof Plenes

Three-Sided Bay Window

Roof Planes

A S K i e SN B e L A

Ceiling Planes...

Macros

Toggle

(=]
L

Toggle Load Bearing

Toggle Roof/Floor

Togzgle Interior/Exterior

Toggle Wall/Header Widths

Toggle Overhang Lengths

Toggle Framed/Not Framed

Toggle Top Track Elevaions

Toggle Wall/Header Heghts

Toggle Bearing Properties

EEEEEEEEE

Toggle Bears on Earth

Stick Framing

Ridge Boards (Roof)

Struts (Roof)

Stick Areas (Roof)
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MACROS
(Cont'd)

SUB-MENU(S)
Ridge Boards (Ceiing)

Stick Areas (Ceiing)

Skylght...

Dormer...

Panel Break Mode

Floor Deck EditMode

Stretch Model

LATERAL

Default Settings...

Insert SIP...

MovesSIP

Delkete SIP

Creae Shea Lines

Erase Shear Lines

Wind Loads

MATERIALS

Assgn Non-Structural Materias

Generae Non-Structural Maerials List

Generae Structural Materias List

Output Window/Door Schedule

Output Floorsto GSS

GSS Floor Output Settings..

OptionMater@s

Strucural Options Maerials List

Output Membersto LOC Fie

DESIGN

Check Model

Edt Truses

Reconsolidate All Trusses

Truss Label Presats

Import Hangers

GSBULD

GSPin

GS Beam

GS Truss

GSS Output

HELP

Contents

What'sNew

Vst Website

About GS Plen
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